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1 How to Use this Common Installation
Guide

This guide describes how to install and set up the applications delivered with SAP Customer Activity Repository
applications bundle 4.0 FPSOL.

A Caution

If you already have an existing installation of any of these applications, you must perform a software
upgrade rather than a new installation. In this case, see the Common Upgrade Guide under https://

help.sap.com/viewer/p/CARAB |l <Version> » Installation and Upgrade .

Applications in this Release

SAP Customer Activity Repository applications bundle 4.0 FPSO1 includes the following applications:

e SAP Customer Activity Repository 4.0 FPSO1
e SAP Allocation Management 4.0 FPSO1

e SAP Assortment Planning 4.0 FPSO1

e SAP Merchandise Planning 4.0 FPSO1

e SAP Promotion Management 4.0 FPSO1

i Note

You can find the product documentation for all of these applications on SAP Help Portal for SAP Customer
Activity Repository applications bundle at https://help.sap.com/viewer/p/CARAB.

If you wish to connect your system to consume documentation directly from the SAP Help Portal, see
section Configure Access to Documentation Provided on SAP Help Portal (Optional for All Applications)
[page 255] for more information.

What to Install

Technically, SAP Customer Activity Repository applications bundle 4.0 FPSO1 is delivered in the form of two
installable product versions: one for the back-end and one for the front-end.
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Product Versions for this Release Description

SAP CARAB 4.0 FPSO1 Back-end product version

Contains several software components that provide the
ABAP back-end functionality and the business content
(such as SAP HANA views and SQLScript procedures, lo-
cal Bl Content, application function libraries, and work-
books, where applicable).

SAP FIORI FOR SAP CARAB 4.0 FPSO1 Front-end product version

Contains all the SAP Fiori apps included in SAP Customer
Activity Repository applications bundle. It is also referred
to as the product-specific SAP Fiori Ul component.

- Tip

If

you need more information about a product version, log on to the SAP ONE Support Launchpad at

https://launchpad.support.sap.com/#/productsearch® and search for SAP CARAB or SAP FIORI FOR
SAP CARAB. You will find download information, SAP Knowledge Base articles, guided answers, and more.

Installation at a Glance

1.

First you prepare the installation. For example, you ensure that the technical prerequisites are installed.
You also implement mandatory corrections, verify authorizations, and do other preparatory tasks. These
steps are described in sections Install the Prerequisites [page 17] and Prepare the Installation [page

25].

Then you install the back-end product version and the front-end product version. These steps are
described in section Install the Software [page 45]. You must do these steps regardless of the application
that you want to set up later on.

Once you have installed the product versions, you set up the desired applications. These steps are
described in section Set Up the Applications [page 67]. First you do the general setup steps in section
Core (Mandatory for All Applications) [page 67]. You must do the core steps regardless of the application
that you want to set up. After the core setup, you only need to do the steps that are required for your
application. You do not need to read sections that do not apply to your application.
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1.1 Naming Conventions

Important terms and variables used throughout this guide

Terminology

Term

Definition

Common Installation Guide

Common Upgrade Guide

Common guides for the applications delivered with SAP Customer Activity Repository
applications bundle.

You can find the guides on SAP Help Portal under https://help.sap.com/viewer/p/CARAB
|+ <Version> ¥ Installation and Upgrade 4.

consuming application

An application designed to consume and utilize data obtained from the SAP Customer
Activity Repository platform.

< Example
e SAP Allocation Management
e SAP Assortment Planning
® SAP Merchandise Planning

e SAP Promotion Management

back-end server / system

The SAP NetWeaver-based ABAP back-end server on which SAP Customer Activity
Repository and its consuming applications are installed.

front-end server / system

The SAP NetWeaver-based ABAP front-end server on which the SAP Gateway, SAP Fiori
launchpad, central SAP Fiori Ul component, and the product-specific SAP Fiori component
(front-end product version) are installed.

source master data system

SAP Customer Activity Repository applications bundle must be deployed alongside an SAP
ERP or SAP S/4HANA central component as the single source of truth for all master data.

Whenever this guide refers to a source master data system, it refers to the SAP ERP or SAP
S/4HANA central component that you choose for your implementation.

For more information, see Integration with Source Master Data Systems [page 15].

SAP ERP

Unless otherwise specified, references in this guide to SAP ERP are comprehensive. That is,
they apply to SAP Retail and SAP Fashion Management.
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Naming Differences

Due to naming differences between the underlying technical objects, the following terms are used
interchangeably in this guide:

SAP Customer Unified Demand SAP Assortment  SAP Promotion SAP Retail or SAP
Activity Forecast (UDF) Planning / SAP Management S/4HANA
Repository (all and Demand Data Merchandise
modules except Foundation (DDF) Planning SAP Allocation
for UDF and DDF) Management
article product product product product article
material
article variant product variant product variant product variant product variant or  article variant

product/color/size

store location (usedas  location location store store
an umbrella term )
o site
for stores, distribu-

tion centers, etc.)

Variables

The variables are used as placeholders in the guides for objects that are user defined. When this variable is
used in an instruction, you are expected to substitute your customer defined name for the object. For example,
on the back-end application server where you have installed CARAB database objects, you have named your
schema ABCOI. An instruction states to verify the list of packages in your saAp<s1D>. You would look for
packages in the ABCOI schema.

To find the name of your SAP<SID>, sign on to your target system using SAP Logon. Use the file menu

| System #» Status 3. In the lower right section titled Database Data the name of your Schema is shown. This
same schema is also listed as an object in your HANA catalog.
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Variables Used Across All Guides

Variable Description

SAP<SID> Physical schema name
i Note
In this guide your physical schema is referred to as SAP<SID> and is
your database system ID. This name is customer-defined.
To find the name of your SAP<SID>, log on to your target system using
SAP Logon. Choose | System # Status 3. In the lower right-hand sec-
tion titled Database data, the name of your Schema is shown. This same
schemaiis also listed as an object in your SAP HANA studio, under
Catalog. Substitute this schema name whenever the SAP<sID> variable
is used in this guide.

<sapsid> SAP system ID in lowercase letters

<SAPSID> SAP system ID in uppercase letters

<DBSID> Database ID in uppercase letters

<dbsid> Database ID in lowercase letters

<INSTDIR> Installation directory for the SAP system

<DVD_DIR> Directory on which a DVD is mounted

<0s> Operating system name within a path

1.2 Information Available on SAP Help Portal

Information on prerequisite platforms, applications, and other components as well as quick links to SAP sites

Information on Prerequisite Platforms, Applications, Other Components

Information On

Path

Title

Installing SAP HANA

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM ¥

|} <Version> > Installation and
Upgrade > SAP HANA Server
Installation and Update Guide ]

SAP HANA Server Installation and Up-
date Guide
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Information On

Path

Title

Installing SAP HANA database clients

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM ¥

|} <Version> > Installation and
Upgrade # SAP HANA Client
Installation and Update Guide 3

SAP HANA Client Installation and Up-
date Guide

Installing SAP HANA studio

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM

| <Version> ¥ Installation and
Upgrade ¥ SAP HANA Studio
Installation and Update Guide ]

SAP HANA Studio Installation and Up-
date Guide

Installing SAP LT (Landscape Transfor-
mation) Replication Server for SAP
HANA

http://help.sap.com/viewer/p/
SAP_HANA_REAL_TIME_REPLICATION

# | <Version> ¥ Installation and
Upgrade }

Installation Guide - Trigger-Based Data
Replication Using SAP Landscape Trans-
formation Replication Serve

Managing major operational aspects of
the SAP LT Replication Server

http://help.sap.com/viewer/p/
SAP_HANA_REAL_TIME_REPLICATION

# | <Version>  Operations 4

Application Operations Guide - SAP
Landscape Transformation Replication
Server

Using SAP HANA

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM ¥

|} <Version> > Administration > SAP
HANA Administration Guide 4

SAP HANA Administration Guide

Using the SAP HANA development
tools to create comprehensive analyti-
cal models and to build applications
with SAP HANA interfaces and inte-
grated development

(for developers)

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM

| <Version> ¥ Development ¥ SAP
HANA Developer Guide (For SAP HANA

Studio) 4

SAP HANA Developer Guide

Defining data models for use in SAP
HANA

(for modelers, business analysts)

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM ¥

|} <Version> > Development > SAP
HANA Modeling Guide (For SAP HANA

Studio) 4

SAP HANA Modeling Guide

Installing Foundation on SAP NetWea-
ver AS for ABAP 7.52, version for SAP
HANA

https://help.sap.com/viewer/p/
SAP_NETWEAVER_AS_ABAP_752

| <Version> ¥ Installation and

Upgrade > Master Guide }

SAP NetWeaver Master Guide
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Information On

Path

Title

Installing SAP ERP 6.0

http://help.sap.com/viewer/p/
SAP_ERP [ <Version> ¥ Installation
and Upgrade > Installation Guide }

Installation Guide, SAP ERP 6.0 Includ-
ing <your SAP Enhancement Package> -
Technical Usage "Central Applications”
<Your Server>on <Your Operating Sys-

tem>

Installing SAP S/4HANA, on-premise
edition 1610 or higher

http://help.sap.com/viewer/p/
SAP_S4HANA_ON-PREMISE ¥

|» <Version> ¥ Product Documentation

> Installation Guide 1

Installation Guide for SAP S/4HANA, on-
premise edition <version>

Installing SAP Enhancement Package 2
for SAP CRM 7.0 or SAP Enhancement

Package 2 for SAP CRM 7.0, Version for
SAP HANA or higher

http://help.sap.com/viewer/p/
SAP_CUSTOMER_RELATION-

SHIP_MANAGEMENT# |l Version 70
EHP2 > Installation and Upgrade >

Installation Guide ¥ Install
Installation Guides for SAP EHP 2 for

SAP CRM 7.0 ¥ Installation Guide - SAP
enhancement package 2 for CRM 7.0 -

ABAP and Java 4

http://help.sap.com/crmhana
|} Installation and Upgrade Information

» Administrator's Guide ¥
Administrator's Guide SAP CRM 7.0

EHP2, Version for SAP HANA }

Installation Guide, SAP Customer Rela-
tionship Management 7.0 Including En-
hancement Package 2 Java and ABAP

Administrator's Guide, SAP Enhance-
ment Package 2 for SAP CRM 7.0, Ver-
sion for SAP HANA

General Quick Links

SAP Site

Path

SAP Help Portal

http://help.sap.com Pl

Knowledge Base Articles and SAP Notes

https://support.sap.com/en/index.htm| ¥

Product Availability Matrix (PAM)

http://support.sap.com/pam#&

Maintenance and release strategy

https://support.sap.com/en/release-upgrade-maintenance.htm!|#

SAP Software Download Center

http:/support.sap.com/swdc e

SAP Solution Manager

http://support.sap.com/solutionmanager

SAP Security Optimization Services Portfolio

https://support.sap.com/en/offerings-programs/support-services/

security-optimization-services-portfolio.htm!|
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SAP Site

Path

Data Protection and Privacy

https://www.sap.com/about/cloud-trust-center/data-ownership-pri-
vacy.htm|#r

2590321#% Upgrade recommendations to support GDPR compliance

Support information (quick access via SAP ONE
Support Launchpad; requires login)

https://launchpad.support.sap.com/#/productsearch

Support package stacks, latest versions, patch
level requirements

http:/support.sap.com/patches

System sizing

https://www.sap.com/about/benchmark/sizing.htm|. P
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2 Plan your System

System Landscape [page 13]
System landscape diagram for SAP Customer Activity Repository applications bundle

Central Hub Deployment (Recommended) [page 14]
Central hub deployment is the recommended deployment option for the applications in SAP Customer
Activity Repository applications bundle.

Integration with Source Master Data Systems [page 15]
Overview of the source master data systems for deployment scenarios of SAP Customer Activity
Repository applications bundle
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2.1 System Landscape

System landscape diagram for SAP Customer Activity Repository applications bundle

System Landscape

The applications included in SAP Customer Activity Repository applications bundle require a layered system
landscape, as illustrated in the following diagram:

SAP Analysis for

Clients supporting HTML5 Microsoft Office

SAP Web Dispatcher

SAP Fiori Front-End Server | SAP Gateway

Consuming Applications
Demand Data Foundation Multichannel Sales Repository

Foundation on SAP NetWeaver AS for ABAP, version for SAP HANA SAP HANA

Extended

Application

Services,

o T Advanced

Unified Demand Forecast SAP HANA Platform On-Shelf Availabilit

g vaiiabrity Model (XSA)

System Landscape Example

For more information about the components not specific to SAP Customer Activity Repository applications
bundle, see https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION [j» <Version> * Installation and Upgrade
SAP Fiori: Setup and Configuration » Setup of SAP Fiori System Landscape

System Landscape Prerequisites

For information on the versions required for this release, see Install the Prerequisites [page 17].
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2.2 Central Hub Deployment (Recommended)

Central hub deployment is the recommended deployment option for the applications in SAP Customer Activity
Repository applications bundle.

What is Central Hub Deployment

With central hub deployment, the back-end product version is installed in the back-end system, while the front-
end product version and the SAP Fiori front-end server are installed in a separate front-end system.

As aresult, the SAP Fiori apps are deployed in separate systems (Uls in the front-end system, related OData
services in the back-end system).

Advantages

Central hub deployment decouples the lifecycle of the SAP Fiori apps from the back-end components
(separate shipments). This option has the following advantages:
e Faster iterations for SAP Fiori apps
e Central place for theming and branding SAP Fiori apps
® Single point of maintenance for user interface issues, such as browser support and updated versions of
SAPUIS libraries
e (Changes to user interfaces are possible without having development authorizations in the back-end.

e The SAP Fiori front-end server offers a central deployment of the Uls and a central enablement of OData
access for multiple SAP application back-end systems.

i Note

In general, when an SAP solution includes SAP Fiori apps, you could alternatively choose the “embedded
deployment” option, where you use the same SAP NetWeaver server for back-end and front-end
components. Although the advantage of this option is that you do not require a separate SAP NetWeaver
front-end server, we do not recommend it for the applications described in this guide.

This guide is therefore based entirely on the “central hub deployment” option.

More Information

If you need more information about deployment options for SAP Fiori, see the following:

e https:/help.sap.com/viewer/p/FIORI_IMPLEMENTATION | <Version> ¥ Installation and Upgrade » SAP
Fiori: Getting Started » SAP Fiori Deployment Options J

e [ andscape Deployment Recommendations for SAP Fiori Front-End Server

e https:/help.sap.com/viewer/p/SAP_GATEWAY | Installation and Upgrade » Master Guide » SAP Gateway
Master Guide ¥ Deployment Options 3 as well as Embedded Versus Hub Deployment
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2.3

Integration with Source Master Data Systems

Overview of the source master data systems for deployment scenarios of SAP Customer Activity Repository

applications bundle

Overview

You can deploy your SAP Customer Activity Repository applications bundle solution in parallel with one of the
following source master data systems:

Source Master Data System

Flavor

More Information

SAP ERP

(including the SAP ERP Central Compo-
nent, SAP ECC)

SAP Retail (add-on to SAP ERP)

https://help.sap.com/viewer/p/
SAP_ERP |} <Version> > Application
Help > SAP Library > Industries in SAP
ERP  SAP Retail 3

SAP Fashion Management (add-on to
SAP Retail)

https://help.sap.com/viewer/p/
SAP_ERP |} <Version> > Application
Help # SAP Library ¥ Industries in SAP
ERP > Fashion Management }

SAP S/4HANA Retail

SAP S/4HANA Retail for merchandise
management

https://help.sap.com/viewer/product/
SAP_S4HANA_OVERVIEW/latest/en-

us |} <Version> > Product Assistance
> <Language> > Industries > Retail }

i Note

Unless otherwise specified, the following terms are used in this guide:

e References to the source master data system are comprehensive; that is, they apply to SAP ERP
(including SAP ECC) and SAP S/4HANA Retail.

e References to SAP ERP are comprehensive; that is, they apply to SAP Retail and SAP Fashion

Management.

Prerequisites

For information on what versions of the source master data systems are required for this release, see Install the

Prerequisites [page 17].
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More Information
If a migration to SAP S/4HANA is in scope for your business, see the following information for guidance:

e SAP Transformation Navigator at https://go.support.sap.com/transformationnavigator/#/welcome #r
e SAP Readiness Check at https://help.sap.com/viewer/p/SAP_READINESS_CHECK

For cross-scenario planning information, see the following whitelists:

e SAP Note 1661202#% - Support multiple applications one SAP HANA database / tenant DB: Support and
special considerations for multiple applications on a single SAP HANA database or, in the case of MDC, on
a single tenant DB

e SAP Note 1826100#% - Multiple applications SAP Business Suite powered by SAP HANA: Support and
special considerations for multiple applications on a single SAP HANA database within SAP Business Suite
powered by SAP HANA
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3 Install the Prerequisites

This section lists all the prerequisite platforms, applications, and components that must be installed and
configured to prepare the system landscape for a new installation of this release.

i Note

If you are upgrading from a previous release, you must not follow this Common Installation Guide and
rather proceed with the Common Upgrade Guide, available under https://help.sap.com/viewer/p/CARAB

|+ <Version> ¥ Installation and Upgrade 3.

For your convenience, the prerequisites are presented to you in two categories:

e Common Prerequisites, which must be installed regardless of the business scenario you are planning to
implement

e Application-Specific Prerequisites, which are only relevant for specific applications under specific
conditions

- Tip

The prerequisites should be installed and configured by an experienced SAP Basis administrator.

Common Prerequisites

1. Foundation on SAP NetWeaver AS for ABAP, version for SAP HANA
The minimum requirement for this release is ABAP FND 1709 ON HANA SPS 02 (05/2018)
(foundation 1709 on SAP NetWeaver AS for ABAP 7.52, version for SAP HANA).
This minimum requirement applies regardless of the business scenario you are planning to implement.

i Note

You must install the foundation prior to installing other back-end components.

For installation information, see SAP Note 2534199#% (ABAP FND 1709 ON HANA: Release Information

Note) as well as the Master Guide for your SAP NetWeaver version under https://help.sap.com/viewer/p/

SAP_NETWEAVER_AS_ABAP_752 |# <Version> ¥ Installation and Upgrade 7.

2. SAP HANA Platform 2.0
o SAP HANA database component:

The minimum requirement for this release is SAP HANA 2.0 SPS 02 revision 24.08, regardless of the
business scenario you are planning to implement.
If you wish to use SAP HANA Platform 2.0 SPS 03, we recommend that you install SAP HANA 2.0 SPS
03 revision 36.
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i Note

If you wish to use a higher revision of either SPS, we recommend that you select one of the
“maintenance revisions”. See SAP Note 2378962#% and consult the information under Last
Released Revision or Maintenance Revision.

i Note

Regardless of the revision that you select, additionally implement mandatory SAP Note 2525644
# (Input Variables are set to an Empty String When not Mapped in Top-Level Calculation Scenario).

o SAP HANA AFL component:
The minimum requirement for this release is the SAP HANA AFL revision that is compatible with the
selected SAP HANA database revision.

For guidance on selecting the best revision for your scenario, see Download and Install the Application

Function Library (SAP RTL AFL FOR SAP HANA) [page 471].

For installation information, see the following:

o 2380229 : SAP HANA Platform 2.0 Central Note

o 2339267#% : Important version information for SAP HANA client and SAP HANA server

o SAP HANA Server Installation and Update Guide for your SAP HANA Platform version under https://
help.sap.com/viewer/p/SAP_HANA_PLATFORM | <Version> ¥ Installation and Upgrade J

o If you are planning to upgrade from SAP HANA Platform 1.0 to SAP HANA Platform 2.0, additionally
see the following SAP Notes:
o 2372809#%: Guideline for upgrading from SAP HANA Platform 1.0 to SAP HANA Platform 2.0

o 2422421#%: Guideline for upgrading an SAP HANA system with SAP HANA extended application
services, advanced model (XSA)

->Tip

(Optional) To get the latest technical recommendations related to your SAP HANA landscape, you can
activate the SAP EarlyWatch Alert (EWA) in your SAP HANA environment. For more information, see
SAP Note 1958910 #% .

3. SAP RTL AFL FOR SAP HANA

O\ Caution

SAP RTL AFL FOR SAP HANA is a back-end software component of SAP Customer Activity
Repository applications bundle. However, you must always install it together with the SAP HANA
Platform. You must do this before installing the SAP CARAB back-end product version. This guide leads
you through the correct procedures.

The minimum requirement for this release is the SAP RTL AFL FOR SAP HANA revision that is
compatible with the selected SAP HANA database revision, regardless of the business scenario you are
planning to implement. When you download an AFL revision from the SAP Support Portal, the compatible
SAP HANA database revision is always indicated for your convenience.

For installation information, see Download and Install the Application Function Library (SAP RTL AFL FOR
SAP HANA) [page 47].
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i Note

SAP RTIL AFL FOR SAP HANA contains back-end functionality for two modules of SAP Customer
Activity Repository: Unified Demand Forecast (UDF) and On-Shelf Availability (OSA).

You must always install component, regardless of the scenario you are planning to implement.

You only need to set up and configure UDF and/or OSA if you wish to use the functionality in your
scenario.

4. SAP Landscape Transformation Replication Server
The minimum requirement for this release is SAP Landscape Transformation Replication Server 2.0 for
SAP HANA, regardless of the business scenario you are planning to implement.
For installation information, see https://help.sap.com/viewer/p/

SAP_LANDSCAPE_TRANSFORMATION_REPLICATION_SERVER | <Version> ¥ Installation and Upgrade »

Installation Guide (Replicating Data to SAP HANA) . Additionally, see SAP Note 1605140 (SAP
Landscape Transformation Replication Server (SLT)). This is the central note for enabling trigger-based
data replication (download, installation, upgrade, corrections, implementation).
5. SAP Fiori

The minimum requirement for this release is SAP FIORI FRONT-END SERVER 4.0 - SAP FRONTEND
SERVER 7.52, regardless of the business scenario you are planning to implement. The minimum SAPUI5
version is 1.52.4.

For installation and implementation information, see the following:

o Set up the SAP Fiori infrastructure and SAP Fiori apps#

o Overview of SAP Fiori front-end server components and versions

o 2484979% (SAP-Fiori-Frontend-Server 4.0 - General Information)

o 2524632%F (General Information: FIORI Ul Infrastructure Components for products on SAP Frontend

Server 4.0 (S4H))

If you are planning an upgrade to SAP Fiori front-end server 5.0, see SAP Note 2618605 (SAP-Fiori-
Frontend-Server 5.0 - General Information) for information on technical dependencies to other
components.

For additional planning information and a version overview, see SAP Note 2217489#% (Maintenance and
Update Strategy for SAP Fiori Front-End Server).

6. Source master data system
o Either SAP ERP or SAP S/4HANA, on-premise edition must be installed.
o  The minimum release depends on the application that you wish to use. For more information, see the
application-specific prerequisites below.
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Application-Specific Prerequisites

SAP Customer Activity Repository

Prerequisites for SAP Customer Activity Repository

Product

Minimum Requirement

Mandatory/Optional

Installation Information

SAP ERP

When implementing SAP
Customer Activity Repository
with all modules, the mini-
mum requirements are:

e SAPERP 6.0 Enhance-
ment Package 7 SP16 or
higher

e SAPERP 6.0 Enhance-
ment Package 8 SP0O9 or
higher

For module-specific mini-
mum requirements, see SAP
Note 2696488

You must install a source
master data system:; either
SAP ERP or SAP S/4HANA
must be installed.

https://help.sap.com/
viewer/p/SAP_ERP

|} <Version> > Installation
and Upgrade > Installation
Guide 1

SAP S/4HANA, on-premise
edition

When implementing SAP
Customer Activity Repository
with all modules, the mini-
mum requirement is:

e SAP S/4HANA 1709
FPS2 or higher

For module-specific mini-
mum requirements, see SAP
Note 2696488 #r .

You must install a source
master data system; either
SAP ERP or SAP S/4HANA
must be installed.

https://help.sap.com/
viewer/p/SAP_S4HANA_ON-

PREMISE | <Version> ¥
Product Documentation >

Installation Guide }

SAP CRM

The minimum requirement
for this release is one of the
following:

e SAP Enhancement
Package 2 for SAP CRM
70

e SAP Enhancement
Package 2 for SAP CRM
7.0, Version for SAP
HANA or higher

Optional, depending on
whether or not you choose to
implement customer deter-
mination with SAP CRM.

https://help.sap.com/
viewer/p/
SAP_CUSTOMER_RELA-
TIONSHIP_MANAGEMENT

|» <Version> ¥ Installation
and Upgrade > Installation
Guide 3
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Product

Minimum Requirement

Mandatory/Optional

Installation Information

SAP Smart Business

SAP Smart Business founda-
tion component 1.0, most re-
cent SPS

Optional, depending on
whether or not you choose to
implement the SAP Smart
Business for Multichannel
Sales Analytics dashboard
within SAP Customer Activity
Repository.

SAP Note 2018360 #r

SAP Marketing (formerly,
SAP Hybris Marketing)

SAP Marketing 1.10 or higher

Optional, depending on
whether or not you choose to
implement customer deter-
mination with SAP
Marketing.

https://help.sap.com/
viewer/product/
SAP_HYBRIS_MARKETING/
1702%20YMKT/en-US

|} <Version> > Installation
and Upgrade > Installation
and Configuration Guide }

SAP Commerce (formerly,
SAP Hybris Commerce)

SAP Commerce 1811 or
higher (in particular, the Ac-
celerator, the Data Hub, and
SAP Asynchronous Order
Management)

Optional, depending on
whether or not you choose to
implement Omnichannel Ar-
ticle Availability and Sourc-
ing or Omnichannel Promo-
tion Pricing within SAP
Customer Activity
Repository.

http://help.hybris.com
| SAP Commerce
<Version> > Installing &

Upgrading 1

SAP Commerce, integration
package for SAP for Retail
(formerly, SAP Hybris Com-
merce, integration package
for SAP for Retail)

SAP Commerce, integration
package for SAP for Retail
1811 or higher

Optional, depending on
whether or not you choose to
implement Omnichannel Ar-
ticle Availability and Sourc-
ing or Omnichannel Promo-
tion Pricing within SAP
Customer Activity
Repository.

See the Administration Guide
delivered with the software
package or from https://
help.sap.com/viewer/p/IPR.
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Product Minimum Requirement Mandatory/Optional Installation Information
SAP Analytics Cloud Content Innovation 12 Optional, depending on System Requirements and
whether or not you choose to  Technical Prerequisites
implement Omnichannel Ar-
ticle Availability and Sourc-
ing (OAA) within SAP
Customer Activity
Repository.
You only need to run and
connect this application if
you want to use the set of
OAA analyses that has been
predefined in SAP Analytics
Cloud and that is part of the
standard delivery of SAP An-
alytics Cloud. If you are using
a different analytics tool, or if
you do not run analytics at
all, you do not need this ap-
plication.
SAPIQ SAP 1Q 16.0, SP8 or higher Optional, depending on https://help.sap.com/
whether or not you choose to  viewer/p/SAP_IQ
use the Table Content Aging Ib <Version> ¥ Instaliation
report to move data from )
SAP Customer Activity and Upgraclle » <various SAP
Repository to SAP 10, 1Q Installation and
Configuration Guides> }
SAP HANA Dynamic Tiering ~ SAP HANA Dynamic Tiering  Optional, depending on https://help.sap.com/
is delivered with the SAP whether or not you choose to  viewer/p/
HANA Platform. See the use the Table Content Aging ~ SAP_HANA_DYNAMIC_TIER-
Common Prerequisites sec-  report to move data from ING [P <Version> ¥
tion above. SAP Customer Activity )
. Installation and Upgrade >
Repository to extended stor- T
) SAP HANA Dynamic Tiering:
age using SAP HANA Dy- )
o Installation and Update
namic Tiering.
Guide 4
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Product

Minimum Requirement

Mandatory/Optional

Installation Information

SAP HANA XS Advanced

SAP HANA XSA, version
1.0.88 or higher

We recommend that you use
the highest version available.

Optional, depending on
whether or not you choose to
use Omnichannel Promo-
tion Pricing within SAP
Customer Activity

https://help.sap.com/
viewer/p/SAP_HANA_PLAT-

FORM [» <Version> »

Installation and Upgrade >
SAP HANA Server Installation

Repository.
and Upgrade } Installing an
SAP HANA System »
Installing XS Advanced
Runtime }
SAP Allocation Management
Prerequisites for SAP Allocation Management
Product Minimum Requirement Mandatory/Optional Installation Information
SAP ERP SAP ERP 6.0 Enhancement  You must install a source https://help.sap.com/
Package 7. master data system; either viewer/p/SAP_ERP

SAP ERP or SAP S/4HANA
must be installed.

|} <Version> > Installation
and Upgrade > Installation
Guide J

SAP S/4AHANA, on-premise
edition

SAP S/4AHANA, on-premise
edition 1709

You must install a source
master data system:; either
SAP ERP or SAP S/4HANA
must be installed.

https://help.sap.com/
viewer/p/SAP_S4HANA_ON-

PREMISE | <Version>
Product Documentation #

Installation Guide }

SAP Assortment Planning

Prerequisites for SAP Assortment Planning

Product Minimum Requirement Mandatory/Optional Installation Information
SAP ERP SAP ERP 6.0 Enhancement You must install a source https://help.sap.com/
Package 7 master data system; either viewer/p/SAP_ERP

SAP ERP or SAP S/4HANA
must be installed.

|» <Version> ¥ Installation
and Upgrade > Installation
Guide 3
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Product

Minimum Requirement

Mandatory/Optional

Installation Information

SAP S/4AHANA, on-premise
edition

SAP S/4HANA, on-premise
edition 1610

You must install a source
master data system:; either
SAP ERP or SAP S/4HANA
must be installed.

https://help.sap.com/
viewer/p/SAP_S4HANA_ON-

PREMISE | <Version>
Product Documentation ¥

Installation Guide }

SAP Analysis

SAP Analysis for Microsoft
Office 2.6 SPO3

Mandatory

https://help.sap.com/
viewer/p/SAP_BUSINES-
SOBJECTS_ANALYSIS_OF-

FICE | <Version>
Installation, Configuration,
Security, and Administration

> Administrator Guide ]

SAP Promotion Management

SAP Promotion Management requires only the common prerequisites.

SAP Merchandise Planning

Prerequisites for SAP Merchandise Planning

Product Minimum Requirement Mandatory/Optional Installation Information
SAP ERP SAP ERP 6.0 Enhancement Mandatory https://help.sap.com/
Package 7 SP16 or higher viewer/p/SAP_ERP
SAP ERP 6.0 Enhancement I <version> » Installation
Package 8 SPO9 or higher and Upgrade ¥ Installation
Guide ]
SAP S/4HANA, on-premise  SAP S/4HANA 1709 FPS2 or  You must install a source https://help.sap.com/
edition higher master data system; either viewer/p/SAP_S4HANA_ON-

SAP ERP or SAP S/4HANA
must be installed.

PREMISE | <Version>
Product Documentation >

Installation Guide 3

SAP Analysis

SAP Analysis for Microsoft
Office 2.6 SPO3

Mandatory

https://help.sap.com/
viewer/p/SAP_BUSINES-
SOBJECTS_ANALYSIS_OF-

FICE|F <Version> ¥
Installation, Configuration,
Security, and Administration

» Administrator Guide 3
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4 Prepare the Installation

Before you start with the actual installation of SAP Customer Activity Repository applications bundle 4.0
FPSO1, you must first perform several preparatory tasks.

1. Implement SAP Notes for the Installation [page 25]
This section lists SAP Notes that you must read and — when appropriate — implement at different
points in the installation process. For additional SAP Notes created after the publication of this
guide, always consult the release information notes 2708055 (for the back-end) and 2708040 ¥
(for the front-end).

2. Verify SAP HANA Users and Privileges [page 37]
SAP Customer Activity Repository applications bundle requires a layered system landscape (SAP
HANA database, ABAP back-end server, ABAP front-end server with SAP Gateway and SAP Fiori). Each
layer requires specific users and privileges. In this procedure, you set up the users and privileges for the
SAP HANA database (level 1).

3. Verify Correct Schema Mapping [page 40]
In SAP HANA studio, verify that all authoring schemas of SAP Customer Activity Repository
applications bundle are mapped to the correct physical schema of your customer back-end system. If
necessary, create any mappings that are missing. This procedure is mandatory for all the applications.

4. Configure AFL Usage [page 42]
Perform configuration tasks to enable the usage of application function libraries (such as the PAL and
the OFL) for the applications SAP Assortment Planning and SAP Allocation Management.

4.1 Implement SAP Notes for the Installation

This section lists SAP Notes that you must read and — when appropriate — implement at different points in
the installation process. For additional SAP Notes created after the publication of this guide, always consult
the release information notes 2708055/ (for the back-end) and 2708040#% (for the front-end).

i Note

Make sure that you have the up-to-date version of each SAP Note, which you can find on the SAP Support
Portal at http://support.sap.com/notes .

i Note

The Implement column indicates when to apply the SAP Note.

A Caution

Always consult the table for SAP Customer Activity Repository, regardless of your scenario. Notes listed
here are often common corrections, applicable to all consuming applications.
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SAP Notes for SAP Customer Activity Repository

SAP Notes for SAP Customer Activity Repository

Implement

Area

SAP Note

Description

Prior to the installa-

tion

Back-end

2548843

DD: data ele-
ment changes
from DEC to
CURR, error for
dependent
views

Mandatory correction for all the applications.

During the installa-

tion

Back-end

22983407k

SAP HANA DB:
CDS views with
external views
as base ob-
jects cannot be
created in the
DB

Troubleshooting information for error messages during the “move
nametabs” phase.

During the installa-

tion

Back-end

2340418t

SAP HANA DB:
RUTDDL -
SCREATE re-
turns errors for
CDS views with
external views
as base object

Troubleshooting information for error messages during the
RUTDDLSCREATE phase.

During the installa-

Back-end

2377525k

Troubleshooting information for error messages during the

tion ) CREATE VIEW phase.
External view
in view hierar-
chy
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Implement Area SAP Note Description
During the installa- Back-end 2330184 M Troubleshooting information for error messages during various
tion RSDBO2CK-related phases (SUM only). For example, ZEETGO02
Appearance of L
Nor-Exi View "/AMR/C_P_A_L_C" does not exist in the database or
on-Exis-
) 2EETGOOZ2 View "/AMR/V_APITSLOC" does not exist in the data-
tence/Activa-
) base.
tion Errors of
Views/DDL
Sources within
installation of
CARAB 1.0
FPO3 and
CARAB 2.0
After the installation  Front-end 2183947 P Information on how to install add-on object UTSAFND1 100 when
. installing the SAP Smart Business Modeler Apps Framework with
Smart Busi-
User Interface Add-On 2.0 for SAP NetWeaver.
ness for SoH
(Suite on
Hana) delivery
After the installation  Back-end 1778607 P Optional (only relevant if you choose to implement SAP HANA
Live for SAP Business Suite). Release information and implemen-
SAP HANA ) ) )
tation considerations.
Live for SAP
Business Suite
After the installation  Back-end 2623953 Mandatory if you are using omnichannel article availability and
sourcing (OAA) and using the functionality in sales channel mode.
SADL GW: Ex- ) ) N
for A Not required for functions other than OAA. Not required if you are
posur‘e oran using OAA in OAA profile mode.
notations on
Entity Con-
tainer with
namespace
After the installation  Back-end 2625428 M Mandatory if you are using omnichannel article availability and
sourcing (OAA) and using the functionality in sales channel mode.
SADL GW: Ex-

posure for An-
notations on
Entity Con-
tainer with
namespace

Not required for functions other than OAA. Not required if you are
using OAA in OAA profile mode.
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Implement Area SAP Note Description
After the installation  Front-end 2547022 Only required if your front-end server is version 7.50 or lower:
Service cannot Mandatory if you are using omnichannel article availability and
be consumed  sourcing (OAA) and using the functionality in sales channel mode.
in SDK 10S due Not required for functions other than OAA. Not required if you are
to invalid char- using OAA in OAA profile mode.
acter " in Enti-
tyContainer
namespace
After the installation  Front-end 27628190 M Mandatory correction for any scenario using the Manage Product
Attributes app. The correction is required for the new
Adding new
SAP ISR BR DDF ADMIN role for the app.
SAP Fiori cata- -
log entry and i Note
group for new
DDF role (SAP The app is used by several scenarios, such as SAP Customer
Customer Ac- Activity Repository (similar products search), SAP
tivity Reposi- Assortment Planning, or SAP Allocation Management.
tory applica-
tions bundle
4.0 FPSO1)
After the installation  Front-end 2763472 P Mandatory correction for any scenario using the Manage Product
Attributes app. The correction is required for the new
New Role
SAP ISR BR DDF ADMIN role for the app.
"SAP_ISR_BR_ - - - =
DDF_ADMIN" i Note
for SAP Fiori
apps (SAP The app is used by several scenarios, such as SAP Customer
Customer Ac- Activity Repository (similar products search), SAP
tivity Reposi- Assortment Planning, or SAP Allocation Management.
tory applica-
tions bundle
4.0 FPS01)
After the installation ~ Front-end 2760697 P Mandatory corrections for Analyze Forecast and Adjust Forecast.
Corrections for
the Analyze
Forecast and
Adjust Fore-
castapps in
SAP Customer
Activity Repo-
sitory 4.0
FPSO1
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Implement Area SAP Note Description
After the installation  Back-end and 2763337 Collective note for mandatory corrections for demand planning
front-end Demand Plan- functionality. You need to apply these corrections for working with
ning CARAB the Manage Demand Influencing Factors and the Adjust Forecast
4.0 FPSO1 - apps. The collective note references more notes:
Collective Note o gacy_end: 2766184k
for Corrections
before RTC e Additional back-end improvements: 2780905 #r
e Manage Demand Influencing Factors app: 2766567 #r
e Adjust Forecast app: 2766169 Fir
After the installation  Back-end 2770192 P Mandatory corrections for the similar products search in SAP
Customer Activity Repository. The note enables the full configura-
Corrections for . ) .
tion of the search via the Manage Product Attributes app.
the Similar
Products i Note
Search in SAP
Customer Ac- Implement this note also for SAP Assortment Planning if you
tivity Reposi- are using the search for this scenario.
tory applica-
tions bundle
4.0 FPSO1
After the installation  Back-end 2771130 Fr Mandatory corrections for the SAP Fiori apps Analyze Forecast,
Adjust Forecast, and Manage Demand Influencing Factors.
Back-end cor-
rections for the
demand plan-
ning apps (An-
alyze Forecast,
Adjust Fore-
cast, Manage
Demand Influ-
encing Fac-
tors) in SAP
Customer Ac-
tivity Reposi-
tory 4.0 FPSO1
After the installation  Back-end 2576497 P Note for errors produced when material number is longer that 18
SOL Error characters.
Code 274: in-

serted value
too large for
column

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0

FPSO1
Prepare the Installation

PUBLIC 29


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2763337
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2766184
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2780905
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2766567
												
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2766169 
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2770192
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2771130
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2576497

Implement Area SAP Note Description

Mandatory correction for all scenarios of SAP Customer
Activity Repository applications bundle. Implement this note
SAP Allocation regardless of the application that you wish to set up.

After the installation  Back-end 2777415

Management:
Activating /AM
R/* views ends
in Error

SAP Notes for SAP Merchandise Planning

i Note

Always consult the table for SAP Customer Activity Repository, regardless of your scenario. Notes listed
there are often common corrections, applicable to all consuming applications.

SAP Notes for SAP Merchandise Planning

Implement Area SAP Note Description

After the installation  Back-end 1919631 Embedded BW-IP features explicitly needs the NW BPC10.1 li-

cense along with the PAK.
Activating the

BPC imbedded
is necessary

After the installation  Back-end 2600370 P The time-independent navigation attribute table of the character-

istic (X table) is fully or partially empty.
The input help

for time char-
acteristics
used as navi-
gation attrib-
utes does not
return any data

SAP Notes for SAP Assortment Planning

i Note

Always consult the table for SAP Customer Activity Repository, regardless of your scenario. Notes listed
there are often common corrections, applicable to all consuming applications.
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SAP Notes for SAP Assortment Planning

Implement Area SAP Note Description

Prior to the installa- ~ SAP Retail sys- 2196351 Corrections to SAP Retail data elements.

tion tem
Pre-requisite

for SAP Note
#2196323

Prior to the installa- SAP Retail sys- 2196323#% Article Hierarchy Transfer replication will transfer all node and ar-
tion tem ticle assignments irrespective of the validity.

DRFOUT: Only
valid current
node assign-
ments and ar-
ticle assign-
ments are
transferred
during Article
Hierarchy Rep-
lication

Prior to the installa- ~ SAP Retail sys- 2209621 Functionality on the SAP Retail side to enable PIR integration with

tion tem SAP Assortment Planning.
Assortment

Listing API:
List by DC fix

Prior to the installa- ~ SAP Retail sys- 2286994 Supports:
tion tem

New Listing e Different listing periods for different products within an as-
AP for Retail sortment

Assortment e (Changes in the listing after a product has been listed
Planning ® |n-season listing changes

e Multiple validity time periods for the same location

Prior to the installa-  Back-end 1656983 M Information on changing the default ResultSetSizeLimit set-
tion ) ting.

Result Set Size

Limit Exceeded

Message
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Implement Area SAP Note Description
Prior to the installa-  Back-end 2564718 Corrections to the installation of InfoProviders (SAP BW).
tion
Authorization
replication ter-
minates with
the SQL error
message
Predicates
are
required
in a where
clause:
unknown
user name
After the installation  Back-end 2706022 This note is relevant if you use the Retail SAP BW Structure. This
note contains instructions for solving a BW issue in the Plan
When Current  proqiycts by Week worksheet of the Plan Assortment workbook.
Member is ac-
tivated on
OFISCYEAR,
the calculation
was not possi-
ble
After the installation Back-end 2768113 M This note includes instructions to avoid creating corrupt data in
database tables and issues with the Match Placeholders and My
PHP Number  assortment Lists apps.
Range Config-
uration Infor-
mation
After the installation  Back-end 2773890 This optional note for the My Assortment Lists app includes the
following:
Assortment
List4.0-Add ® Instructions for adding additional access control objects for
access control OData entities
objects for e Bug fix regarding sorting issues for business week and fiscal
OData entities month
and bug fixes e Bug fix for module assignment that is not kept when replac-
ing a product in the similar products table
After the installation Front-end 2772899 M This mandatory note for the My Assortment Lists app includes the
following:
Assortment
List 4.0 - Sta- e Stableidsto be able to assign hotspots for Web Assistant
ble ids for Ul o Bug fixes for the Manage Products screen
elements
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Implement Area SAP Note Description

Front-end

After the installation 2767553 M This mandatory note for the Manage Option Plans app includes

several bug fixes.
APR 4.0 FPO1 -

Manage Option
Plans Ul OP-
TION PLAN-
NING - Ul Fixes

Back-end This mandatory note for the My Assortment Lists app includes a

bug fix.

After the installation 2784220 %

Assortment
List 4.0 - Col-
umn with con-
catenated val-
ues too large

Front-end This mandatory note for the My Assortment Lists app includes en-

hancements and bug fixes.

After the installation 2776566

Assortment
List4.0 - En-
hance Update
products and
Multi-Copy/
Merge extensi-
bility and bug
fixes

SAP Notes for SAP Promotion Management

i Note
Always consult the table for SAP Customer Activity Repository, regardless of your scenario. Notes listed

there are often common corrections, applicable to all consuming applications.

SAP Notes for SAP Promotion Management

Implement Area SAP Note Description

Front-End Mandatory. Fiori - Latest version of Manage Promotional Offers

After the installation 2606408%F

Promotional
Offers CARAB
2.0 SPS0O5
(FPO3)
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SAP Notes for SAP Allocation Management

i Note

Always consult the SAP Notes for SAP Customer Activity Repository, regardless of your scenario. Notes
listed there are common corrections, applicable to all consuming applications.

SAP Notes for SAP Allocation Management

Implement

Area

SAP Note

Description

After the installation

Back-end and
front-end

2778617 P
SAP Allocation
Management
4.0 - Collection
of Corrections
Before RTC for
FPO1

This note comprises all corrections for SAP Allocation
Management for all architecture layers (SAP Fiori, ABAP (Gateway
and back-end), and SAP HANA DB) up to the RTC date of 4.0
FPSO1.

After the installation

Follow-On Sys-
tem

2618509 Fr

Blacklisted
RFC for Crea-
tion of Alloca-
tion Table in
S4H System

Implement the correction to facilitate the creation of allocation ta-
bles from SAP Allocation Management in the SAP S/4HANA fol-
low-on system.

After the installation

Back-end

2631613 P

SAP Allocation
Management -
Customizing -
Define Busi-
ness Scenarios

Follow the instructions to create a valid business scenario ID.

After the installation

Back-end

2632881 P

SHDB: Low
and High Val-
ues are clipped
during conver-
sion of Selec-
tionTables into
WHERE
clauses

This note contains corrections regarding the SAP HANA database.
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Implement

Area

SAP Note

Description

After the installation

Back-end

2502917 e

Unable to reg-
ister the serv-
ice /AMR/
OD_WORKLOAD
SRV with

namespace

This note is only relevant if the back-end component SAP_GWEND

752 is below SP 2.

After the installation

Back-end

2474287 P

Handling of
units of meas-
ure inside SAP
Allocation
Management

After the installation

SAP S/4HANA
Retail for mer-
chandise man-
agement

2522603 %

Wrapper RFC
for ATP via
Controller

After the installation

Back-end

2641286

Internal server
error
LCX_MISS-
ING_PARAME-
TER in
CL_SADL_ABQ
|

After the installation

Back-end

2636746 P

OData Naviga-
tion not work-
ing
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Implement

Area

SAP Note

Description

After the installation

Back-end

2441184

Static ABAP
generation er-
ror of

classes /AMR/
CL... when in-
stalling CARAB
1.0 FPO3,
CARAB 2.0,
and CARAB
4.0

After the installation

Back-end

27774155

SAP Allocation
Management :

Activating /AM
R/* views ends
in Error

Mandatory correction

After the installation

Follow-On Sys-
tem

2416853 P

RFC function
module to cre-
ate allocation
table for SAP
Allocation
Management

Enhanced functionality for the transfer of allocation data to an

ECC system.

After the installation

Follow-On Sys-
tem

2524857 P

RFC function
module to cre-
ate allocation
table for SAP
Allocation
Management
in S4H system

Creation of an allocation table from SAP Allocation Management

in SAP S/4HANA system for the transfer of allocation plans.

Parent topic: Prepare the Installation [page 25]

Next: Verify SAP HANA Users and Privileges [page 37]
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4.2 Verify SAP HANA Users and Privileges

SAP Customer Activity Repository applications bundle requires a layered system landscape (SAP HANA
database, ABAP back-end server, ABAP front-end server with SAP Gateway and SAP Fiori). Each layer requires
specific users and privileges. In this procedure, you set up the users and privileges for the SAP HANA database

(level 1).

Overview

A Caution

ABAP Front-End Server (SAP Gateway, SAP Fiori)

User, roles, groups, and catalogs required to use the SAP Fiori apps
that form the user interfaces of the applications in SAP Customer
Activity Repository applications bundle.

ABAP Back-End Server

User and roles to access the relevant Customizing activities and use
core functionality of the applications in SAP Customer Activity

Repository applications bundle.

\ SAP HANA Database /

Users and privileges allowing the applications in SAP Customer
Activity Repository applications bundle to access SAP HANA views
and procedures, which provide access to data and functionality
directly on the database level (such as the SAP RTL AFL application
function libraries).

S~ I

Authorization Levels in SAP Customer Activity Repository applications bundle

Level 1: You must set up the users and privileges for the SAP HANA database before installing SAP
Customer Activity Repository applications bundle on the back-end server and the front-end server.

i Note

Level 2 and level 3: You can only set up these authorizations after the installation, and you will get to them

later in this guide:

e |evel 2 back-end authorizations are described under Verify Back-End Users and Roles.

e |evel 3 front-end authorizations are described under Assign Roles, Catalogs, and Groups in SAP Fiori
Launchpad (SAP Assortment Planning), Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad
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(SAP Allocation Management), and Set Up Standalone SAP Fiori Apps for SAP Customer Activity
Repository [page 108] (optional, app-specific).

Procedure
1. Ensure that the SAP HANA database users listed below exist and that they have the required roles/
privileges.

A\ Caution

Users marked * must be identical on all three levels: that is, on the SAP HANA database level, on the
back-end server, and on the front-end server.

Users Privileges / Roles

SAP<SID> o Privilege REPO. IMPORT
o Privilege ROLE ADMIN

This is the generic database user

. . o Privilege STRUCTUREDPRIVILEGE ADMIN
specified for the connection from the g

SAP NetWeaver back-end server to ©  Privilege EXECUTE on procedure TRUNCATE PROCEDURE OBJECTS
the SAP HANA database. o Privilege EXECUTE on procedure GET PROCEDURE OBJECTS
© Role CONTENT ADMIN
© Role AFLPM CREATOR ERASER_EXECUTE
This role must be assigned to execute functions of the PAL library (re-
quired by SAP Assortment Planning, for example).
For more information, see Enable Usage of PAL Functions [page 42] and
SAP Note 2046767 ¥ .
0 RoleAFL SYS AFL OFL AREA EXECUTE
o Grant the following additional privileges, with option Grantable to others,
on these schemas:
Onschema sys BIC:
o Privilege CREATE ANY
o Privilege ALTER
Onschema <SAP Retail or SAP S/4HANA schema name>:

o Privilege SELECT
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Users Privileges / Roles

SYS REPO o Privilege SELECT, with option Grantable to others, on the following physical
- database schemas:
o Physical database schema of your back-end system, this is referred to
as SAP<SID> in this guide (
o Physical database schema that contains the SAP Retail or SAP S/
4HANA tables
o Physical database schema that contains the SAP CRM tables
o Physical database schema that contains the SAP Marketing tables
You can use the following example SQL statement to grant the privilege:
GRANT SELECT ON SCHEMA <Your schema name> TO
_SYS REPO WITH GRANT OPTION;
© Role UDF DEPLOY SYS REPO. Forinformation about the privileges auto-
matically assigned via this role, see Set Up Authorizations for Unified De-
mand Forecast (UDF) [page 73].
o For SAP Allocation Management, you need the following additional privi-
leges:
o  Privilege CREATE ANY

o Privilege CREATE SCHEMA

<Your User Name> * ©  Privilege SELECT onschema _SyS_BI

o Privilege SELECT on schema SAP<SID>
©  Privilege EXECUTE on procedure REPOSITORY REST
o The Session Client of this database user must be set to the appropriate
back-end system client.
This step is necessary to use the SAP Assortment Planning planning
framework, where SAP Analysis for Microsoft Office workbooks obtain
data from SAP HANA views.
For more information, see the Assign Default Client section in the SAP
HANA Modeling Guide.
1. Logonto SAP HANA studio.
2. Open the Modeler perspective and use the Navigator to access your
back-end system.
Under Security, select a user.
Set the Session Client to the client number created in the Set Up SAP
Client procedure .

Parent topic: Prepare the Installation [page 25]

Previous: Implement SAP Notes for the Installation [page 25]

Next: Verify Correct Schema Mapping [page 40]
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4.3 Verify Correct Schema Mapping

In SAP HANA studio, verify that all authoring schemas of SAP Customer Activity Repository applications
bundle are mapped to the correct physical schema of your customer back-end system. If necessary, create any
mappings that are missing. This procedure is mandatory for all the applications.

Context

What are Authoring Schemas and Physical Schemas

The SAP HANA content of SAP Customer Activity Repository applications bundle is delivered with several
authoring schemas (for different scenarios and different source master data systems).

You must map multiple authoring schemas to the same physical schema:

e The authoring schema is the logical database schema with which the SAP HANA objects were originally
created in the SAP source system. The authoring schemais listed in each object's properties. Different
objects can have different authoring schemas.

® The target system is your customer-specific back-end system. Its database schema is the physical
schema. The tables of the source master data system are replicated to this back-end system and physical
schema. This is why all authoring schemas must be mapped to this one physical schema of your customer
system (n:1 relationship).

What is Your sap<s1D> Name (Schema Name, User Name)

In this guide your physical schema is referred to as SAap<sID>. This is your customer-defined database system
ID.

There are two ways how you can find the Sap<S1D> name for your system landscape:

e [ ogon toyour ABAP back-end system using SAP Logon. Choose System Status. In the lower right-hand
section titled Database data, see the name for Schema.

e |n SAP HANA studio, the schema name is listed as an object under Catalog.

Substitute this schema name whenever the SAp<s1D> variable is used in this guide.

Why Schema Mapping

e Schema mapping allows transporting SAP HANA objects from a source system to a target system. For
example, from the SAP delivery system to your test system, or from your test system to your production
system.

e Schema mapping is a prerequisite for the successful activation of the SAP HANA content.

e Schema mapping is also a prerequisite for the SLT replication of the source master data system tables.
Example: Your source master data system is SAP S/4HANA. During table replication with the SAP
Landscape Transformation Replication Server, you replicate the SAP S/4HANA tables from the sap _s4n
authoring schema to the physical schema in your SAP Customer Activity Repository applications bundle
system.
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Authoring Schemas

You have two sets of authoring schemas:

Authoring Schemas in SAP Customer Activity Repository applications bundle

SAP CAR SAP HANA objects for SAP Customer Activity Repository

SAP DDF SAP HANA objects for Demand Data Foundation and Unified

Demand Forecast

SAPOSA SAP HANA objects for On-Shelf Availability
SAP_RAP SAP HANA objects for consuming applications
SAP_RTLRAP_AMR SAP HANA objects for SAP Allocation Management

Authoring Schemas for Source Master Data Systems

SAP CRM SAP Customer Relationship Management
SAP_CUAN SAP Marketing

SAP_ECC SAP ERP (SAP Retail)

SAP_S4H SAP S/4HANA Retail

Procedure

1. In SAP HANA studio, log on to your back-end system.

2. Choose |» Window ¥ Perspective » Open Perspective » SAP HANA Modeler 3

3. Choose|l» Help ¥ Quick View  Schema Mapping 3.

4. Select the system and choose Next.

5. Do the following for the two sets of schemas:

o Map all authoring schemas of the first table above to the same physical schema (saAp<s1D>)in
your customer system. If necessary, add new mappings.
o Map each authoring schema of the second table above to the physical schema for the respective
source master data system in your customer system. If necessary, add new mappings.
6. Choose Finish.

Parent topic: Prepare the Installation [page 25]

Previous: Verify SAP HANA Users and Privileges [page 37]

Next: Configure AFL Usage [page 42]
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4.4 Configure AFL Usage

Perform configuration tasks to enable the usage of application function libraries (such as the PAL and the OFL)
for the applications SAP Assortment Planning and SAP Allocation Management.

Enable Usage of PAL Functions (SAP Assortment Planning) [page 42]
To enable the usage of the PAL algorithm for SAP Assortment Planning, perform the required setup
steps.

Check the OFL Installation [page 43]
Confirm that the OFL algorithm was installed successfully as prerequisite for SAP Assortment Planning
and SAP Allocation Management.

Parent topic: Prepare the Installation [page 25]

Previous: Verify Correct Schema Mapping [page 40]

4.4.1 Enable Usage of PAL Functions (SAP Assortment
Planning)

To enable the usage of the PAL algorithm for SAP Assortment Planning, perform the required setup steps.

Use

The installation of SAP HANA Platform includes the installation of the PAL algorithm, a prerequisite for SAP
Assortment Planning.

To enable the usage of the PAL algorithm, as required by SAP Assortment Planning, perform the following
procedure.

i Note

You do not need to create the AFL. WRAPPER GENERATOR Of AFL_WRAPPER ERASER procedures, nor do
you need to generate any special PAL procedures; this is done automatically.

Procedure

1. To confirm that the PAL functions were installed successfully, you can run SELECT statements in the three
relevant public views as follows:
© SELECT * FROM SYS.AFL AREAS WHERE AREA NAME = 'AFLPAL';
In the case of a successful installation, the statement should return 1 row.
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o

SELECT * FROM SYS.AFL PACKAGES WHERE AREA NAME = 'AFLPAL';
In the case of a successful installation, the statement should return 1 row.
SELECT * FROM SYS.AFL FUNCTIONS WHERE AREA NAME = 'AFLPAL' ;

In the case of a successful installation, the statement should return many rows. Verify that the function

KMEANS is part of the list.

select * from SYS.AFL_FUNCTIONS WHERE AREA NAME = 'AFLPAL'

FUNCTION_OID SCHEMA_NAME AREA_NAME PACKAGE_NAME FUNCTION_NAME CREATE_TIMESTAMP INPUT_PARAMETER_COUNT
101 574,505,979 _SYS_AFL AFLPAL PAL KMEANS Apr 20, 2017 4:45:41.852 AM 2
102 574505980 _SYS_AFL AFLPAL PAL KMEANS_OVERLOAD_2 4 Apr 20, 2017 4:45:41.86 AM 2
103 574,505,981 _SYS_AFL AFLPAL PAL KMEANS__OVERLOAD_2 5 Apr 20, 2017 4:45:41.869 AM 2
104 574,505,982 _SYS_AFL AFLPAL PAL KMEDQIDS Apr 20, 2017 4:45:41.877 AM 2
105 574,505,983 _SYS_AFL AFLPAL PAL KMEDIANS Apr 20, 2017 4:45:41.885 AM 2
106 574505984 SYS AFL AFLPAL PAL VALIDATEKMEANS Apr 20, 2017 4:45:41.893 AM 3

More Information

Section Install the Prerequisites [page 171 | Common Prerequisites » SAP HANA Platform 3
http://help.sap.com/hana_platform# | <Version> » Reference » SAP HANA Predictive Analysis Library
(PAL) 3

4.4.2 Check the OFL Installation

Confirm that the OFL algorithm was installed successfully as prerequisite for SAP Assortment Planning and
SAP Allocation Management.

Use

The installation of SAP HANA Platform includes the installation of the OFL algorithm, a prerequisite for SAP
Assortment Planning.

Procedure

To confirm that the OFL was installed successfully, you can run SELECT statements in the three relevant
public views as follows:
© SELECT * FROM SYS.AFL_AREAS WHERE AREA NAME = 'OFL_AREA';

In the case of a successful installation, the statement should return 1 row.
SELECT * FROM SYS.AFL PACKAGES WHERE AREA NAME = 'OFL_AREA';
In the case of a successful installation, the statement should return 1 row.
SELECT * FROM SYS.AFL FUNCTIONS WHERE AREA NAME = 'OFL_AREA';

In the case of a successful installation, the statement should return 4 rows. Verify that the function
GENIOS_ SOLVE is part of the list.
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FUNCTION_QID SCHEMA NAME AREA NAME PACKAGE NAME FUNCTION NAME 'CREATE_TIMESTAMP INPUT_PARAMETER_COUNT RETURN_VALUE COUNT FUNCTION TYPE TECHNICAL CATEGORY
i 574,506,051 SVS.AFL OFLAREA  OFL GENIOS_SOLVE Apr 20, 2017 44611926 AM 7 3 Tfunc var_none i
2 574508052 _SYS_AFL OFLAREA  OFL NETWORK_SIMPLEX_SOLVE Apr 20, 2017 4:46:11.932 AM 7] 1 LFunc var_none
3 574,508,053 _SVSAFL OFLAREA  OFL COST_SCALING_SOLVE Apr 20, 2017 44611937 AM 2 1 Lfunc var.none
4 574,508,054 _SYS_AFL OFLAREA  OFL LAPIV_SOLVE Apr20, 2017 446:11.942 AM 2 4 LFunc var_nane
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5 Install the Software

For a correct installation, you must first install the required prerequisites and pre-installation SAP Notes. Then
you install the back-end components and the front-end components. Lastly, you check for SAP Notes that
must be implemented after the installation.

1. Verify Prerequisites and SAP Notes [page 45]
Ensure that the required prerequisites and SAP Notes have been implemented in your system
landscape.

2. Install ABAP Back-End Server [page 46]
Install the SAP RTL AFL FOR SAP HANA componentinthe SAP HANA database. In your back-end
system, then install the back-end product version of SAP Customer Activity Repository applications
bundle and set up an SAP client.

3. Install ABAP Front-End Server [page 53]
Install the complete Ul layer in the front-end system. This Ul layer consists of SAP Gateway, the central
SAP Fiori Ul component (SAP Fiori front-end server), and the product-specific SAP Fiori Ul component
(front-end product version of SAP Customer Activity Repository applications bundle).

4. Install Alternate Storage (Optional) [page 57]
You only need to implement this procedure if you plan on using the Table Content Aging report delivered
with SAP Customer Activity Repository. This report allows you to copy your transaction log (TLOG)
data and its extensions from your SAP HANA database to an alternate storage technology (such as
SAP IQ or Apache Hadoop), thereby reducing your total cost of hardware ownership.

5.1 Verify Prerequisites and SAP Notes

Ensure that the required prerequisites and SAP Notes have been implemented in your system landscape.

1. Verify that you have installed and configured the required prerequisites for your scenario. See Install the
Prerequisites [page 17] under Common Prerequisites and Application-Specific Prerequisites.

2. Verify that all SAP Notes that must be applied before the installation and that are required for your
scenario have been implemented.
See Implement SAP Notes for the Installation [page 25].

i Note

Always consult the table for SAP Customer Activity Repository, regardless of your scenario. Notes
listed there are often common corrections, applicable to all consuming applications.

Parent topic: Install the Software [page 45]

Next: Install ABAP Back-End Server [page 46]
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5.2 Install ABAP Back-End Server

Install the saP RTL AFL FOR SAP HANA componentinthe SAP HANA database. In your back-end system,
then install the back-end product version of SAP Customer Activity Repository applications bundle and set up
an SAP client.

Context

The ABAP back-end server is based on SAP NetWeaver. It contains the products that provide the business logic
and the back-end data, including users, roles, and authorizations.

i Note

For a general system landscape overview, see https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION
|+ <Version> ¥ Installation and Upgrade # SAP Fiori: Setup and Configuration  Setup of SAP Fiori System
Landscape 3.

1. Download and Install the Application Function Library (SAP RTL AFL FOR SAP HANA) [page 47]

Install compatible revisions of the SAP RTL AFL FOR SAP HANA component, the SAP HANA AFL
component, and the SAP HANA database. You must do this before you install the back-end product
version of SAP Customer Activity Repository applications bundle.

2. Install SAP Customer Activity Repository applications bundle (Back-End Product Version) [page 49]
Install the saP CARAB 4.0 FPSO01 back-end product version of SAP Customer Activity Repository
applications bundle 4.0 FPSOL.

3. SetUp SAP Client [page 51]

Set up an SAP client on your back-end system. The steps to follow depend on whether your scenario
uses the Demand Data Foundation (DDF) module in SAP Customer Activity Repository or not.

Parent topic: Install the Software [page 45]
Previous: Verify Prerequisites and SAP Notes [page 45]

Next: Install ABAP Front-End Server [page 53]
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5.2.1 Download and Install the Application Function Library
(SAP RTL AFL FOR SAP HANA)

Install compatible revisions of the SAP RTL AFL FOR SAP HANA component, the SAP HANA AFL component,
and the SAP HANA database. You must do this before you install the back-end product version of SAP
Customer Activity Repository applications bundle.

Overview

There is one software component in SAP Customer Activity Repository applications bundle that you must
always install first: SAP RTL AFL FOR SAP HANA.

You must download compatible revisions of SAP RTL AFL FOR SAP HANA, SAP HANA AFL,and SAP HANA
DATABASE, and install them together. For this, you need to be aware of the following dependencies.

Dependencies Between AFLs and the SAP HANA Database

Even though SAP RTL AFL FOR SAP HANA is part of SAP Customer Activity Repository applications bundle,
itis released independently.

That is because AFL components (such as SAP RTI, AFL FOR SAP HANA and SAP HANA AFL) follow the
release cycle of the SAP HANA database. The releases are called “revisions”. Whenever a new revision of the
SAP HANA database is released, a new revision of each AFL is released. As a result, there are always multiple
revisions of each component available for download.

A Caution

For each revision of an AFL component, there is only one compatible revision of the SAP HANA database.
Whenever you upgrade the AFLs, you must also upgrade the database to the compatible revision.
Whenever you upgrade the database, you must also upgrade the AFLs.

i Note

When you download an AFL from the SAP Support Portal, the compatible revision of the SAP HANA
database is always indicated.

Download and Install SAP RTL. AFL FOR SAP HANA

1. Determine which revision of the SAP HANA database and the AFL components you need.
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To select the best revision for your scenario, see the following:

o Insection Install the Prerequisites [page 17], see ¥ Common Prerequisites % SAP HANA Platform 3.
Here you can find the minimum revisions of the SAP HANA database and the AFL components. You
need at least these revisions for the current release.

o If you want to use a higher revision for your scenario, select one of the “Datacenter Service Point
(DSP)" revisions. These are specially verified revisions, which you can find listed in SAP Note 2378962
#ir for SAP HANA Platform 2.0.

For a helpful overview of the different types of SAP HANA revisions, see the SAP HANA Revision
Strategy slide deck linked from this note.

o SAP Note 1948334#% : This note lists the supported database update paths for SAP HANA
Maintenance Revisions. Consult this note for valid revision combinations for your scenario.

o If you need more information on the release and maintenance strategy of the SAP HANA Platform, see
http://support.sap.com® |+ Download Software » By Alphabetical Index (A-Z) » H » SAP HANA
PLATFORM EDITION ¥ <your edition> ¥ INFO 7.

Once you have selected a revision, this gives you the compatible revisions of the other components.
2. Download the compatible revisions from the SAP Support Portal at http:/support.sap.com# | Download
Software 3

->Tip

Alternatively, you can log in to the SAP ONE Support Launchpad at https://
launchpad.support.sap.com/#/softwarecenter/# and follow the navigation from there.

O SAP RTL AFL FOR SAP HANA:

This component is included in the SaP CARAB back-end product version. You can find the available
revisions under | By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE » SAP
CARAB 4.0 » Support Packages and Patches » DOWNLOADS j» COMPRISED SOFTWARE
COMPONENT VERSIONS  SAP RTL AFL FOR SAP HANA 200 3.

O SAP HANA AFLand SAP HANA DATABASE!

These components are included in the SAP HANA Platform. You can find the available revisions under
| By Alphabetical Index (A-Z) » H » SAP HANA PLATFORM EDITION » SAP HANA PLATFORM
EDITION 2.0 ¥ Support Packages and Patches j» DOWNLOADS ¥ SAP HANA AFL 2.0 J and SAP HANA
DATABASE 2.0.

o |If applicable, other AFLs provided with the SAP HANA Platform that might be relevant for your
scenario. For an overview, see the Managing SAP HANA System Components section of the SAP HANA
Server Installation and Update Guide under https://help.sap.com/viewer/p/SAP_HANA_PLATFORM
| <Version> ¥ Installation and Upgrade 1.

3. Install the selected revisions of SAP RTL AFL FOR SAP HANA, SAP HANA AFL,and SAP HANA
DATABASE.
See SAP Note 2377894 #% and carefully follow the steps for the new installation scenario.

->Tip

If you encounter issues during the installation, see the Troubleshooting [page 154] section for possible
solutions.

Parent topic: Install ABAP Back-End Server [page 46]
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Next: Install SAP Customer Activity Repository applications bundle (Back-End Product Version) [page 49]

5.2.2 Install SAP Customer Activity Repository applications
bundle (Back-End Product Version)

Install the sap CARAB 4.0 FPS01 back-end product version of SAP Customer Activity Repository

applications bundle 4.0 FPSO1.

Prerequisites

e You have completed all of the procedures listed in the previous sections of this guide, in particular, in

section Prepare the Installation [page 25].

® You have installed compatible revisions of the SAP HANA database, the SAP HANA AFL component, and
the SAP RTL AFL FOR SAP HANA component. If you need information on the required minimum revision,

see Install the Prerequisites [page 17].

Overview

In the procedures below you do the following:

Use this tool...

To do this...

Maintenance Planner

More information: https://help.sap.com/viewer/p/MAINTE-

NANCE_PLANNER

Plan your system landscape and create a stack XML file
based on the required product versions.

Software Update Manager (SUM)

More information: https://support.sap.com/en/tools/soft-

ware-logistics-tools/software-update-manager.htm|

Install or upgrade components using the stack XML file.

i Note

It may be possible to install or upgrade components using the SAP Add-On Installation Tool as an
alternative, but this alternative procedure is not described in this guide. For information on whether this is
possible for your implementation scenario and on how to proceed, see SAP Note 1803986 .
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Create the Stack XML File Using Maintenance Planner

i Note
If you encounter issues in Maintenance Planner, see the following SAP Notes for possible solutions:

e 2596901 : NetWeaver 7.51 and 7.52 targets are not available when selecting the option "Update SAP
NetWeaver" in Maintenance Planner

e 2535751#%: Can not select the higher release for Netweaver in Maintenance Planner
o 2314463# : Required file K-XXXxxxxxxxx.SAR is not visible for your user SXxxxxxxx

1. Log onto Maintenance Planner at http://support.sap.com# | Maintenance » Maintenance Information »
Maintenance Planner » Access Maintenance Planner 3.
Choose Plan a New System.
Choose Plan.
Enter a three-character system ID.
Select Installan SAP NETWEAVER System.
Select one of the following product versions and support package stacks:
O ABAP FND 1709 ON HANA and SPS02 (05/2018) (or ahigher support package stack)

o oA W

© ABAP FND 1809 ON HANAand Initial Shipment Stack (or ahigher support package stack)
7. Select a valid instance (for example, SAP Foundation).
8. Choose Confirm Selection.
9. Choose Install or Maintain an Add-On.
10. Select the back-end product version SAP CARAB 4.0 and the support package stack FPsS01 (04/2019).
11. Select theinstance CAR Retail Application Bundle.
12. Choose Confirm Selection.
13. Choose Next.
14. Select the operating system and database for your scenario.
15. Choose Confirm Selection.
16. Review the details of your stack dependent and independent files, then choose Next.

17. Choose Download Stack XML.
You have now created the stack XML file.

Install the Stack XML File Using Software Update Manager (SUM)

1. Download and install the SUM tool:
1. Seethe SAP Support Portal at https://support.sap.com/en/tools/software-logistics-tools/software-
update-manager.htm| .
2. Consult the information for SUM 2.0 SP xx and follow the instructions.
2. In SUM, install your add-on product using the stack XML file that you have created in the first procedure.
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Result

You have successfully installed the back-end product version.

i Note

With this installation, the SAP HANA content for Unified Demand Forecast (UDF) has already been
activated automatically. This saves you a manual activation step later on.

Continue with the next section.

Parent topic: Install ABAP Back-End Server [page 46]
Previous: Download and Install the Application Function Library (SAP RTL AFL FOR SAP HANA) [page 47]

Next: Set Up SAP Client [page 51]

5.2.3 Set Up SAP Client

Set up an SAP client on your back-end system. The steps to follow depend on whether your scenario uses the
Demand Data Foundation (DDF) module in SAP Customer Activity Repository or not.

Procedure for All Scenarios Using DDF

Do this procedure in the following cases:

e You want to model and forecast demand using the UDF module in SAP Customer Activity Repository.

® You want to use the Omnichannel Promotion Pricing (OPP) module in SAP Customer Activity Repository.
e You want to use SAP Allocation Management.

® You want to use SAP Assortment Planning.

® You want to use SAP Merchandise Planning.

e You want to use SAP Promotion Management.

1. Create the necessary client on your back-end system using the client maintenance transaction (scc4).

O\ Caution

If you are performing a client copy, only do this after a successful import of all related software
components. Also, only import or transfer Customizing tables after this client copy is complete, as
described in SAP Note 337623 .

2. Make the required settings in the Define Logical Systems Customizing activity under |+ Cross-Application

Components » Demand Data Foundation » Basic Settings 3.
Read the activity documentation to verify your settings. If you are using multiple source master data
systems and/or clients, you must define a logical system for each system/client.
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Furthermore, you use this activity to define the master data system type (SAP Retail (SAP ERP) or SAP S/
AHANA).

Procedure for Scenarios Not Using DDF

Do this procedure if you are implementing a non-DDF scenario:

52

POS Data Transfer and Audit

Multichannel Transaction Data Management
Inventory Visibility

On-Shelf Availability

Verify the client numbers in the source SAP Retail or SAP S/4HANA system and in the source systems of
optional products that you wish to implement with SAP Customer Activity Repository (such as SAP CRM
and SAP Marketing).

This installation includes SAP HANA content that provides views on a combination of client-dependent
data authored in these source SAP systems. For instance, sales documents are created in a source SAP
Retail system and are replicated to the repository. Likewise, customer information can be optionally
replicated from a source SAP CRM or SAP Marketing system.

. Create the necessary client on your back-end system using the client maintenance transaction (scc4).

O\ Caution

If you are performing a client copy, only do this after a successful import of all related software
components. Also, only import or transfer Customizing tables after this client copy is complete, as
described in SAP Note 337623 .

Using the same client number might not be possible due to the specifics of your implementation and client
setup rules. In this case, you must use SLT transformation rules before replicating data to transform the
source SAP Retail or SAP S/4HANA, and optionally, the source SAP CRM or SAP Marketing, client(s) to
match the client on your back-end system.

«» Example

If SAP Retail and SAP CRM (or SAP Marketing) are set up on client 100 in your implementation, you
should also set up your installation on client 100. If, for any reason, you are unable to do so, you can
transform the source client to 100 using SLT transformation rules.

Cross-system information is client-dependent. As a result, the SAP Client (MANDT) attribute must be used
as one of the join attributes in the SAP HANA views to combine cross-system sales and master data. All
data (whether created or replicated) must be affiliated with the same client number.

If required, enable multiple master data system support and define client mapping for each of the master
data systems. Do this in the Client Mapping For Multiple ERP Systems Customizing activity under [ SAP
Customer Activity Repository ¥ General Settings 3.
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More Information

If you require more information about the client concept, see https://help.sap.com/viewer/product/
SAP_NETWEAVER_AS_ABAP_752 ¢ Application Help # SAP NetWeaver Library: Function-Oriented View
Application Server ABAP » Other Services ¥ Services for Administrators » Client Concept 4.

Parent topic: Install ABAP Back-End Server [page 46]

Previous: Install SAP Customer Activity Repository applications bundle (Back-End Product Version) [page 49]

5.3 Install ABAP Front-End Server

Install the complete Ul layer in the front-end system. This Ul layer consists of SAP Gateway, the central SAP
Fiori Ul component (SAP Fiori front-end server), and the product-specific SAP Fiori Ul component (front-end
product version of SAP Customer Activity Repository applications bundle).

Context

The ABAP front-end server contains all the infrastructure components to generate an SAP Fiori app-specific
Ul for the client and to communicate with the back-end systems. The Ul components and SAP Gateway are
based on SAP NetWeaver.

The central SAP Fiori Ul component is a framework that provides the common infrastructure for all SAP Fiori
apps: The SAP Fiori launchpad is the basis of all SAP Fiori Uls, and provides fundamental functions for SAP
Fiori apps (such as logon, surface sizing, navigation between apps, and role- based app catalogs). End-users
access the SAP Fiori apps from the SAP Fiori launchpad.

i Note

For a general system landscape overview, see https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION
|+ <Version> » Installation and Upgrade » SAP Fiori: Setup and Configuration » Setup of SAP Fiori System
Landscape 3.

1. Install SAP Gateway on the ABAP Front-End Server [page 54]
SAP Gateway (saP_GWFND) is a component in SAP NetWeaver. In this procedure, you ensure that the
required SAP NetWeaver version is installed on your ABAP front-end server.

2. Verify Installation of Central SAP Fiori Ul Component [page 55]
The central SAP Fiori Ul component includes the SAPUI5 control library and the SAP Fiori launchpad. It
is delivered as part of the SAP Fiori front-end server. Verify that the required version of the SAP Fiori
front-end server is installed.

3. Install Product-Specific SAP Fiori Ul Component (Front-End Product Version) [page 55]
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Install the SAP FIORI FOR SAP CARAB 4.0 FPSO1 front-end product version for this release. The
product version contains the SAP Fiori apps for SAP Customer Activity Repository applications bundle.
First create a stack XML file with Maintenance Planner and then install the stack XML file with Software
Update Manager (SUM).

Parent topic: Install the Software [page 45]
Previous: Install ABAP Back-End Server [page 46]

Next: Install Alternate Storage (Optional) [page 57]

5.3.1 Install SAP Gateway on the ABAP Front-End Server

SAP Gateway (SAP_GWFND) is a component in SAP NetWeaver. In this procedure, you ensure that the required
SAP NetWeaver version is installed on your ABAP front-end server.

Context

SAP Gateway (sometimes called SAP Gateway Foundation) handles the communication between the ABAP
back-end server and the client on the front-end. It establishes a connection between SAP Business Suite or
application data and target clients, platforms, and programming framework.

i Note

With the central hub deployment option, you use separate servers for the back-end and the front-end
components. For a landscape diagram and more information about deployment options, see System
Landscape [page 13].

Procedure

1. Ensure that the required SAP NetWeaver version is installed on your front-end server. For more
information, see the following:
o Verify the required version. See Install the Prerequisites [page 17] and consult the information under
| Common Prerequisites » Foundation on SAP NetWeaver AS for ABAP, version for SAP HANA 3 and
SAP Fiori.
o Forinstallation and upgrade information for SAP Fiori, see https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION |» <Version> ¥ Installation and Upgrade » SAP Fiori: Setup and

Configuration » Setup of SAP Fiori System Landscape 4, including the Installation subsection.

Parent topic: Install ABAP Front-End Server [page 53]

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
54 PUBLIC Install the Software


https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION
https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION

Next: Verify Installation of Central SAP Fiori Ul Component [page 55]

5.3.2 Verify Installation of Central SAP Fiori Ul Component

The central SAP Fiori Ul component includes the SAPUI5 control library and the SAP Fiori launchpad. It is
delivered as part of the SAP Fiori front-end server. Verify that the required version of the SAP Fiori front-end
server is installed.

Procedure

1. Verify what version is required. In Install the Prerequisites [page 17], see under | Common Prerequisites ¥
SAP Fiori 4.
2. Ensure that the required version is installed on your front-end server.

Parent topic: Install ABAP Front-End Server [page 53]
Previous: Install SAP Gateway on the ABAP Front-End Server [page 54]

Next: Install Product-Specific SAP Fiori Ul Component (Front-End Product Version) [page 55]

5.3.3 Install Product-Specific SAP Fiori Ul Component (Front-
End Product Version)

Install the SAP FIORI FOR SAP CARAB 4.0 FPSO1 front-end product version for this release. The product
version contains the SAP Fiori apps for SAP Customer Activity Repository applications bundle. First create a
stack XML file with Maintenance Planner and then install the stack XML file with Software Update Manager
(SUM).
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Overview

In the procedures below you do the following:

Use this tool... To do this...

Maintenance Planner Plan your system landscape and create a stack XML file

based on the required product versions.
More information: https://help.sap.com/viewer/p/MAINTE- 9 P

NANCE_PLANNER

Software Update Manager (SUM) Install or upgrade components using the stack XML file.

More information: https://support.sap.com/en/tools/soft-

ware-logistics-tools/software-update-manager.htm|

i Note

It may be possible to install or upgrade components using the SAP Add-On Installation Tool as an
alternative, but this alternative procedure is not described in this guide. For information on whether this is
possible for your implementation scenario and on how to proceed, see SAP Note 1803986 ¥ .

Create the Stack XML File Using Maintenance Planner

i Note

If you encounter issues in Maintenance Planner, see the following SAP Notes for possible solutions:

e 2596901 : NetWeaver 7.51 and 7.52 targets are not available when selecting the option "Update SAP
NetWeaver" in Maintenance Planner

e 2535751#%: Can not select the higher release for Netweaver in Maintenance Planner
o 2314463 : Required file K-XXXxxxxxxxx.SAR is not visible for your user SXxxxxxxx

1. Loginto Maintenance Planner at https://help.sap.com/viewer/p/MAINTENANCE_PLANNER [ Additional
Information » Launch Maintenance Planner 3.

Choose Plan a New System.

Choose Plan.

Choose a system type (ABAP or JAVA system) and enter a three-character system ID.

Choose Install an SAP NetWeaver System.

Select a valid product version (for example, SAP NETWEAVER 7.5)and a valid support package stack.
Select a valid instance (for example, Application Server ABAP).

Choose Confirm Selection.

© O NOUAWN

Choose Install or Maintain an Add-On.
10. Select the sAP FIORI FOR SAP CARAB 4.0 FPSO01 front-end product version.
11. Select a valid front-end server instance.
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12. Choose Confirm Selection.

13. Choose Next.

14. Select the operating system and database for your implementation scenario.

15. Choose Confirm Selection.

16. Review the details of your stack-dependent and stack-independent files, then choose Next.
17. Choose Download Stack XML.

Install the Stack XML File Using Software Update Manager (SUM)

1. Download and install the SUM tool:

1. See the SAP Support Portal at https://support.sap.com/en/tools/software-logistics-tools/software-
update-manager.htm|

2. Consult the information for SUM 2.0 SP xx and follow the instructions.

2. In SUM, use the stack XML file that you have created in the first procedure to install your add-on product.

Result

You have successfully installed the front-end product version for this release.

Continue with the next section.

Parent topic: Install ABAP Front-End Server [page 53]

Previous: Verify Installation of Central SAP Fiori Ul Component [page 55]

5.4 Install Alternate Storage (Optional)

You only need to implement this procedure if you plan on using the Table Content Aging report delivered with
SAP Customer Activity Repository. This report allows you to copy your transaction log (TLOG) data and its
extensions from your SAP HANA database to an alternate storage technology (such as SAP IQ or Apache
Hadoop), thereby reducing your total cost of hardware ownership.

Use

For more information, see SAP Help Portal at https://help.sap.com/viewer/p/CARAB | <Version> »
Application Help » SAP Customer Activity Repository » POS Data Transfer and Audit » Implementing a POS
Transaction Data Storage Strategy # Using the Table Content Aging Report 4.
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i Note

If your scenario includes demand modeling and forecasting with the Unified Demand Forecast (UDF)
module, we recommend retaining the historical sales data in memory.

Process Flow

In order to successfully install alternate storage, you must execute the following procedures:
1. Do one of the following:
o Install and set up integration with SAP 1Q, or
o Install and set up integration with Apache Hadoop, or
o Install and set up integration with SAP HANA Dynamic Tiering
2. Create the remote source in SAP HANA studio (not applicable for integration with SAP HANA Dynamic
Tiering).
3. Create the virtual table.
4. Set the deploy mode in SAP HANA Transport for ABAP.

Parent topic: Install the Software [page 45]

Previous: Install ABAP Front-End Server [page 53]

5.4.1 Install and Set Up Integration with SAP IQ

You use these procedures to install and set up SAP 1Q to support the Table Content Aging report
(transaction /CAR/TABLE AGING) delivered with SAP Customer Activity Repository.

The SAP HANA database points to your SAP |Q database using SAP HANA smart data access (SDA), which
exposes data from SAP 1Q remote sources as virtual tables.

For more information, see SAP Help Portal at https://help.sap.com/viewer/p/CARAB|F <your release>
Application Help » SAP Customer Activity Repository » POS Data Transfer and Audit » Implementing a POS
Transaction Data Storage Strategy ¥ Using the Table Content Aging Report 4.

Install SAP 1Q

A detailed procedure is described in the SAP IQ Installation and Update Guide.

For more information, see SAP Help Portal at https://help.sap.com/viewer/p/SAP_IQll Installation and
Upgrade » SAP IQ Installation and Update Guide for <your operating system> 4.
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Configure SAP IQ

1. Allocate sufficient space into which your data will be loaded.

i Note

The default DBSpaces provided during installation are intended to be used for SAP IQ system
management. You should create your own DBSpace under the Main store with a DB File that is large
enough to satisfy your sizing requirements.

For more information, see SAP Help Portal at https://help.sap.com/viewer/p/SAP_IQ|F Reference
SAP IQ SOL Reference  SQL Statements » CREATE DBSPACE Statement 3.

2. Create anin-memory row-level versioning (RLV) store.
For more information, see SAP Help Portal at https://help.sap.com/viewer/p/SAP_IQ|F Administration

Administration: In-Memory Row-Level Versioning » About In-Memory Row-Level Versioning 3.

i Note

Click View All if topic does not appear in initial list.
3. Create a database under the content created at the beginning of this procedure.

i Note
Ensure the following:
o The SAP IQ stores are configured with a large enough cache configuration, main memory, and
temporary memory.

o The page size should be set to 128KB.
o The concurrency aligns with the amount of processes that will be triggered during the data copy.

For more information, see SAP Help Portal at https://help.sap.com/viewer/p/SAP_IQlp Configuration
Performance and Tuning Guide .
4. Create the following tables in the DBSpace created at the beginning of the procedure:
o /POSDW/TLOGF
© /POSDW/TLOGF EXT
© /POSDW/TLOGF X
© /POSDW/PLOGF

i Note

These tables should have the same structure as the tables in your SAP HANA system. One possible
way is to export the table structure via Export SQL on the SAP HANA side, and import it on the SAP IQ
side using the SQL console.

The SQL statement requires some modifications, such as:

o Converting all the column names in the exported SQL statement to lower case (for example,
“RETAILSTOREID becomes “retailstoreid”).
You can simply convert the entire SQL statement into lower case and then only convert the table
name to upper case to keep the table name unchanged.
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o Renaming of NVARCHAR to VARCHAR.
o Removing references to CS_* (for example, CS_FIXED).

5. Enable the RLV for the tables you just created.
6. Set the snapshot versioning property of the transaction to row-level.
«* Example

set option Snapshot Versioning = 'Row-level';

7. Enable connection blocking and set the blocking timeout threshold.

«* Example
set option blocking = 'On';

set option blocking timeout = '0';

Install SAP IQ Drivers

Install and configure the ODBC database drivers required to connect to the remote source.

i Note

Each data source driver setup is described in its own section. The prerequisites are given as a simple guide;
you will need to consult the original driver documentation provided by the driver manufacturer for more
detailed information.

A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http:/help.sap.com/viewer/p/SAP_HANA_PLATFORM #
|\ Administration » SAP HANA Administration Guide ¥ Data Provisioning  SAP HANA Smart Data Access
Setting Up ODBC Drivers » SAP IQ ODBC Driver 3.

5.4.2 Install and Set Up Integration with Apache Hadoop

You use these procedures to install and set up Apache Hadoop to support the Table Content Aging report
(transaction /CAR/TABLE AGING) delivered with SAP Customer Activity Repository.

The SAP HANA database points to your Hadoop cluster using SAP HANA smart data access (SDA), which
exposes data from Hadoop remote sources as virtual tables.

For more information, see SAP Help Portal at http://help.sap.com/viewer/p/CARAB# | <Version> »
Application Help » SAP Customer Activity Repository » POS Data Transfer and Audit » Implementing a POS
Transaction Data Storage Strategy # Using the Table Content Aging Report 4.
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Process Flow

To successfully install and set up integration with Apache Hadoop, you must execute the following procedures:

1. Install Apache Hadoop.
2. Do one of the following:
o Install and set up the Apache Hive ODBC driver, or
o Install and set up the SAP HANA Spark controller.
3. Create and partition tables in Apache Hive.
4. Create a NFS mount on SAP NetWeaver.

Install Apache Hadoop

According to the SAP HANA Administration Guide, SAP HANA smart data access is supported by Hortonworks
Distribution for Apache Hadoop: version 2.3 (supported on Intel-based hardware platforms only).

For more information on integration between SAP HANA and Apache Hadoop, see SAP Help Portal at http://

help.sap.com/viewer/p/SAP_HANA_PLATFORM#|j» Administration » SAP HANA Administration Guide » Data
Access ¥ SAP HANA Smart Data Access 3.

For more information on installing Apache Hadoop, see http://docs.hortonworks.com # |+ All » HDP » 2.3
HDP 2.3.0 (GA) 3.

Install and Set Up Apache Hive ODBC Driver

i Note

Integration between SAP HANA and Apache Hadoop requires either an Apache Hive ODBC driver or an
SAP HANA Spark controller.

Implement this procedure only if you wish to integrate SAP HANA with Apache Hadoop via the Apache Hive
ODBC driver.

1. According to the SAP HANA Administration Guide, SAP HANA smart data access is supported by
Hortonworks Distribution for Apache Hadoop: version 2.3 (This includes Apache Hadoop version 1.0.3 and
Apache Hive 0.9.0; supported on Intel-based hardware platforms only).

For more information on integration between SAP HANA and Apache Hadoop, see SAP Help Portal at

http://help.sap.com/viewer/p/SAP_HANA_PLATFORM#& | Administration  SAP HANA Administration
Guide » Data Access » SAP HANA Smart Data Access 4.
For more information on installing the Apache Hive ODBC driver, see http://docs.hortonworks.com # |+ All
» HDP » 2.3 » HDP2.3.0 (GA) 1.

2. Set up the driver as described in the SAP HANA Administration Guide at http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM#|» Administration » SAP HANA Administration Guide » Data Access » SAP
HANA Hadoop Integration .
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Install and Set Up the SAP HANA Spark Controller

i Note

Integration between SAP HANA and Apache Hadoop requires either an Apache Hive ODBC driver or a SAP
HANA Spark controller.

Implement this procedure only if you wish to integrate SAP HANA with Apache Hadoop via the SAP HANA
Spark controller.

1. Confirm the right combination of versions required between SAP HANA, Apache Spark, and the SAP HANA
Spark controller. Use the SAP HANA Spark Controller Compatibility Matrix to do this. This document is
available under https://help.sap.com/viewer/p/SAP_HANA_SPARK_CONTROLLER. Navigate to

| Additional Information » SAP HANA Spark Controller Compatibility Matrix 3.
2. Install and set up the SAP HANA Spark controller as described in SAP Note 2273047 #&r .

For more information on installing and setting up the SAP HANA Spark controller, see SAP Help Portal at
http://help.sap.com/viewer/p/SAP_HANA_PLATFORM#|p Administration » SAP HANA Administration Guide
» Data Access  SAP HANA Hadoop Integration  SAP HANA Spark Controller 3.

Create and Partition Tables

Create the SAP schema, tables, and table partitions as described in SAP Note 2317597 #r .

Create a NFS Mount on SAP NetWeaver

The TLOG data and its extensions are copied from your SAP HANA database to Hadoop using the HDFS NFS
Gateway on your Hadoop system. To enable this you must create a mount point on your SAP NetWeaver
system for the data files to be created directly in the Hadoop File System (HDFS).

i Note

The following steps are only guidelines which provide an example of how to mount Network File System
(NFS) on an SAP NetWeaver Linux-based client.

1. Make sure the NFS client is installed based on the examples provided:

Operating System Command
Red Hat, CentOS sudo yum install nfs-utils
Ubuntu sudo apt-get install nfs-common

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
62 PUBLIC Install the Software


https://help.sap.com/viewer/p/SAP_HANA_SPARK_CONTROLLER
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2273047
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fviewer%2Fp%2FSAP_HANA_PLATFORM
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2317597

Operating System Command

SUSE sudo zypper install nfs-client

2. List the NFS shares exported on the server.
Example
showmount -e <host>

3. Setup amount point for an NFS share.
Example
sudo mkdir <folder>

i Note

You must ensure that the folder paths share the same naming conventions, as follows:

Temporary data folder /tmp/tct_csv_out/temp

Data folder /tmp/tct csv_out/data

4. Mount the cluster using NFS.
Example
sudo mount -o hard, nolock <host> <folder>

On your HDFS, the different tables are stored under a folder using the following convention:
<data directory>/<schema>/<table>/<businessdaydate=partition value>/{files}

On the SAP NetWeaver file system, the Hadoop files are stored under a physical path and file name that is
derived from a customer-definable logical path or file name. The configuration is provided via the FILE
transaction. Inside the FILE transaction, you also need to make use of parameters PARAM 1 and PARAM 2.
PARAM 1 will be populated during runtime by the program (generated file name) and PARAM 2 will be
populated by the program during runtime <schema>/<table>/<businessdaydate=partition value>.

Example (Data Directory)

If the Hadoop data files are stored in Unix/Linux folder ,<schema>/<table>/businessdaydate=partition_value/
{files}pARAM 1.cCsV and physical directory /tmp/tct_csv_out/data/hdp/apps/hive/warehouse/
<PARAM 2><FILENAME>.

You create the following logical path in the FILE transaction as follows:

Logical path /CAR/HDFS_DATA

Name HDFS Data

Syntax group UNIX

Physical path /tmp/tct_csv_out/data/hdp/apps/hive/

warehouse/<PARAM 2><FILENAME>
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You create the following logical file in the FILE transaction as follows:

Logical file /CAR/HDFS_DATA
Name HDFS Data
Physical file <PARAM 1>.CSV
Data format WK1

Application area IS

Logical path /CAR/HDFS_DATA

Example (Temporary Directory)

/tmp/tct_csv_out/data/hdp/apps/hive/warehouse/On top of the Hadoop data files, you also need to provide
a temporary directory in which the program will populate script files and also temporarily store data files to be
compressed.

If the temporary files are stored in Unix/Linux folder /tmp/tct csv_out/temp/{files}, you create the
following logical path in the FILE transaction as follows:

Logical path /CAR/HDFS_TEMP

Name HDFS Temp

Syntax group UNIX

Physical path /tmp/tct _csv_out/temp/<FILENAME>

You create the following logical file in the FILE transaction as follows:

Logical file /CAR/HDFS_TEMP
Name HDFS Temp
Physical file <PARAM 1>.SH

Data format

Application area IS

Logical path /CAR/HDFS_TEMP
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5.4.3 Install and Set Up Integration with SAP HANA Dynamic
Tiering

You use these procedures to install and set up SAP HANA Dynamic Tiering to support the Table Content Aging
report (transaction /CAR/TABLE AGING) delivered with SAP Customer Activity Repository.

SAP HANA Dynamic Tiering adds the SAP HANA dynamic tiering service to your SAP HANA system. You use
this service to create the extended store and extended tables. Extended tables behave like all other SAP HANA
tables, but their data resides in the disk-based extended store.

For more information, see SAP Help Portal at http://help.sap.com/viewer/p/CARAB# | <your release>
Application Help » SAP Customer Activity Repository » POS Data Transfer and Audit » Implementing a POS
Transaction Data Storage Strategy » Using the Table Content Aging Report 3.

Install SAP HANA Dynamic Tiering

A detailed procedure is described in the SAP HANA Dynamic Tiering: Installation and Update Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_options_dt# |} Installation and
Update ¥ Installation and Update 3.

Create Extended Storage

A detailed procedure is described in the SAP HANA Dynamic Tiering: Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_options_dt#|p System
Administration » SAP HANA Dynamic Tiering: Administration Guide 3 and consult the following subsections:

o | System Administration » Managing Extended Storage » Create Extended Storage 3

o |» System Administration » Managing Tables » Extended Store Tables » Convert HANA Tables to Extended
Store Tables Using the SAP HANA Cockpit 3

5.4.4 Create the Remote Source in SAP HANA Studio

i Note

This step is not applicable if you are integrating the alternate storage feature with SAP HANA Dynamic
Tiering.

Create a remote source by selecting the appropriate adapter and configuring the connection properties and
user credentials.
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A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/viewer/p/SAP_HANA_PLATFORM #
| Administration » SAP HANA Administration Guide p Data Access » SAP HANA Smart Data Access »

Creating a Remote Source .

5.4.5 Create the Virtual Table

Create the following virtual tables to access the data stored in remote tables:

Virtual Table Remote Table
VT_TLOGF_NLS /POSDW/TLOGF
VT_TLOGF_X_NLS /POSDW/TLOGF_X
VT_TLOGF_EXT_NLS /POSDW/TLOGF_EXT
VT_PLOGF_NLS /POSDW/PLOGF

A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http:/help.sap.com/viewer/p/SAP_HANA_PLATFORM #
| Administration » SAP HANA Administration Guide ¥ Data Provisioning » SAP HANA Smart Data Access ¥
Managing Virtual Tables 3.

5.4.6 Activate Alternate Storage

1. Inyour back-end system, execute report /CAR/ACTIVATE HTA.

2. Confirm or set the following:
o Inthe ECC Mode section, choose the relevant ECC mode for your system.
o Inthe External Systems section, choose Nearline Storage.

3. Press Execute.

This deploys package sap.is.retail.car.nls for ECC mode SAP ERP, or sap.is.retail.car_s4h.nls
for ECC mode S/4HANA. Each package contains views that combine TLOG data from SAP HANA with TLOG
data from the alternate storage system.
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6 Set Up the Applications

You have installed the back-end components and front-end components of SAP Customer Activity Repository
applications bundle. Now you must first do the setup steps under | SAP Customer Activity Repository » Core
(Mandatory for All Applications) 3. These steps are required for all the applications. Then you either continue
with the setup steps under [ SAP Customer Activity Repository ¥ Advanced (Optional) 3 or do the setup steps
for your application.

For SAP Allocation Management, first consult the information in section SAP Allocation Management. Then
do the setup steps under | SAP Customer Activity Repository » Core (Mandatory for All Applications) 3.

6.1 SAP Customer Activity Repository

First do the setup steps under |» SAP Customer Activity Repository j# Core (Mandatory for All Applications) .
Then you can continue with the setup steps under |0 SAP Customer Activity Repository » Advanced
(Optional) 3 or do the setup steps for your application.

Core (Mandatory for All Applications) [page 67]

Perform the core steps to set up SAP Customer Activity Repository as the common platform. The core
steps are mandatory for SAP Customer Activity Repository and for all the consuming applications.

Advanced (Optional) [page 98]
Perform optional steps to set up specific functionality in SAP Customer Activity Repository.

Troubleshooting [page 154]
Diagnose and resolve issues that may arise when you install, upgrade, and set up your scenario. If you
need to report a customer incident, see the information at the end of this section.

6.1.1 Core (Mandatory for All Applications)

Perform the core steps to set up SAP Customer Activity Repository as the common platform. The core steps
are mandatory for SAP Customer Activity Repository and for all the consuming applications.

A Caution

Always do the core steps first. Then you can continue with the Advanced (Optional) steps for SAP
Customer Activity Repository or with the setup steps for your application.

1. Check SAP Notes and RINs [page 69]
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There are notes that can only be implemented after you have installed the back-end product version
and the front-end product version. You must therefore do this additional check and implement the
required notes, before you do the next steps.

2. Verify Back-End Users and Roles [page 70]
Ensure that the required users on the SAP HANA database level and on the back-end application level
have the privileges, roles, and authorizations required for your scenario.

3. Set Up Authorizations for On-Shelf Availability (OSA) [page 72]
In SAP HANA studio, grantthe AFL__ SYS AFL POSDM AREA EXECUTE role to the SAP<SID> user.
This short procedure is mandatory for all the scenarios, because it is required for the successful
activation of the SAP HANA content later on.

4. Set Up Authorizations for Unified Demand Forecast (UDF) [page 73]
In SAP HANA studio, create three roles for UDF, grant the required privileges, and assign two roles to
the sAP<SID> user and one role to the Sys REPO user. This procedure is mandatory for all the
scenarios because it is required for the successful activation of the SAP HANA content later on.

5. Create/Replicate Source Master Data System Tables [page 76]
Create the tables in SAP Customer Activity Repository that are required for data replication with the
SAP Landscape Transformation Replication Server (SLT). Then do the actual replication from the
source master data system. For reference, use a spreadsheet listing the tables for each system (SAP
Retail, SAP S/4HANA).

6. Activate SAP HANA Content [page 78]
Activate the SAP HANA content for your scenario by executing an activation report in the back-end
system. You can run this report as many times as your scenario requires.

7. Activate SAP HANA Content for Distribution Curves [page 81]
If you plan to calculate distribution curves for your scenario, activate the required SAP HANA content in
this additional procedure.

8. Activate SAP HANA Script Server [page 83]
Activate the script server for the SAP HANA database. This step is mandatory for all the applications.

9. Configure Demand Data Foundation [page 84]
Configure the DDF module in SAP Customer Activity Repository as required for your scenario.

10. Configure SAP Gateway [page 88]
Perform several configuration steps for SAP Gateway and the OData services. The steps to follow
depend on the SAP NetWeaver version on your front-end server.

11. Configure SAP Fiori Launchpad [page 96]
Perform the general configuration of the SAP Fiori launchpad. This is a prerequisite to being able to set
up SAP Fiori apps for any of the applications.

12. Configure Calculation of SAPUIS Application Index [page 97]
Configure and run the report to calculate the SAPUI5 application index. You can run the report
manually, but we recommend that you schedule it as a regular background job on your front-end
server. The reportis /UI5/APP INDEX CALCULATE (Calculation of SAPUI5 Application Index for
SAPUI5 Repositories).
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6.1.1.1 Check SAP Notes and RINs

There are notes that can only be implemented after you have installed the back-end product version and the
front-end product version. You must therefore do this additional check and implement the required notes,
before you do the next steps.

Prerequisites

Make sure that you have the up-to-date version of each note, which you can find on the SAP Support Portal at
http://support.sap.com/notes .

The release information notes (RINs) in particular are continuously updated, as corrections for the current
release of SAP Customer Activity Repository applications bundle become available.

Procedure

1. Consult the Implement SAP Notes for the Installation [page 25] section and verify that all After the
installation notes that are required for your scenario have been implemented.

i Note

Always consult the table for SAP Customer Activity Repository. Notes listed there are often common
corrections, applicable to all consuming applications.

2. Consult the back-end RIN 2708055#% and implement any required corrections. The note contains back-
end corrections for the current release of SAP Customer Activity Repository applications bundle.

3. Consult the front-end RIN 2708040#% and implement any required corrections. The note contains front-
end corrections for the current release of SAP Customer Activity Repository applications bundle.

Task overview: Core (Mandatory for All Applications) [page 67]

Next: Verify Back-End Users and Roles [page 70]
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6.11.2 Verify Back-End Users and Roles

Ensure that the required users on the SAP HANA database level and on the back-end application level have
the privileges, roles, and authorizations required for your scenario.
Prerequisites

® You are aware that the names of the front-end application users must be the same as those in the SAP
HANA database and the back-end application.

® You have read and performed the steps in section Verify SAP HANA User and Privileges [page 37].
Procedure

Ensure that your back-end application user has the following roles/authorizations.
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User

Role / Authorization

<Your User Name>*

SAP_ISR DDF MASTER

SAP_ISR AP MASTER

/RAP/BW_AP_WORKBOOKS

/RAP/BW_MPR WORKBOOKS

In transaction RS2HANA VIEW, set SAP HANA User Mapping to C (DBMS
user, else SAP HANA user with same name as BW user).

In transaction RS2HANA CHECK, verify that authorizations for generating
SAP HANA views out of local Bl Content objects are set up. Correct any re-
sulting issues.

For more information, see http://help.sap.com/viewer/p/SAP_NETWEA-
VER_750#% (or choose a higher version). Navigate to |} Application Help >
SAP NetWeaver Library: Function-Oriented View # SAP Business Warehouse
» Using the SAP HANA Database # Data Modeling When Using a SAP HANA
» Mixed Modeling (SAP BW and SAP HANA) » Generating SAP HANA Views

from the BW System > Authorizations for Generating SAP HANA Views }

If you need detailed information about PAK execution, the user profile must
have the following parameters maintained. Be aware that as a result of the
additional logging, these settings might slow down the performance.

In transaction su3, select the Parameters tab. Enter the parameter and the

desired value as shown below and choose Save.

Parameter Value

RSPLS HDB PE TRACE Y

More Information

For information on setting up front-end application users, see the following:

e For SAP Assortment Planning: Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad [page 237]
e For SAP Allocation Management: Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad [page 254]

Parent topic: Core (Mandatory for All Applications) [page 67]

Previous task: Check SAP Notes and RINs [page 69]

Next: Set Up Authorizations for On-Shelf Availability (OSA) [page 72]

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0

FPSO1
Set Up the Applications

PUBLIC 71


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fviewer%2Fp%2FSAP_NETWEAVER_750
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fviewer%2Fp%2FSAP_NETWEAVER_750

6.11.3 Set Up Authorizations for On-Shelf Availability
(OSA)

In SAP HANA studio, grantthe AFL___SYS AFL POSDM AREA EXECUTE role to the SAP<SID> user. This short
procedure is mandatory for all the scenarios, because it is required for the successful activation of the SAP
HANA content later on.

Context

TheAFL SYsS AFL POSDM AREA EXECUTE role enables the SAP<SID> user to call the OSA application
function library (part of the SAP RTL AFL FOR SAP HANA component)inthe SAP HANA database.

Prerequisites

® You have installed the SAP RTL AFL FOR SAP HANA component as described in Download and Install the
Application Function Library (SAP RTL AFL FOR SAP HANA) [page 47].

® You have an SAP<SID> user and an SAP<SID> physical schema in your SAP HANA database. The names
must be identical. If you need more information on database users and schema mapping, see Verify Back-
End Users and Roles [page 70] and Verify Correct Schema Mapping [page 40].

® You have database administrator rights so that you can grant roles to users.

Procedure

->Tip
e |f you encounter issues related to authorization or authentication, see the Security-Related Issues
section of the SAP HANA Troubleshooting and Performance Analysis Guide, which you can find under
https://help.sap.com/viewer/p/SAP_HANA_PLATFORM |[p <Version> » Administration 3.

e We have also provided an example SQL statement below that you can adapt as needed for your system
landscape.

In SAP HANA studio, access your back-end system and open the SAP HANA Administration Console.

Choose | Security ¥ Users 3.
Select your sSAP<S1D> user and open the user details (or double-click the user).

s owopoe

On the Granted Roles tab, choose the plus icon and select AFL,__SYS_AFL_POSDM AREA EXECUTE as the
role name.
SQL example: grant AFL SYS AFL POSDM AREA EXECUTE to SAP<SID>;

5. Save your changes by choosing the Deploy (F8) icon at the top right.
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Result

You have successfully set up the authorizations for OSA.

Parent topic: Core (Mandatory for All Applications) [page 67]

Previous: Verify Back-End Users and Roles [page 70]

Next: Set Up Authorizations for Unified Demand Forecast (UDF) [page 73]

6.11.4 Set Up Authorizations for Unified Demand Forecast

(UDF)

In SAP HANA studio, create three roles for UDF, grant the required privileges, and assign two roles to the
SAP<SID> user and oneroletothe SYS REPO user. This procedure is mandatory for all the scenarios

because it is required for the successful

Context

activation of the SAP HANA content later on.

The three roles for UDF have the following purpose:

Role

Purpose

UDF_EXECUTE

Required to execute UDF. Enables the sap<S1D> user to call the UDF applica-

tion function library (AFL) in the SAP HANA database.

UDF DEPLOY

Required to activate the SAP HANA content for UDF. Enables the sap<s1D>
user to deploy the SAP HANA content for UDF.

UDF DEPLOY SYS REPO

Required to activate the SAP HANA content. Defines additional privileges for
the sys REPO standard user.

Prerequisites

® You haveinstalled the sAP RTL AFL FOR SAP HANA component as described in Download and Install the
Application Function Library (SAP RTL AFL FOR SAP HANA) [page 47]. This component contains the

application function library for UDF.

® You have an SAP<SID> user and an SAP<SID> physical schema in your SAP HANA database. The names

must be identical. For more information, see Verify Back-End Users and Roles [page 70].
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You know what the name of the SAP<SID> user is in your system landscape. For information on how to find
this name, see Verify Correct Schema Mapping [page 40].

You have database administrator rights so that you can create roles, grant privileges, and assign roles to
users.

Procedure

- Tip

© N O

10.

74

e |f you encounter issues related to authorization or authentication, see the Security-Related Issues
section of the SAP HANA Troubleshooting and Performance Analysis Guide, which you can find under
https://help.sap.com/viewer/p/SAP_HANA_PLATFORM |p <Version> » Administration 3.

e We have also provided example SQL statements below that you can adapt as needed for your system
landscape.

In SAP HANA studio, log on to your back-end system and open the SAP HANA Administration Console.

Navigate to [ Security » Roles 3 and select New Role from the context menu.
In the Role Name field, specify UDF_EXECUTE.
SQL example: create role UDF EXECUTE;
Make the following settings for this role:
o Onthe Granted Roles tab: Choose the plus icon and select the
AFL SYS AFL UDFCORE AREA EXECUTE role from the list.
SQL example: grant AFL _SYS AFL UDFCORE AREA EXECUTE to UDF EXECUTE;
o Onthe Object Privileges tab: Add the following catalog objects and grant them the following privileges:
o Catalog object (schema name) sap<s1ID>: privileges SELECT, INSERT, UPDATE, DELETE
SQL example: grant SELECT, INSERT, UPDATE, DELETE on schema SAP<SID> to
UDF_EXECUTE;

o Catalog object (schemaname) sys BIC: privileges SELECT, EXECUTE
SQL example: grant SELECT, EXECUTE on schema SYS BIC to UDF EXECUTE;
o Onthe Analytic Privileges tab: Addthe sys BI CP ALL privilege.
SQL example: call
GRANT ACTIVATED ANALYTICAL PRIVILEGE (' SYS BI CP ALL','UDF EXECUTE');

Save your changes by choosing the Deploy (F8) icon at the top right.
Navigate to | Security » Users 3.
Select the sap<s1D> user from the list and open the details screen (or double-click the user).

On the Granted Roles tab, add the UDF_EXECUTE role.
SQL example: grant UDF_EXECUTE to SAP<SID>

Save your changes by choosing the Deploy (F8) icon at the top right.

i Note

You have created the first role with the required privileges and granted the role to the SAP<SID> user.

Now create the second role. Navigate again to [+ Security » Roles 3 and select New Role from the context
menu.
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11.

12.

13,
14.
15.
16.

17.

18.

19.

In the Role Name field, specify UDF_DEPLOY.
SQL example: create role UDF DEPLOY;
Make the following settings for this role:
o Onthe Granted Roles tab: Choose the plus icon and select the CONTENT ADMIN role from the list.
SQL example: grant CONTENT ADMIN to UDF _DEPLOY;

o Onthe System Privileges tab: Add the CATALOG READ privilege.
SQL example: grant CATALOG READ to UDF DEPLOY;
Save your changes by choosing the Deploy (F8) icon at the top right.
Navigate again to |F Security #» Users 3.
Select the sap<sID> user from the list and open the details screen (or double-click the user).

On the Granted Roles tab, add the UDF DEPLOY role.
SQL example: grant UDF_DEPLOY to SAP<SID>;

Save your changes by choosing the Deploy (F8) icon at the top right.

i Note

You have created the second role and granted the role to the SAP<SID> user.

Now create the third role. Navigate again to | Security » Roles 3 and select New Role from the context
menu.

In the Role Name field, specify UDF_DEPLOY_SYS_REPO.

SQL example: create role UDF DEPLOY SYS REPO;

20.0n the Object Privileges tab, make these settings:

21

Add catalog object (schema name) sap<s1ID> and grant the privileges SELECT, INSERT, UPDATE, and
DELETE.

SQL example: grant SELECT, INSERT, UPDATE, DELETE on schema SAP<SID> to
UDF_DEPLOY SYS REPO;

Save your changes by choosing the Deploy (F8) icon at the top right.

22.Navigate again to [ Security » Users 1.
23.Selectthe sys REPO user from the list and open the details screen (or double-click the user).
24.0n the Granted Roles tab, add the UDF_DEPLOY SYS REPO role.

SQL example: grant UDF DEPLOY SYS REPO to _SYS REPO;

25. Save your changes by choosing the Deploy (F8) icon at the top right.

i Note

You have created the third role with the required privileges and granted the role to the Sys REPO user.

Result

You have successfully set up the authorizations for UDF.

Parent topic: Core (Mandatory for All Applications) [page 67]

Previous: Set Up Authorizations for On-Shelf Availability (OSA) [page 72]
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Next task: Create/Replicate Source Master Data System Tables [page 76]

6.1.1.5 Create/Replicate Source Master Data System
Tables

Create the tables in SAP Customer Activity Repository that are required for data replication with the SAP
Landscape Transformation Replication Server (SLT). Then do the actual replication from the source master
data system. For reference, use a spreadsheet listing the tables for each system (SAP Retail, SAP S/4HANA).

Prerequisites

® You have installed the SAP Landscape Transformation Replication Server. For the minimum version
required, see in Install the Prerequisites [page 17] under Common Prerequisites.

® You have downloaded the spreadsheet with the tables for your version of SAP Customer Activity
Repository applications bundle:
1. Navigate to SAP Help Portal at https://help.sap.com/viewer/p/CARAB and select the desired version
at the top right.
2. Download the SLT Tables for SAP Customer Activity Repository applications bundle archive from under
Installation and Upgrade and extract the spreadsheet.

Context

SAP Customer Activity Repository applications bundle uses data that originates from a single or multiple
source master data systems. For information on using multiple source master data systems and/or clients, see
Set Up SAP Client [page 51].

The list of tables to create and replicate depends on your leading source master data system:

® SAP Retail: for installations based on the sap_Ecc schema
® SAP S/4HANA Retail: for installations based on the SAP S4H schema

i Note

To be able to activate the SAP HANA content for SAP Allocation Management, you must replicate both the
SAP ERP tables and the SAP Fashion Management tables. Note that the replication of the SAP Fashion
Management tables is mandatory, even if you do not use SAP Fashion Management.

In this procedure, you first create and then replicate the required tables.

A Caution

You must always create and replicate all the tables listed for your source master data system in the
spreadsheet. This is mandatory for the successful activation of the SAP HANA content.
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i Note

You can combine the steps create and replicate.

Procedure

1. Create all the tables listed for your source master data system.

a. Configure access from the SAP Landscape Transformation Replication Server to the source SAP Retail
or SAP S/4HANA Retail system (RFC connection) and from the SAP Landscape Transformation
Replication Server to the target SAP HANA database.

For more information, see sections Technical Prerequisites and Authorization Aspects and Accessing
the Configuration and Monitoring Dashboard under https://help.sap.com/viewer/p/
SAP_LANDSCAPE_TRANSFORMATION_REPLICATION_SERVER | <Version> ¥ Operations »
Application Operations Guide (Replicating Data to SAP HANA) 1.

b. Ensure that your back-end system is connected to SAP HANA studio.

If necessary, set the connection as follows:

1. Logonto SAP HANA studio.

2. Right-click in the Navigator pane and select Add System.

3. Inthe Specify System dialog, enter the Host Name, Instance Number, and Description.
4. Inthe Connection Properties dialog, enter your system User Name and Password.

c. Ensure that the database schemas are created on the SAP HANA database of your back-end system.
These are the schemas on your SAP HANA database to which the SAP Retail and/or SAP S/4HANA
data will be replicated.

i Note

For more information, see section Create a Schema of the SAP HANA Developer Guide.

d. Create all the tables for your source master data system.

1. Logontothe SAP Landscape Transformation Replication Server.

2. Start transaction LTRC (SAP LT Replication Server Cockpit)).

3. Define and select your replication configuration.
See section Creating a Configuration under https://help.sap.com/viewer/p/
SAP_LANDSCAPE_TRANSFORMATION_REPLICATION_SERVER | <Version> » Operations ¥
Application Operations Guide (Replicating Data to SAP HANA) 3.

4. Choose[execute (r8) | A screen opens that shows the details of this replication configuration.

5. Select the table overview tab. On top, the data provisioning function will get visible.

6. Execute the table overview function. On the subsequent pop-up, select the function for table
creation.

7. Choose the multiple selection push-button next to the table name field.

8. Inthe next screen, you can either enter table names manually or upload a text file with the table
names (recommended):
Create this text file based on the spreadsheet and ensure that it only contains the table names and
no other data. Then upload the text file.
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9. Choose[copy (8) |toreturn to the previous screen.
10. Choose to trigger the creation of the tables.

2. Replicate all the tables listed for your source master data system.

i Note

If your source SAP Retail or SAP S/4HANA Retail system and your back-end SAP Customer Activity
Repository system are co-deployed on the same SAP HANA database, you do not need to replicate the
tables.

a. Save a CSV file of the required tables. You will later load the tables from this file.

b. In SAP HANA studio, choose |+ Window ¥ Perspective ¥ Open Perspective 3 and open the SAP HANA
Modeler perspective.

c. Inthe Quick View panel, choose Data Provisioning to open the Data Provisioning Editor for your system.

If the Quick View panel is not displayed, choose | Help # Quick View 3.
d. Inthe Data Provisioning Editor, make any necessary adjustments: remove or add tables, select the
appropriate source system, and select the target schema for replication.

e. Choose Replicate to open the Replicate Request screen.
f. Choose Load from file and browse to the location where you saved the CSV file.
g. The tables in the file will be added to the Selected column on the right-hand side. Select Finish.

In the Data Provisioning Editor, you can monitor the action status of the tables using Data Load
Management.

You have successfully created and replicated the tables for your source master data system.

Task overview: Core (Mandatory for All Applications) [page 67]
Previous: Set Up Authorizations for Unified Demand Forecast (UDF) [page 73]

Next task: Activate SAP HANA Content [page 78]

6.1.1.6 Activate SAP HANA Content

Activate the SAP HANA content for your scenario by executing an activation report in the back-end system. You
can run this report as many times as your scenario requires.

Prerequisites

You have successfully completed all of the procedures listed in the previous sections of this guide.
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Context

The /CAR/ACTIVATE HTA report activates the SAP HANA Transport for ABAP (HTA) objects for your scenario.
One HTA object is activated for each SAP HANA content package.

Procedure

1. B iNote

You must only do this first step if your source master data system is SAP S/4HANA 1809 or higher. If
it is not, continue directly with step 2.

Run a special SLT report to create the tables required for data replication with the SAP Landscape
Transformation Replication Server:

a. Inyour back-end system, start transaction sSE38.

b. Enter /DMF/CREATE_SLT TABLES as the program and choose Execute ().
c. Select system S/4HANA and version 1809 (or a higher version).

d. Make the other settings as required for your system landscape:

o Physical Source Schema: Enter the name of your physical schema that you have previously
mapped to the SAp_s4H authoring schema.

o Physical Dummy Schema: Enter the name of your physical schema that you have previously
mapped to the SAP_EcC authoring schema.

i Note

If you need information on the mapped schemas, see Verify Correct Schema Mapping [page
40].

o Mode: Select Simulation.
e. Choose Execute to run the report in simulation mode.
f. Resolve any messages that might be raised.
g. Deselect the simulation mode and run the report for real.

The SLT tables for SAP S/4HANA 1809 (or higher) are created. Now you can activate the SAP HANA
content for your scenario.

2. Starttransaction sE38.

3. Enter /CAR/ACTIVATE_HTA as the program and choose Execute ([F8]).

4. Select all the options for which you wish to activate the SAP HANA content. Use the following table for
reference:
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You want to activate the SAP HANA
content for...

Select at least these options...

SAP Allocation Management

Do not select Allocation Management and run the report.

Follow the instructions in section Activate SAP Allocation Management
SAP HANA Content [page 245] instead.

Distribution Curves (without SAP
Allocation Management)

Follow the instructions in Activate SAP HANA Content for Distribution
Curves [page 81].

SAP Assortment Planning

o ECC Mode: Select your source master data system. If you use Fashion
Management, select it.

o Business Scenarios Activation: Select Assortment Planning.

Unified Demand Forecast (UDF) and de-
mand planning SAP Fiori apps (Analyze
Forecast, Adjust Forecast, Manage De-
mand Influencing Factors)

You do not need to run the report for these scenarios.

The SAP HANA content should already be active at this point. It was acti-
vated automatically during the installation of the back-end product ver-
sion.

On-Shelf Availability

o ECC Mode: Select your source master data system.

o Business Scenarios Activation: Select On-Shelf Availability and
Customer Activity Repository.

Omnichannel Article Availability and
Sourcing (OAA)

o ECC Mode: Select your source master data system.

o Business Scenarios Activation: Select Omnichannel Article Availability.

SAP Merchandise Planning

Follow the instructions in Activate SAP HANA Content for SAP Merchan-
dise Planning [page 174].

SAP Promotion Management

No action required.

5. Perform the prerequisite check to validate the selections:

a. Select Perform Prerequisite Check and choose Execute ().
b. Read the system log before applying any database changes.

c. Resolve any issues found during the check.

If you encounter issues, see the Troubleshooting [page 154] section for possible solutions.

6. Activate the SAP HANA content for real:

a. Deselect Perform Prerequisite Check.

b. Choose Execute ([£8]) again.

7. Check that the activation was successful. You have several options:

a. Simply rerun the report. The system lists the scenarios that are now active.

b. Or: Execute transaction scTs_HTA. Specify a SAP HANA content package (for example,
sap.is.retail), selectInclude subpackages, and choose Execute (). The system lists the
contents of the package and indicates the status of each object.

c. Or: Navigate to the same package in SAP HANA studio and check whether all its views are active.

PUBLIC
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Results
You have successfully activated the SAP HANA content for your scenario. Continue with the next section.

Task overview: Core (Mandatory for All Applications) [page 67]
Previous task: Create/Replicate Source Master Data System Tables [page 76]

Next: Activate SAP HANA Content for Distribution Curves [page 81]

6.1.1.7 Activate SAP HANA Content for Distribution Curves

If you plan to calculate distribution curves for your scenario, activate the required SAP HANA content in this
additional procedure.

Prerequisite

You have installed SAP Note 2692291# SAP Allocation Management 4.0 - Distribution Curve Configuration -
SLT report /DMF/CREATE_SLT_TABLES fails for S4H 1709 Source system.

Run the Dummy Schema and Dummy Table Creation Report

The report checks for a missing physical schema and creates this physical schema and the corresponding
dummy tables in the schema if necessary. The successful completion of this step is a prerequisite for the SAP
HANA content activation for distribution curves.

i Note

The running of the report requires a database user in the ABAP system with the authorization to crate the
dummy schema. Check the application log for the report if there were errors.

1. Inyour back-end system, start transaction SE38. Enter /DMF/CREATE_SLT TABLES (Create SLT Tables)
as the program and choose Execute.

2. Select your source system. For S/4HANA, enter the version.

3. Enter the physical source and dummy schema names. For the Physical Source Schema, enter the physical
schema name into which your SLT tables should be replicated. For the Physical Dummy Schema, enter the
name for the schema to be created. If the physical source schema already exists in the SAP HANA
database, then only the dummy tables in this schema are created when you execute the report.

4. Select the simulation mode for a test run. After the simulation run, you can check for errors in the
application log.
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Maintain Schema Mapping

Check the names you use for your physical schema. If you are using the default names below, no further action
is required:

e sap s4H, for your SAP S/4HANA schema

® SAP ECC, for your SAP Retail (ECC or FMS) schema

If you have chosen names for your physical schema that are different from the names above, you must do the
following:

Maintain a schema mapping in your SAP HANA database where your customer-specific names are used as
authoring schemas for the physical schema.

Set Prework Done for DDF Packages

A precondition for the activation of SAP HANA Transport for ABAP (HTA) objects is that the PREWORK DONE
indicator is set for all packages with activation mode P - prework needed. You can check this setting in the
table CTS HOT PACKAGE in field HOT ACTIVATION MODE.

Set the PREWORK_DONE indicator for all Demand Data Foundation (DDF) packages relevant for the distribution
curve functionality:

® sap.is.ddf.ecc

® sap.is.ddf.fms

® sap.is.ddf.fms_ s4h

® sap.is.ddf.cross.ecc

® sap.is.ddf.cross.fms

® sap.is.ddf.cross.fms s4h

® sap.is.ddf.cross

1. Calltransaction sE16 (Data Browser) and display the contents of table cTS HOT PREWORK (HANA
Transport for ABAP: Prework for SAP HANA Deployment).

2. Enter ABAP HANA PACKAGE ID forall DDF packages listed above. You can obtain the
ABAP HANA PACKAGE ID forthe HANA PACKAGE ID fromtable CTS HOT PACKAGE.

3. Check if the indicator PREWORK_DONE is set to X for all these packages. If not, set the indicator to X.

Check and Activate DDF SAP HANA Content

Based on your scenario, there can be inactive packages in DDF, even though you have activated the content
earlier via the report /CAR/ACTIVATE HTA (Activate SAP HANA Content for SAP CARAB), as described in
section Activate SAP HANA Content [page 78].

1. Calltransaction scTs HTA DEPLOY (SAP HANA Transport for ABAP - Deployment) to check and to deploy
(if not already deployed) the following packages, in strictly the sequence in which they are listed. Do not
select the option to Include subpackages:
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® sap.is.ddf.ecc

® sap.is.ddf.fms

® sap.is.ddf.fms s4h

® sap.is.ddf.cross.ecc

® sap.is.ddf.cross.fms

® sap.is.ddf.cross.fms s4h

® sap.is.ddf.cross

i Note

The package names are case-sensitive.

Parent topic: Core (Mandatory for All Applications) [page 67]
Previous task: Activate SAP HANA Content [page 78]

Next task: Activate SAP HANA Script Server [page 83]

6.1.1.8 Activate SAP HANA Script Server

Activate the script server for the SAP HANA database. This step is mandatory for all the applications.

Context

The script server is an auxiliary SAP HANA server that is required to execute application function libraries
(AFLs). For example, this applies to the sap HANA AFIL component (which includes the SAP HANA Predictive
Analysis Library (PAL) and other libraries) and to the SAP RTL AFL FOR SAP HANA component (which
includes the libraries for Unified Demand Forecast and On-Shelf Availability).

i Note
The operating system process is hdbscriptserver.
The service name is scriptserver.

The operating system process can be started while the SAP HANA database is already running.

Procedure

1. In SAP HANA studio, verify if the script server is active.
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2. If the script server is not active, restart it manually as described in SAP Note 1650957 # SAP HANA
Database: Starting the Script Server.

Task overview: Core (Mandatory for All Applications) [page 67]
Previous: Activate SAP HANA Content for Distribution Curves [page 81]

Next: Configure Demand Data Foundation [page 84]

6.1.1.9 Configure Demand Data Foundation

Configure the DDF module in SAP Customer Activity Repository as required for your scenario.

Required Configuration

The configuration of DDF is mandatory for the following scenarios:
® You want to model and forecast demand using the UDF module in SAP Customer Activity Repository.
® You want to use the Omnichannel Promotion Pricing (OPP) module in SAP Customer Activity Repository.
e You want to use SAP Allocation Management.
® You want to use SAP Assortment Planning.
e You want to use SAP Merchandise Planning.
e You want to use SAP Promotion Management.

i Note

The configuration of DDF is optional for the following SAP Customer Activity Repository scenarios:

e PQOS Data Transfer and Audit

® Multichannel Transaction Data Management
® |nventory Visibility

e On-Shelf Availability

For additional configurations and integration information, see the following documentation on SAP Help Portal
at http://help.sap.com/viewer/p/CARAB# | <Version> J:

e |» Application Help » SAP Customer Activity Repository » Demand Data Foundation ¥ Integration
Information ¥ Master Data Replication from SAP ERP to Demand Data Foundation 3

o |» Administration » SAP Customer Activity Repository Administration Guide 3: sections Configuring
Demand Data Foundation (DDF), Configuring Data Replication from SAP ERP to DDF

i Note

If you encounter issues during the configuration, see the Troubleshooting [page 154 ] section for possible
solutions.
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Overview of DDF Configuration Tasks

1. Perform General Demand Data Foundation Configuration [page 85]
Perform various configuration steps in Customizing for DDF. DDF must be fully configured and
operational for all the scenarios for which it is mandatory.

2. Configure Automatic Flattening of Hierarchies [page 86]
Configure the system so it automatically creates and updates flat structures for the product and
location hierarchies in DDF. The flat structures are required so that the consuming applications can
correctly recognize the hierarchies.

3. Import SAP NetWeaver Portal Roles for DDF [page 87]
Set up user authorizations for DDF using the PFCG roles from the SAP NetWeaver Business Client
(NWBC) and from the SAP NetWeaver Portal (optional). Both sets of roles operate in the same manner.

4. Check Performance-Related Configuration Options (Optional) [page 88]
Use additional configuration options for Demand Data Foundation (DDF) to optimize performance for
different use cases.

Parent topic: Core (Mandatory for All Applications) [page 67]
Previous task: Activate SAP HANA Script Server [page 83]

Next: Configure SAP Gateway [page 88]

6.1.1.9.1 Perform General Demand Data Foundation
Configuration

Perform various configuration steps in Customizing for DDF. DDF must be fully configured and operational for
all the scenarios for which it is mandatory.

Procedure

1. Perform all of the Customizing activities that are required for DDF.
For more information, see the Configuring Demand Data Foundation (DDF) section of the SAP Customer
Activity Repository Administration Guide.

Parent topic: Configure Demand Data Foundation [page 84]

Next task: Configure Automatic Flattening of Hierarchies [page 86]
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61192 Configure Automatic Flattening of Hierarchies

Configure the system so it automatically creates and updates flat structures for the product and location
hierarchies in DDF. The flat structures are required so that the consuming applications can correctly recognize
the hierarchies.

Context

Flat structures describe the parent-child relationships of hierarchies in a flattened format. A hierarchy can be
vertically or horizontally flattened. Each row of the resulting flat structure contains one parent-child
relationship.

When you create (or update) a product hierarchy, product group, location hierarchy, or location group in
Demand Data Foundation (DDF), the system should create (or update) the corresponding flat structure.
Without this, you get hierarchy errors in the consuming applications.

To configure the automatic flattening of hierarchies, follow these steps:

Procedure

1. Carefully read SAP Note 1425876/ and follow the instructions.

2. Execute transaction SWETYPV and ensure that you have activated all required event type linkages and have
enabled the specified event queues. In particular, check that the Linkage Activated and Enable Event Queue
options are for each of the following events: LOCATION CREATED, LOCATION UPDATED,

CREATE LOC_HIER,CREATE PROD HIER.If you need to change a setting, you can do so in the Details
screen of each event.

For more information about event handling, see SAP Note 1098805, in particular sections Events and
Transactions for troubleshooting.

Results

You have set up the automatic flattening of the hierarchies. When you now create (or update) a hierarchy, the
system will automatically run the /DMF/TREE_FLATTENER PROD_INS report (for product hierarchies) or
the /DMF/TREE_FLATTENER LOC_INS report (for location hierarchies) and create (or update) the
corresponding flat structure.

Task overview: Configure Demand Data Foundation [page 84]
Previous: Perform General Demand Data Foundation Configuration [page 85]

Next: Import SAP NetWeaver Portal Roles for DDF [page 87]
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6.11.9.3 Import SAP NetWeaver Portal Roles for DDF

Set up user authorizations for DDF using the PFCG roles from the SAP NetWeaver Business Client (NWBC) and
from the SAP NetWeaver Portal (optional). Both sets of roles operate in the same manner.

Use

The roles have been designed for use in SAP NetWeaver Business Client. To use the functions of these roles in
SAP NetWeaver Portal, you must upload the roles from the SAP back-end system to the portal. The uploaded
objects are converted into portal objects.

Procedure

1. Use the Role Upload tool to generate the SAP NetWeaver Portal roles automatically. For information about
this tool, see SAP Note 1685257 ¥
You can also enhance the SAP NetWeaver Portal roles; for example, you can create your own iViews.
You can upload the following roles for DDF:
O SAP ISR DDF MASTER

© SAP ISR _DDF READONLY MASTER

For descriptions of these roles and information about maintaining roles in SAP Customer Activity Repository,
see section Authorizations in the SAP Customer Activity Repository Administration Guide.

Parent topic: Configure Demand Data Foundation [page 84]
Previous task: Configure Automatic Flattening of Hierarchies [page 86]

Next: Check Performance-Related Configuration Options (Optional) [page 88]
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6.1.1.94

Check Performance-Related Configuration
Options (Optional)

Use additional configuration options for Demand Data Foundation (DDF) to optimize performance for different

use cases.

Procedure

See the following options and implement those that are relevant for you:

Use Case

Configuration Option

You have a great number of products and locations, so that
the resulting tables are very large.

Consider table partitioning.

For information, see the Partition Tables for UDF and DDF
section of the SAP Customer Activity Repository Administra-
tion Guide.

You want to optimize workload distribution.

Consider setting up load balancing.

For information, see https://help.sap.com/viewer/p/CARAB
|» <Version> # Application Help * SAP Customer Activity
Repository > Demand Data Foundation > General Services

> Configure Load Balancing }

You are using DDF together with UDF to model and forecast
consumer demand.

Optimize performance for modeling and forecasting proc-
esses.

For information, see the Optimize UDF PerformanceOptimize
UDF Performance section of the SAP Customer Activity
Repository Administration Guide.

Parent topic: Configure Demand Data Foundation [page 84]

Previous: Import SAP NetWeaver Portal Roles for DDF [page 87]

6.1.1.10 Configure SAP Gateway

Perform several configuration steps for SAP Gateway and the OData services. The steps to follow depend on

the SAP NetWeaver version on your front-end server.

Perform General SAP Gateway Configuration [page 89]
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Make several general configuration settings (for example, set profile parameters, activate ICF services,
or make language settings). The settings may vary depending on the SAP NetWeaver version installed
on your front-end server, or on other specifics related to your system landscape.

Connect SAP Gateway to Your Back-End System [page 90]
Set up the connection between SAP Gateway on your front-end server and your back-end system. In
other words, set up the OData Channel (ODC).

Activate SAP Gateway [page 91]
Before you can use SAP Gateway, you must activate it globally on your front-end server.

Activate OData Services [page 91]
First activate all the common OData services for SAP Fiori (mandatory). Then select the OData
services for the application and SAP Fiori apps that you wish to use and activate these services as well.

Parent topic: Core (Mandatory for All Applications) [page 67]
Previous: Configure Demand Data Foundation [page 84]

Next: Configure SAP Fiori Launchpad [page 96]

6.1.1.10.1 Perform General SAP Gateway Configuration

Make several general configuration settings (for example, set profile parameters, activate ICF services, or make
language settings). The settings may vary depending on the SAP NetWeaver version installed on your front-end
server, or on other specifics related to your system landscape.

Use

The steps are not specific to this guide and are described in the product documentation of your SAP
NetWeaver version.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.

2. Consult the product documentation for your SAP NetWeaver version to determine what settings to make.
For SAP Gateway for SAP NetWeaver 7.52, see https://help.sap.com/viewer/p/
SAP_NETWEAVER_AS_ABAP_752 |l» <Version> ¥ Application Help  SAP Gateway Foundation
(SAP_GWFND) » SAP Gateway Foundation Configuration Guide » General Configuration Settings 3.

3. Perform the general SAP Gateway configuration specific to your SAP NetWeaver version.
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6.1.1.10.2 Connect SAP Gateway to Your Back-End System

Set up the connection between SAP Gateway on your front-end server and your back-end system. In other
words, set up the OData Channel (ODC).

Use

The steps are not specific to this guide and are described in the product documentation for your SAP
NetWeaver version.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.

2. Set up the OData Channel as described in the product documentation for your SAP NetWeaver version.
For SAP Gateway for SAP NetWeaver 7.52, see https://help.sap.com/viewer/p/

SAP_NETWEAVER_AS_ABAP_752 |l» <Version> ¥ Application Help # SAP Gateway Foundation
(SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway Configuration j» User,
Developer, and Administrator Roles 3 and Connection Settings for the SAP Gateway Hub System.

3. Set up the required roles on the front-end server and assign your user to these roles.

4. Specify the connection settings on the SAP Gateway hub system. They include:

o Connection from SAP Gateway to consumer systems
These settings allow you to connect the SAP Gateway host to the consumer systems (clients from
which you access the SAP Fiori apps).

o Connection from SAP Gateway to SAP back-end system
These settings allow you to connect SAP Gateway to your back-end system. They include the following
steps:

o

o

o

Creating a type 3 connection from the SAP Gateway host to your back-end system

Defining a trust relationship between your back-end system and the SAP Gateway host
Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host
Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system
Configuring the necessary system aliases
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6.1.1.10.3 Activate SAP Gateway

Before you can use SAP Gateway, you must activate it globally on your front-end server.

Use

The steps are not specific to this guide and are described in the product documentation for your SAP
NetWeaver version.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
For SAP Gateway for SAP NetWeaver 7.52, see https://help.sap.com/viewer/p/

SAP_NETWEAVER_AS_ABAP_752 |» <Version> » Application Help # SAP Gateway Foundation
(SAP_GWFND) » SAP Gateway Foundation Configuration Guide  SAP Gateway Configuration ¥ Activating
SAP Gateway 3.

6.1.1.10.4 Activate OData Services

First activate all the common OData services for SAP Fiori (mandatory). Then select the OData services for the
application and SAP Fiori apps that you wish to use and activate these services as well.

Context

For security reasons, the OData services are delivered in an inactive state:

® The common OData services are delivered as part of the SAP Fiori front-end server. They are required for
the SAP Fiori launchpad and you must always activate them.

e The application-specific OData services are delivered with SAP Customer Activity Repository
applications bundle. You only need to activate the services that are relevant for your application.

Procedures

Mandatory: Activate Common OData Services for SAP Fiori
1. Logon to your front-end server (your SAP Gateway system).
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2. Intransaction SPRO, navigate to |» SAP Reference IMG j» SAP NetWeaver » SAP Gateway » OData Channel

» Administration » General Settings ¥ Activate and Maintain Services 3 and execute the Customizing
activity.

- Tip

As a quick shortcut to the same screen, use transaction /n/IWFEND/MAINT SERVICE.

The Service Catalog shows you all the services that are currently active in your SAP Gateway system.

3. To add and activate more services, choose Add Service.
The Add Selected Services screen is displayed.

4. In System Alias, select the alias of your local back-end system.
This is the alias that you have created in Connect SAP Gateway to your Back-End System [page 90]. For
example, LOCAL.

5. In Technical Service Name, specify /UI2%*.

6. Choose Get Services (or press [ENTER]).

7. Select all the common OData services for SAP Fiori:

Common OData Services for SAP Fiori

/UI2/PAGE_BUILDER CONF

/UI2/PAGE BUILDER CUST

/UI2/PAGE_BUILDER PERS

/UI2/TRANSPORT

/UI2/INTEROP

8. Choose Add Selected Services and follow the instructions.
Result
The common OData services are now active in your SAP Gateway system.

Activate Application-Specific OData Services for SAP Customer Activity Repository
applications bundle

1. Log on to your front-end server (your SAP Gateway system).

2. Intransaction SPRO, navigate to | SAP Reference IMG # SAP NetWeaver » SAP Gateway » OData Channel

» Administration » General Settings » Activate and Maintain Services 3 and execute the Customizing
activity.

- Tip

As a quick shortcut to the same screen, use transaction /n/IWFND/MAINT SERVICE.

The Service Catalog shows you all the services that are currently active in your SAP Gateway system.
3. Activate the services that are required for your application:

1. Choose Add Service.
The Add Selected Services screen is displayed.
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2. In System Alias, select the alias of your back-end system.

3. Choose Get Services (or press [ENTER]).

The available services are displayed.
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4. Use the following table for reference and select the services for your application:

For this Application... Activate These OData services...

SAP Customer o For POS Data Transfer and Audit: none
Activity Repository o For Multichannel Transaction Data Management: none
o For Unified Demand Forecast and the demand planning apps (Analyze Forecast,
Adjust Forecast, Manage Demand Influencing Factors):
o /DMF/DEMAND PLAN UTILITIES SRV
o /DMF/OD_DEMAND PLAN SRV
o /DMF/OD_FC TIME SERIES VIZ SRV
© /DPL/OD ADJUST FORECAST SRV
o For Demand Data Foundation (optional, alternative to the DRF data replication
framework for importing master data):
o /DMF/API DOCUMENT
o /DMF/API_GENERIC TIME SERIES
0 /DMF/API_INVENTORY
o /DMF/API_LOCATION
o /DMF/API_LOCATION HIERARCHY
o /DMF/API_ PRODUCT
o /DMF/API_PRODUCT_ HIERARCHY
© /DMF/API PRODUCT LOCATION
o0 /DMF/API_SALES HISTORY
o /DMF/API_TRANSPORTATION LANE
o /DMF/API ATTRIBUTES
© /DMF/API_IMAGES
o /DMF/API_MERCHANDISE PLAN KPI
© /DMF/API PHPS
o For the Manage Product Attributes app:
/DMF/API_ATTRIBUTES SRV (optional, to import external attributes for integration
scenarios with a non-SAP source master data system)
o For Omnichannel Promotion Pricing: none
o For Omnichannel Article Availability and Sourcing (part of Inventory Visibility):
o With SAP S/4HANA back-end:
/OAA/F3391 MSN_SRV (new with SAP Customer Activity Repository)
/OAA/F2586 MSS SRV
/OAA/F2659 MSC SRV
/OAA/F3392 MS_ SRV (new with SAP Customer Activity Repository)

o With SAP Retail back-end:
/OAA/F2530_MSN_SRV
/ORA/F2586 MSS SRV
/ORA/F2659_MSC_SRV
/OAR/F3003 MS SRV

For On-Shelf Availability:
/OSA/ON_SHELF AVAILABILITY

o
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For this Application... Activate These OData services...

o For SAP Smart Business for Multichannel Sales Analytics: none

Distribution Curves /DMF/DIST_CURVE

SAP Allocation o0 /AMR/OD_ALLOCATIONPLAN SRV
Management o /AMR/OD_COMMON_ SRV

0 /AMR/OD MARKETUNIT SRV

o0 /AMR/OD_PARAM SRV

© /AMR/OD_WORKLOAD_ SRV

o /AMR/OD_ PRODUCT FLOW SRV

© /AMR/OD_KPI_CONFIG_SRV

o0 /AMR/OD_ALLOCATIONRESULT SRV

0 /AMR/OD_BASKET SRV

O /AMR/OD_ ALLOCATIONPLAN SEARCH SRV

SAP Assortment © /DMF/CURRENCY LIST SRV
Planning © /DMF/LOCATION CLUSTERSET SRV
© /DMF/MASTER DATA SRV
© /DMF/MODULE_ MANAGEMENT SRV
© /DMF/OBJ ATTRIBUTE SRV
© /DMF/PLAN CONFIG SRV
© /DMF/SEARCH LOCATIONS SRV
© /DMF/SEARCH PRODUCTS SRV
o /DMF/SEASONS_ SRV
© /RAP/ASSORTMENT LIST SRV
© /RAP/OPTION PLAN SRV
© /RAP/PHP MATCH SRV
© /RAP/VALIDITY PERIOD SRV
o /RAP/V_OP _KPI Q CDS_CDS
© /RAP/OPT PLN KPI SRV

© /RAP/V_OP OCLST PRSL O CDS CDS

SAP Merchandise Not applicable (this application does not have SAP Fiori apps)

Planning

SAP Promotion © /DMF/PROD MD SRV (Master Data Retrieval)

Management © /DMF/OFFER MANAGEMENT V2 SRV (Manage Promotional Offers)

o /DMF/PRODUCT GROUP_SRV (Manage Product Groups)
© /DMF/LOCATION SUBGROUP_ SRV (Manage Location Subgroups)

© /PRM/OFFER CONTENT_ SRV (Offer Content Assignment)

4. Choose Add Selected Services and follow the instructions.

i Note

User roles are only needed if you want to have connections to multiple back-end systems or multiple
clients on the same back-end. The user roles are system-specific and are not delivered by default. If
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required, you must create them manually. If you define multiple user roles for different connections,
make sure you have only one role assigned to your user at any time. If you need to change roles, first
remove the old role from your user, then assign the new role.

Result
The application-specific services that you have selected are now active in your SAP Gateway system.

6.1.1.11 Configure SAP Fiori Launchpad

Perform the general configuration of the SAP Fiori launchpad. This is a prerequisite to being able to set up SAP
Fiori apps for any of the applications.

Prerequisite

The central SAP Fiori Ul component is installed on the front-end server. The component contains the SAP Fiori
launchpad.

Use

The configuration steps are not specific to this guide and are described in the product documentation of your
SAP NetWeaver version.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.

2. Configure the SAP Fiori launchpad as described in the corresponding product documentation.
For SAP NetWeaver 7.52, see https://help.sap.com/viewer/p/SAP_NETWEAVER_AS_ABAP_752

|b <Version> ¥ Ul Technologies in SAP NetWeaver j» SAP Fiori Launchpad » Administration Guide 7.
If required, select a different version at the top right.

Parent topic: Core (Mandatory for All Applications) [page 67]
Previous: Configure SAP Gateway [page 88]
Next: Configure Calculation of SAPUI5 Application Index [page 97]
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6.1.1.12 Configure Calculation of SAPUI5 Application Index

Configure and run the report to calculate the SAPUI5 application index. You can run the report manually, but we
recommend that you schedule it as a regular background job on your front-end server. The reportis /UI5/
APP INDEX CALCULATE (Calculation of SAPUI5 Application Index for SAPUI5 Repositories).

Context

The SAPUI5 application index provides an indexing and caching mechanism for data related to SAP Fiori apps,
components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application Server
for ABAP.

This index is calculated and updated each time you run the report. The index makes it possible to find the data
significantly faster.

Use

Run the report and update the index in all front-end systems of your system landscape:
e after any changes to the content of the SAPUI5 ABAP repository

e afterinstalling a new version of the SAPUI5 distribution layer
e after implementing an SAP Note containing changes to an SAP Fiori app

Procedure

1. Read SAP Note 2227577 # (Recalculation of the SAPUI5 Application Index After Implementing an SAP
Note).
2. Determine the SAP NetWeaver version on your front-end server.
3. Follow the instructions specific to your SAP NetWeaver version:
o For SAP Gateway for SAP NetWeaver 7.52:

https://help.sap.com/viewer/p/SAP_NETWEAVER_AS_ABAP_752 | <Version> # Application Help
Ul Technologies in SAP NetWeaver (SAP_UI 750) » SAPUI5: Ul Development Toolkit for HTML5
Developing Apps # The SAPUI5 ABAP Repository and the ABAP Back-End Infrastructure » SAPUI5
Application Index J

Parent topic: Core (Mandatory for All Applications) [page 67]
Previous: Configure SAP Fiori Launchpad [page 96]
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6.1.2 Advanced (Optional)

Perform optional steps to set up specific functionality in SAP Customer Activity Repository.

6.1.2.1 Configure SAP Smart Business for Multichannel
Sales Analytics

6.1.2.11 Install the SAP Smart Business Modeler Apps
Framework

The SAP Smart Business for Multichannel Sales Analytics apps included in this installation are based on the
SAP Smart Business Modeler Apps Framework. Installation and setup of this framework includes the following:

e |[nstallation of SAP Smart Business Modeler apps on the front-end server
e |nstallation of SAP Smart Business products on the SAP HANA Server

e |[nstallation of SAP Web Dispatcher

e Communication channels

e App implementation

For more information on these topics, see https://help.sap.com/viewer/p/Ul_ADD-
ON_FOR_SAP_NETWEAVER_10|» Application Help » SAP Library » SAPUI5: Ul Development Toolkit for HTML5
SAPUI5 Application Frameworks #» SAP Smart Business » Setting up the SAP Smart Business Modeler Apps

Framework

i Note

If you are installing User Interface Add-On 2.0 for SAP NetWeaver, you must download and install add-on
object UISAFND1 100 as described in SAP Note 2183947 #r .
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6.1.212 Configure SAP Web Dispatcher for the SAP Smart
Business Modeler Apps

SAP Web Dispatcher lies between the Internet and your SAP system. It is the entry point for HTTP(s) requests
into your system. As a “software web switch”, SAP Web Dispatcher can reject or accept connections. It
contributes to security and also balances the load in your SAP system.

Where to Find Configuration Information

To find the SAP Web Dispatcher information for your SAP NetWeaver release, see the following:

e Central SAP Web Dispatcher note: 908097 SAP Web Dispatcher: Release, Installation, Patches,
Documentation

e Product documentation: https:/help.sap.com/viewer/p/SAP_NETWEAVER. Choose your SAP NetWeaver
Platform and select the support package stack at the top right.
For configuration information, search for “Administration of the SAP Web Dispatcher".
For a configuration example, search for “SAP Web Dispatcher Configuration Reference”.
For architecture information, search for “Architecture and Functions of the SAP Web Dispatcher”.

How to Configure SAP Web Dispatcher for the SAP Smart Business Modeler
Apps

The following parameters values are required:

® Source master data system: SAP ECC
Parameter wdisp/system 542 requires the following URL: /sap/is/retail/car/mcsa/odata
Resulting setting: wdisp/system 542 /sap/is/retail/car/mcsa/odata

e Source master data system: SAP S/4HANA
Parameter wdisp/system_ 542 requires the following URL: /sap/is/retail/car_s4h/mcsa/odata
Resulting setting: wdisp/system 542 /sap/is/retail/car_s4h/mcsa/odata

Other Solutions

If you use any other reverse proxy, see the manufacturer's documentation for more information.
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6.1.2.2 Configure On-Shelf Availability

Configure the On-Shelf Availability (OSA) module in SAP Customer Activity Repository. All steps are optional
and depend on your implementation scenario.

i Note

The configuration of OSA is mandatory if you want to generate intraday forecasts. For information about
this feature, see https://help.sap.com/viewer/p/CARAB | <Version> » Application Help » SAP Customer
Activity Repository # Unified Demand Forecast » General Services » Generate Intraday Forecasts 3.

i Note

If you encounter any issues when upgrading OSA, see Troubleshooting [page 154] for a possible solution.

6.1.2.2.1 Generate Run IDs for OSA Processing Steps

Use

Each scheduled run of a processing step of On-Shelf Availability (OSA) has a generated run ID. This is the
unique identification for a job.

The run ID is used to distinguish several runs within one period. Each processing step has its own ID generator:

Processing Step Transaction for the ID Generator
Intraweek Pattern /OSA/NR_IWP
Estimation /OSA/NR_EST
Monitoring /OSA/NR_MON
Analysis /OSA/NR_ANA

For each of the four ID generator transactions, you must define the range of run IDs.

Procedure

Do the following steps for each transaction:

1. Log on to your back-end system.

2. Execute the transaction by specifying either /n<transaction> or /o<transaction>.
Example for the first transaction: /n/0SA/NR_IWP

3. Choose Intervals in change mode.
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4. Inthe first row of the table, enter the following values for the following fields:
o Field No: 01
o Field From No.: 0000000000000001
o Field To Number: 9999999999999999

5. Save your changes.

6.1.2.2.2 Check Field Contents in SAP HANA Content for
On-Shelf Availability

Use

There are two OSA-specific SAP HANA views that can be customized:

® AN TRANSACTION
® PROMOTION TRANS

You must check if the fields in these views contain the mappings or formulas you need.

A Caution

If you need to modify a view, be aware that a new installation will rewrite the modifications. It is therefore
recommended to back up the modified views.

Procedure

To change the mapping or the formula of a field, do these steps:

Define the data foundation that is the source for the view, that is, the table /POSDW/TLOGF.
Define filters for the view.
Map the fields from source to target.

AW

Create measures and calculation fields.

For more information, see the documentation under https://help.sap.com/viewer/p/SAP_HANA_PLATFORM
|» <Version> » Development 3.

Definitions for a View (Using the AN TRANSACTION View as an Example)
The following definitions are set by default for the AN TRANSACTION view:

e The source of the view is the table /POSDW/TLOGF.
e Examples of filters for the views:
0 RECORDQUALIFIER = '5':Only salesrecords are used.
© DATASTATUS in ('2' , '3'"):Onlythose records are used that passed the SAP Customer Activity
Repository validation.
© RETAILQUANTITY > 0.0:Negative quantities are not used by On-Shelf Availability.
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© VOIDEDLINE = '':Canceled transactions are not used by On-Shelf Availability.
e Examples of fields mappings:
o MANDT: Client ID. This field is mapped to the MANDT column of the /POSDW/TLOGF table.
o STORE_ID:StorelD. This field is mapped to the RETAILSTOREID column of the /POSDW/TLOGF table.
© BUSINESSDAYDATE: Business day. This field is mapped to the BUSINESSDAYDATE column of the /
POSDW/TLOGF table.
e Examples of measures:
0 RETAILQUANTITY: Amount of units sold. Refers to the SALESUOM (Sales Unit of Measure) field that is
also defined in the /POSDW/TLOGF table. Contains the value of the RETATLQUANTITY field.
o PRICE: Price specified in the store currency. Contains the value of the ACTUALUNITPRICE field.
e Examples of calculated fields:
© TRANS TIME DBL: Value of the TRANS TIME output field of type DOUBLE. The format of the
transaction time that is stored in BEGINTIMESTAMP and ENDTIMESTAMP iS <YYYYMMDDhhmmss>.
O DISCOUNT: Total relative discount applied on the item.
Calculated as (ITEMDISC + DISTDISC) / (RETAILQUANTITY * ACTUALUNITPRICE). Ifthe price

is not a positive number, O is returned.
Definitions:

© DISTDISC: global discount on the whole purchase; currently not used.
© ITEMDISC: item-specific discount; currently used.

6.1.2.3 Ensure that Third Party CRM Sales Orders are
Transferred to SAP ERP

Use

Sales documents are accessed by SAP Customer Activity Repository (either through replication or direct data
access) from a source SAP ERP system. One way that sales documents of type Sales Order can be generated in
a SAP ERP system is through the transfer of sales orders created using an SAP CRM source system or a third
party CRM system.

When customers create sales orders using SAP CRM systems, these sales orders are inherently compatible to
the sales document structure in SAP ERP. They are transferred to SAP ERP via Data Exchange for Sales Orders:
CRM Enterprise - ERP System process. For more information, see SAP Library for SAP CRM on SAP Help Portal
at http://help.sap.com/crm#r. Select the applicable version of SAP CRM and under Application Help, open
SAP Library and choose | Basic Functions ¥ Business Transaction ¥ Data Exchange for Business

Transactions 3.

Customers who use third party CRM systems to create sales orders, and who want to access these sales orders
from SAP Customer Activity Repository, must ensure that their sales order data:

® |ncludes the information required by SAP Customer Activity Repository
® Has been transferred to SAP ERP prior to being able to access this data from SAP Customer Activity
Repository
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Procedure

1. Ensure that the fields required by SAP Customer Activity Repository are filled during the transfer of sales
order data from your third party CRM system to SAP ERP.
2. Ensure that sales order data has been transferred from your third party CRM system to SAP ERP.

6.1.2.4 Partition /POSDW/TLOGF and Aggregation Tables

Use

SAP Customer Activity Repository application contains the Point of Sale Data Management software
component, which is used to receive a large volume of data from your connected stores. Point of Sale Data
Management, or more specifically, its POS Inbound Processing Engine (PIPE), processes the incoming
transactions and stores them in the /POSDW/TLOGF table.

Since every transaction line item is stored as a separate row in the /POSDW/TLOGF table, the table can quickly
grow to become very large. To improve standard database operations, such as inserting, updating, deleting and
reading and mass operations, such as archiving or index merging, SAP recommends that you partition the /
POSDW/TLOGF table.

Also, you can select to store extension segments in a dedicated /POSDW/TLOGF_EXT table using the Store
Extensions in Separate Table option of the Define General Settings Customizing activity. Table /posDwW/
TLOGF EXT should be partitioned in the same way as the /POSDW/TLOGF table.

For more information on extension segments, see the Appendix of the Operations Guide, SAP Customer Activity
Repository.

i Note

Partitioning is typically used in distributed system, but it may also be beneficial for single-host systems.

Procedure

1. Read the Table Partitioning in the SAP HANA Database section of the SAP HANA Administration Guide.
2. Plan your partition specifications in accordance to the following guidelines:
o Asingle partition should not contain more than 1 billion rows.
o The total amount of partitions of a single table should not exceed 1000.
o Because the actual act of partitioning a table does use system resources, do not start partitioning
the /POSDW/TLOGF table until its volume has surpassed 250 million rows.
3. Partition the /PoSDW/TLOGF table as required according to SAP Note 1719282 % . Depending on your

requirements, you may also optionally partition the following tables. The same SAP Note is relevant for
these as well.

© /POSDW/TLOGF EXT
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© /POSDW/AGGRO1
© /POSDW/ACCRTB

6.1.25 Customize Copies of SAP HANA Views

Use

In this optional procedure, you create copies of views included in SAP HANA Live for SAP ERP or in the SAP
HANA content for SAP Customer Activity Repository. You then customize these copies to reflect your specific
data model extensions.

A Caution
Do not modify standard SAP HANA content.

For example, you would need to execute this procedure if you have extended your POS transaction data model.
The views delivered with the SAP HANA content for SAP Customer Activity Repository are built on the
standard /POsSDW/TLOGF table. If you have added custom fields to the /POSDW/TLOGF table, you will have to
create views that expose these fields.

In general, if you have extended any standard SAP data models, you must copy and adapt the standard SAP
HANA content.

A Caution

If you have created a copy of a view shipped as part of the standard SAP HANA content and have made
modifications to this copy, a subsequent upgrade of SAP HANA Live for SAP ERP or SAP HANA content for
SAP Customer Activity Repository will not update your copied and modified version of the view. SAP Notes
or enhancements shipped by SAP will also have to be manually implemented on the copied, and
subsequently modified, SAP HANA content.

Procedure

1. Logonto SAP HANA studio.
2. Open the Modeler and use the Navigator to access the folder that contains the view that you want to copy.
For example, | <Your System Name> » Content » sap ¥ is ¥ retail » car » Calculation Views 3.
3. ldentify the view you want to copy. For example, sap.is.retail.car/POSSalesQuery.
4. Use the Auto Documentation feature of SAP HANA studio to identify all reuse and private views that are
consumed by your selected view, as well as any query views that might consume your view. To do so:
1. Right-click on the selected view, and choose Auto Documentation from the context menu.
2. Browse to the location where you want to save the file and choose Finish.
3. Open the generated *.pdf file, and locate the Cross-References section of the document.
The Cross-References section displays the hierarchy of calculation (query, reuse, and private) views

that are accessed by the selected view. Affected underlying, as well as all consuming views, in this
hierarchy must also be copied and modified as a result of your extension.
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For example, calculation views sap.is.retail.car/POSSales, sap.is.retail.car/
POSLogItem, and sap.is.retail.car/TLOGF ITEM COM are all consumingthe /POSDW/ TLOGF
table and are consumed by the sap.is.retail.car/P0OSSalesQuery view. Therefore, if you have
extended the /POSDW/TLOGF table, all these views must be copied and modified.

5. For each view identified in the previous step, do the following:
1. Inthe Navigator panel, select an object and in the context menu, choose Copy.
2. Navigate to the package where you want to paste the view and choose Paste.

i Note

You must have write permissions on the target package to which you are pasting the view. Also, you
should copy the view to your own package. Do not modify the original sap package.

3. Modify the copied view as required.
For more information, see the Creating Views section of the SAP HANA Developer Guide.

4. Right-click on the copied and modified view and select Activate.

6.1.2.6 Complete UDF Setup

Set up the Unified Demand Forecast (UDF) module in SAP Customer Activity Repository to enable demand
modeling and forecasting. The steps in this section are optional and depend on the scenario that you wish to
implement.

Use

UDF supports the following scenarios:

Scenario Set Up and Configure UDF

Demand planning apps in SAP Customer Activity Repository Mandatory
(Analyze Forecast, Adjust Forecast, Manage Demand
Influencing Factors)

SAP Promotion Management Mandatory (for what-if forecasts)

Optional (without what-if forecasts)

SAP Allocation Management Mandatory (if associated with your scenario)
SAP Assortment Planning

SAP Merchandise Planning
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Prerequisites

® You have configured the DDF module as described in Configure Demand Data Foundation [page 841].

® You have set up the users, roles, and privileges for UDF as described in Set Up Authorizations for Unified
Demand Forecast (UDF) [page 73].

Procedure

i Note

If you encounter issues during the setup, see the Troubleshooting [page 154] section for possible solutions.

Perform Mandatory Setup Steps

1. Log on to your ABAP back-end system.
2. Intransaction SPRO, do the Customizing for UDF that you need for your scenario:

i Note

For more information about the following Customizing activities, see the accompanying system
documentation.

What to do... Your scenario is... Customizing

Define the time series source with his- All scenarios |} Cross-Application Components >
torical demand data that you wish to
import to DDF.

Demand Data Foundation > Imported
Data > Time Series > Define Time
Series for Key Figure Configuration 4

You want to generate what-if forecasts Additionally, configure the following
in SAP Promotion Management. activity for this scenario:
|} Cross-Application Components }
Demand Data Foundation > Data

Maintenance > Define Time Series

Source 4
Define general settings for modeling  All scenarios Activities under [ Cross-Application
and forecasting. Components # Demand Data

Foundation > Modeling and
Forecasting ]

3. Check and, if necessary, change the default setting for how the covariance matrix is generated during
modeling.
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1. Navigate to | Cross-Application Components » Demand Data Foundation » Modeling and Forecasting
» Define Modeling Control Settings 3.
2. Execute the Customizing activity and choose New Entries.

3. Configure the MOD COV_REDUCED parameter to generate either the “full” or the “reduced” covariance
matrix:

Your scenario is... What to do...

© Youwant to calculate hierarchical priors (HPRs). The reduced covariance matrix is sufficient for those

o You want to use SAP Promotion Management, but  scenarios and also saves runtime.

without generating the forecast confidence index
Enable the MOD cOov_REDUCED parameter:

(FCh.
o You do not want to use SAP Promotion Enter the parameter name under Configuration Type
Management. Code and set the Value to X to override the default.
Make the other settings as required and save your
changes.
You want to generate the FCl in SAP Promotion The full covariance matrix is mandatory for the FCI.
Management.
g No additional configuration is required (the
MOD COV_REDUCED parameter is disabled by default,
which is correct for this scenario).
Be aware that the generation of the full covariance ma-
trix is performance-intensive.
i Note

To calculate either the full or the reduced covariance matrix, the MOD OUTPUT COV parameter
must be enabled. As it is enabled by default, no additional configuration is required unless you have
previously disabled the parameter for a different scenario.

4. Configure the modeling and forecasting features that you wish to use in your scenario.
See the Configuring Unified Demand Forecast (UDF) section of the SAP Customer Activity Repository
Administration Guide.

Perform Optional Setup Steps
You have the following additional options:

1. Implement the following SAP Note(s) if relevant for your scenario:
o 2161484#% : Information about an ABAP report that you can use to validate the input data for modeling
and forecasting and identify potential issues

2. Setup table partitioning for your scenario.
See the Partition Tables for UDF and DDF section of the SAP Customer Activity Repository Administration
Guide.

3. Set upthe demand planning apps (Analyze Forecast, Adjust Forecast, Manage Demand Influencing Factors).
See Set Up Standalone SAP Fiori Apps for SAP Customer Activity Repository [page 108].
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More Information

For integration information for UDF and DDF, see the Introduction to SAP Customer Activity Repository section
of the SAP Customer Activity Repository Administration Guide.

6.1.2.7 Set Up Standalone SAP Fiori Apps for SAP
Customer Activity Repository

Check that the prerequisites are fulfilled and prepare the system landscape for the standalone apps included in
SAP Customer Activity Repository.

i Note

Depending on your scenario, some prerequisites might already be available in your system landscape.

General Prerequisites

® Front-end server: You have installed the required version of SAP FIORI FRONT-END SERVER. For version

information, see Install the Prerequisites [page 17] under | Common Prerequisites » SAP Fiori 3.

e SAP Fiori launchpad: You have set up the launchpad as described in the Common Installation Guide,
section.

e SAP Fiori launchpad designer: You have set up the designer as described for the SAP NetWeaver version
on your front-end server. See https://help.sap.com/viewer/p/SAP_NETWEAVER [ SAP NetWeaver
Platform ¥ <Version> ¥ Application Help » Ul Technologies in SAP NetWeaver » SAP Fiori Launchpad ¥
Setting up the Launchpad 3 and Using the Launchpad Designer.

For some apps, app-specific settings will be required in the designer.

e SAP Gateway: You have done the general SAP Gateway configuration and you have activated the central
OData services and Internet Communication Framework (ICF) services. See the following:

© ,including all subsections
o SAP Note 1560585#% (SAP Gateway 2.0 Release Note)

Prerequisites Specific to SAP Customer Activity Repository applications
bundle

1. You haveinstalled the SAP RTL, AFL FOR SAP HANA component for the current release. See Download
and Install the Application Function Library (SAP RTL AFL FOR SAP HANA) [page 47].

2. You have installed the back-end system. See Install ABAP Back-End Server [page 46].

3. You have installed the front-end system. See .
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You have implemented all the mandatory SAP Notes for the apps that you wish to set up. See Implement
SAP Notes for the Installation [page 25] and consult the release information notes (RINs) mentioned there
as well as the table for SAP Customer Activity Repository.

. You have performed all mandatory setup steps for SAP Customer Activity Repository. For example, this

includes activating the OData services for the apps or calculating the SAPUIS application index. For a
complete list of the steps, see Core (Mandatory for All Applications) [page 67].

You have set up the system connections:

©  You have set up dedicated RFC connections between your front-end system and your back-end
system, and between your front-end system and your source master data system.
o You have defined a system alias for your back-end system.

A\ Caution

You must set the back-end system client to the same value for the SAP Gateway OData services (via
the system alias and the RFC connection) and the SAP HANA services (via the bk-client parameter
in the SAP Fiori launchpad designer). Otherwise, the apps will not work correctly.

For the demand planning apps (Analyze Forecast, Adjust Forecast, Manage Demand Influencing Factors):
You have set up the Unified Demand Forecast (UDF) module as the forecasting engine in the back-end. You
must at least complete the mandatory setup steps. See Complete UDF Setup [page 105].

Only for Analyze Forecast:

o SAP Web Dispatcher: You have configured the dispatcher and set up the routing rules for browser
requests as described in section Configuring SAP Web Dispatcher # .

i Note

If you encounter issues during the setup, see the following sections for possible solutions:
o Central SAP Note for SAP Web Dispatcher: 908097 (SAP Web Dispatcher: Release,
Installation, Patches, Documentation)

o SAP Help Portal for SAP NetWeaver: Choose your SAP NetWeaver Platform and select your
support package stack at the top right. Search for “Architecture and Functions of the SAP Web
Dispatcher” and “Administration of the SAP Web Dispatcher”.

o If you use any other reverse proxy, see the manufacturer's documentation for more
information.

o SAP Fiori system landscape with SAP HANA Extended Application Services, classic model: You
have set up the system landscape as described in https://help.sap.com/viewer/p/

FIORI_IMPLEMENTATION |+ Version: SAP NW 7.40 4.0 » Installation and Upgrade » Setup of SAP Fiori
System Landscape ¥ Setup of SAP Fiori System Landscape with SAP HANA XS .

For system landscape diagrams, see https://help.sap.com/viewer/p/SAP_FIORI | Implementation
Information for SAP Fiori for SAP Business Suite » Setup of SAP Fiori System Landscape for SAP
Business Suite ' SAP Fiori for SAP Business Suite: Implementation Information j» Setup of SAP Fiori
System Landscape for SAP Business Suite with SAP HANA XS 3.

Result

Afte

r you have prepared the system landscape in this way, you can now set up the apps that you wish to use.
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Set Up the Analyze Forecast App [page 110]
Perform several tasks on the front-end server and the back-end server to set up the Analyze Forecast
app.

Set Up the Adjust Forecast App [page 117]
Perform several tasks on the front-end server and the back-end server to set up the Adjust Forecast
app.

Set Up the Manage Demand Influencing Factors App [page 122]

Perform several tasks on the front-end server and the back-end server to set up the Manage Demand
Influencing Factors app.

Set Up the Manage Product Attributes App [page 127]
Perform several tasks on the front-end server and the back-end server to set up the Manage Product
Attributes app. This transactional app is delivered with SAP Customer Activity Repository and supports
different scenarios and consuming applications (such as SAP Allocation Management and SAP
Assortment Planning). The app enables planning administrators to create, configure, assign, and
maintain product attributes for a selected product hierarchy.

Set Up Additional Standalone Apps Included in SAP Customer Activity Repository [page 130]
In addition to the apps described in this guide, SAP Customer Activity Repository includes additional
apps that support different scenarios and consuming applications.

6.1.2.71 Set Up the Analyze Forecast App

Perform several tasks on the front-end server and the back-end server to set up the Analyze Forecast app.

i Note

If you are already using the app and only wish to upgrade it to the current release, see the Set Up the
Analyze Forecast App (Upgrade Scenarios) section of the Common Upgrade Guide for this release.

Prerequisites

® You are aware that the technical setup for Analyze Forecast (app ID: F1773A) differs from that of the other
apps:
o  The app requires SAP Web Dispatcher.

o The app does not use SAP HANA XSA (SAP HANA Extended Application Services, advanced model).
Instead, it requires SAP HANA XS Classic (SAP HANA Extended Application Services, classic model).

i Note

The SAP HANA Extended Application Services are a layer on top of the SAP HANA database. This
layer provides the platform for running SAP HANA-based Web applications.
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® You are aware of the implementation information for the app in the SAP Fiori apps reference library.
For the latest delivery (latest wave), see: https://fioriappslibrary.hana.ondemand.com/sap/fix/
externalViewer/index.html?appld=F1773A

® You have verified the prerequisites and prepared the system landscape as described in Set Up Standalone
SAP Fiori Apps for SAP Customer Activity Repository [page 108].

e (Optional) If you need information on the key features of the app and the supported time series, see
https://help.sap.com/viewer/p/CARAB || <Version> ¥ Application Help » SAP Customer Activity
Repository ¥ SAP Fiori for SAP Customer Activity Repository » Standalone SAP Fiori Apps for SAP

Customer Activity Repository ¥ Analyze Forecast (Version 2)

Procedure

To set up Analyze Forecast, follow these steps:
- Tip

If you encounter issues during the setup, see the Troubleshooting [page 154] section for possible solutions.

1. Configure user access to the SAP HANA data for the app.
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1.

i Note

You can find the general SAP Fiori Help section for this step at https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION |+ Version: SAP NW 740 » Implementation * App Implementation » App
Implementation for Analytical Apps ¥ Configuring Access to SAP HANA Data 3.

Use this section as your starting point. However, to configure Analyze Forecast, you only need to do
some of the steps described there.

Synchronize the SAP HANA database users. Each user of the app requires both a user in the ABAP
front-end server (to enable navigation in the SAP Fiori launchpad) and a user in the SAP HANA
database (to enable access to the relevant SAP HANA views).

Follow the steps in | Configuring Access to SAP HANA Data ¥ Synchronizing SAP HANA Database
Users 3.

Assign the app-specific SAP HANA role
sap.hba.t.rtl.udf.afc.roles::AnalyzeForecast.hdbrole tothe users of the app. The role

gives them access to the app-specific SAP HANA data so they can analyze this data in the app (for
example, sales, modeling results, forecasts).

Follow the steps in |F Configuring Access to SAP HANA Data » Assigning Roles for Accessing SAP
HANA Data 3.

Create the analytic privileges to give the users read-only access to the SAP HANA views for the app
(SAP HANA content package sap.hba.t.rtl.udf.afc.v).

Follow the steps in |F Configuring Access to SAP HANA Data » Creating Analytic Privileges 3.
If you need more information about analytic privileges, see the following:

o https://help.sap.com/viewer/p/SAP_HANA_PLATFORM | <Version> » Development  SAP
HANA Modeling Guide (for SAP HANA Studio) » Defining Data Access Privileges » Create Classical
XML-based Analytic Privileges 3

o https://help.sap.com/viewer/product/SAP_HANA_LIVE/2.0/en-US | <Version> ¥ Additional

Information » SAP HANA Live Authorization Assistant 3, in particular sections Generating Analytic
Privileges and Updating Analytic Privileges

2. Customize the navigation target for the app in the SAP Fiori launchpad on the front-end server.
In Launchpad Customizing (transaction LED_CUST), choose [ UICAROOI TRANSACTIONAL »

AnalyzeForecast  and make the following settings:

o

o

e}

o

o

o

o

Link Text: AnalyzeForecast

Application Type: URL

URL: /sap/bc/ui5_ui5/sap/analyzfcst_v2

Application Alias: AnalyzeForecast

Additional Information: SAPUI5.Component=retail.udf.analyzeforecastv2
Portal Parameters: Leave the default settings.

Switch Support: Leave the default settings.

If you need more information on navigation targets, see https://help.sap.com/viewer/p/SAP_NETWEAVER
and choose your SAP NetWeaver Platform. Select your support package stack at the top right and search
for “Customizing Navigation Targets in LPD_CUST".

3. Configure the SAP Fiori launchpad designer for Analyze Forecast.
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1. Launch the designer in one of the following modes:

o

For the cusT mode, use this URL:
https://<server>:<port>/sap/bc/ui5_ui5/sap/arsrvc_upb_admn/main.html?sap-
client=<client>#/Catalog/X-SAP-UI2-CATALOGPAGE:SAP ISR CAR TC A

Use this mode for client-specific configurations, specifying the respective client.

For the cONF mode, use this URL:

https://<server>:<port>/sap/bc/ui5 ui5/sap/arsrvc_upb_admn/main.html?sap-
client=<client>&scope=<CONF>#/Catalog/X-SAP-UI2-

CATALOGPAGE:SAP_ISR CAR TC A

Use this mode for global configurations across all clients. Note that in this URL, you additionally
specify the scope parameter.

2. Configure the app tile in the SAP Fiori launchpad designer.

i Note

By default, the tile for Analyze Forecast is in the SAP: CAR — Analytical Apps catalog (which is
shipped with the launchpad configuration).

If the app tile has not yet been created, create it as a static tile using the following settings:

o

o

o

o

o

o

o

Title: Analyze Forecast

Icon: sap-icon://Fiori5/F0812

Use semantic object navigation: Select this option.
Semantic Object: ForecastDemand

Action: showUDFAnalyzeForecast

Parameters: bk-client=<backend client>

Leave the other options empty.

If you need more information about configuring tiles, see https://help.sap.com/viewer/p/
SAP_NETWEAVER and choose your SAP NetWeaver Platform. Select your support package stack at
the top right and search for “Static App Launcher Tiles”.

3. Configure the target mapping in the SAP Fiori launchpad designer.
If the target mapping has not yet been created, choose Target Mappings and create a new entry with
the following settings:

o

o

o

o

o

Semantic Object: ForecastDemand

Action: showUDFAnalyzeForecast

Application Type: SAP Fiori App using LPD_CUST
Launchpad Role: UICAR001

Launchpad Instance: TRANSACTIONAL

Application Alias: AnalyzeForecast

Device Types: Select Desktop and Tablet.

Allow additional parameters: Select this option.

If you need more information about configuring target mappings, see https://help.sap.com/viewer/p/
SAP_NETWEAVER and choose your SAP NetWeaver Platform. Select your support package stack at
the top right and search for “Configuring Target Mappings”.

4. Complete the setup on the front-end server.
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i Note

You can find the general SAP Fiori Help section for this step at https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION | Version: SAP NW 740 » Implementation » App Implementation » App
Implementation for Analytical Apps ¥ Implementation Tasks on Front-End Server 3.

Use this section as your starting point. However, to configure Analyze Forecast, you only need to do
some of the steps described there.

1. Activate the SAP Gateway OData services for the app:
Follow the steps in Activate OData Services [page 91].

A\ Caution

In the SAP Fiori launchpad designer, you specify the back-end system client using the bk-client
parameter. You must specify the same back-end system client for the SAP Gateway OData services
(system alias and RFC connection) and for the SAP HANA services. Otherwise, the app will not
work correctly.

2. InLaunchpad Customizing (transaction LED_CUST), choose [ UICAROOI TRANSACTIONAL »

AnalyzeForecast J and verify that the app-specific Internet Communication Framework (ICF) services
are active:

© /sap/bc/bsp/sap/analyzfcst v2

© /sap/bc/lrep

O /sap/bc/uib ui5/sap/analyzfcst v2

© /sap/bc/bsp/sap/udfreuse

© /sap/bc/uib ui5/sap/udfreuse

If a service is not active, activate it as follows:

1. Execute transaction SICF.

2. As Service Path, specify the <service path/service name> and execute the search.

3. As Virtual Hosts / Services, select the analyzfcst_v2 entry and choose |B Service/Host
Activate 3.
If you need more information on how to activate ICF services and OData services, see
| Implementation Tasks on Front-End Server  Front-End Server: Activate ICF Services of SAPUI5
Application 3.

3. Add the start authorizations for the app-specific XS OData service
(sap.hba.t.rtl.udf.afc.odata::AnalyzeForecast.xsodata) to the role on the front-end
server. The users need the start authorizations for the activated service to be able to launch the app.
Follow the steps in | Implementation Tasks on Front-End Server » Add Start Authorizations for OData
Services to Role on Front-End 3.

4. Create your custom copy of the SAaP CAR TCR A PFCG role on the front-end server.

i Note

SAP_CAR TCR Alis the front-end server authorization role delivered for analytical apps in SAP
Customer Activity Repository. The role contains the catalogs, groups, and start authorizations for
the OData service required for access to the app.
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1. Copy the provided standard role SAP_CAR TCR_A on the front-end server and enter a name from
the customer namespace.

2. Adjust the role as needed for your scenario. If you need more information on adjusting standard
roles, see section Changing Standard Roles in the User and Role Administration of Application
Server ABAP.

3. Assign the required launchpad catalogs and groups. Follow the steps in [ Implementation Tasks
on Front-End Server ¥ Create PFCG Role on Front-End and Assign Launchpad Catalogs and
Groups 3.

4. Save your changes.

5. Create your custom copy of the SaP_DPL_TCR_T PFCG role on the front-end server. This step is
similar to the previous one, and you can consult the same references.

i Note

SAP DPL TCR T is the front-end server authorization role delivered for the demand planning apps
in SAP Customer Activity Repository.

1. Copy the provided standard role SAP_DPL_TCR_T on the front-end server and enter a name from
the customer namespace.

2. Adjust the role as needed for your scenario.

3. Assign the required launchpad catalogs and groups.

4. Save your changes.

->Tip
If you already have an SAP Fiori launchpad open, clear your browser cache to apply all the changes.

5. Set up the catalogs, groups, and roles in the SAP Fiori launchpad.

Follow the steps in | Implementation Tasks on Front-End Server ¥ Setup of Catalogs, Groups, and Roles in
the SAP Fiori Launchpad 3.

6. Take your custom copies of the two front-end PFCG roles and assign them to the users of the app.
Follow the steps in | Implementation Tasks on Front-End Server ¥ Front-End Server: Assign Roles to
Users .

7. Complete the setup on the back-end server.

1. Log on to the back-end server and execute transaction PFCG to open the Role Maintenance screen.
2. Choose |r Role » Create » Role 3.
3. Copy the provided standard role /DMF/DPL and enter a name from the customer namespace.

i Note

/DMF /DPL is the back-end server authorization role. It is also required to access the Adjust
Forecast app via cross-navigation from the Analyze Forecast app.

4. Adjust the copied role as needed for your scenario. If you need more information on adjusting standard
roles, see section Changing Standard Roles in the User and Role Administration of Application Server
ABAP.

5. Save your changes.
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Optional Setup Steps

If relevant for your scenario, implement any of the following options:

Single Sign-On (SSO): If you haven't already done so, set up SSO between the front-end server and the
back-end server.
For available SSO mechanisms depending on the system landscape, see:
o https:/help.sap.com/viewer/p/FIORI_IMPLEMENTATION | <Version> » SAP Fiori: Security » User
Authentication and Single Sign-On (SSO) 3
o https:/help.sap.com/viewer/p/SAP_HANA_PLATFORM | <Version> » Security » SAP HANA Security
Guide » SAP HANA Authentication and Single Sign-On » Single Sign-On Integration J
For information on how to set up SSO for SAP HANA XS in particular, see https://help.sap.com/viewer/p/
SAP_HANA_PLATFORM |k <Version> » Administration » SAP HANA Administration Guide » Application
Run-Time Services » Maintaining the SAP HANA XS Classic Model Run Time » Maintaining Single Sign-On
for SAP HANA XS Applications 3.

Area of Responsibility (AOR): Assign an AOR (recommended).

This step is required if you wish to use the Product Hierarchy filter option in the app. If so, each front-end
user of the app must also have a user in the back-end system. You assign an area of responsibility to this
back-end user so that the front-end user can see the assigned product hierarchies in the app.

To assign an AOR, use the Maintain Area of Responsibility service in transaction NwWBC. For instructions, see

https://help.sap.com/viewer/p/CARAB | <Version> » Application Help » SAP Customer Activity
Repository » Demand Data Foundation » General Services ¥ Maintenance Services » Maintain Area of
Responsibility 3.

App Extensibility: Extend the app with custom content.

For information on the available extension points and controller hooks, see the SAP Fiori apps reference
library at https://fioriappslibrary.hana.ondemand.com/sap/fix/externalViewer/index.html?appld=F1773A.
Choose IMPLEMENTATION INFORMATION, select the delivery, and consult the information under
Extensibility.

Result

You have successfully set up the Analyze Forecast app.
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6.1.2.7.2 Set Up the Adjust Forecast App

Perform several tasks on the front-end server and the back-end server to set up the Adjust Forecast app.

Prerequisites

You have checked that the prerequisites described in Set Up Standalone SAP Fiori Apps for SAP Customer
Activity Repository [page 108] are fulfilled.

You are aware of the implementation information for the app in the SAP Fiori apps reference library: For the
latest delivery (wave), see: https://fioriappslibrary.hana.ondemand.com/sap/fix/externalViewer/index.html?
appld=F3479

You have set up the SAP Fiori app Analyze Forecast, as described in Set Up the Analyze Forecast App [page
110].

Procedure

To set up Adjust Forecast, follow these steps:

1. To prepare the setup, read the app-specific information on SAP Help Portal at https://help.sap.com/

viewer/p/CARAB | <Version> » Application Help ¥ SAP Customer Activity Repository ¥ SAP Fiori for SAP

Customer Activity Repository » Standalone SAP Fiori Apps for SAP Customer Activity Repository ¥ Adjust
Forecast 3.

2. Customize the navigation target for the app in the SAP Fiori launchpad on the front-end server.
In Launchpad Customizing (transaction LPD_CUST), choose UIDPL0O01 TRANSACTIONAL Demand
Planning Apps and make the app-specific settings for all of the apps:
Application Settings for Adjust Forecast

o Link Text: AdjustForecast
o Application Type: URL
© URL:/sap/bc/uib ui5/sap/adjustforecast
o Application Alias: AdjustForecast
o Additional Information: SAPUI5.Component=retail.dpl.adjustforecast
o Portal Parameters: Leave the default settings.
o Switch Support: Leave the default settings.
Application Settings for Forecast Correction Overlapping Rules
o Link Text: Forecast Correction Overlapping Rules
o Application Type: TRA Transaction
o Transaction Code: /DMF/FCC_MAINT RULES
o System Alias: Enter the HTTP connection to the back-end client in the format SYSID CLNT HTTPS
o Application Alias: ForecastCorrOverlapRules
o GUIType:WEB_GUI SAP GUI for HTML
o Entries Once Started: S Tnitial Screen

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
Set Up the Applications PUBLIC

17


https://fioriappslibrary.hana.ondemand.com/sap/fix/externalViewer/index.html?appId=F3479
https://fioriappslibrary.hana.ondemand.com/sap/fix/externalViewer/index.html?appId=F3479
https://help.sap.com/viewer/p/CARAB
https://help.sap.com/viewer/p/CARAB

o

o

Portal Parameters: Leave the default settings.
Switch Support: Leave the default settings.

Application Settings for Forecast Correction Classification

o

o

o

o

o

Link Text: Forecast Correction Classification

Application Type: TRA Transaction

Transaction Code: /DMF/FCC_MAINT CLSCF

System Alias: Enter the HTTP connection to the back-end client in the format SYSID CLNT HTTPS
Application Alias: ForecastCorrClassification

GUI Type: WEB_GUI SAP GUI for HTML

Entries Once Started: s Initial Screen

Portal Parameters: Leave the default settings.

Switch Support: Leave the default settings.

If you need more information about navigation targets, see SAP Help Portal at https://help.sap.com/
viewer/p/SAP_NETWEAVER and choose your SAP NetWeaver Platform. Select your support package
stack at the top right and search for “Customizing Navigation Targets in LPD_CUST".

3. Configure the SAP Fiorilaunchpad designer for CAR Demand Planning Apps.
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1

2.

Launch the SAP Fiori launchpad designer either in the CUST or in the CONF mode:

O CUST mode:
Use this mode for client-specific configurations, specifying the respective client. For the cusT
mode, use this URL:
https://<server>:<port>/sap/bc/ui5 ui5/sap/arsrvc_upb_admn/main.html?sap-
client=<client>#/Catalog/X-SAP-UI2-CATALOGPAGE : SAP DPL TC T

© CONF mode:
Use this mode for global configurations across all clients. Note that in this URL, you additionally
specify the scope parameter.
For the coNF mode, use this URL:
https://<server>:<port>/sap/bc/uib5 ui5/sap/arsrvc_upb_admn/main.html?sap-
client=<client>&scope=CONF#/Catalog/X-SAP-UI2-CATALOGPAGE:SAP DPL TC T
Use this mode for global configurations across all clients. Note that in this URL, you additionally
specify the scope parameter.

Configure the app tile in the SAP Fiori launchpad designer.

i Note

By default, the tiles for Adjust Forecast, Analyze Forecast, Forecast Correction Classification, and
Forecast Correction Overlapping Rules are in the SAP: CAR — Deman Planning Apps catalog (which
is shipped with launchpad configuration).

If the app tiles have not yet been created, create them as static tiles using the following settings:
Adjust Forecast

o Title:Adjust Forecast

© [con: sap-icon://Fiori5/F0819

o Use semantic object navigation: Select this option.

o Semantic Object: ForecastDemand

o Action: editUDFAdjustForecast

o Leave the other options empty.
Forecast Correction Classification
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o Title: Forecast Correction Classification
o |con: sap-icon://group-2
© Information: /DMF/FCC_MAINT CLSCF
o Use semantic object navigation: Select this option.
o Semantic Object: DemandPlanConfiguration
o Action: create
o Leave the other options empty.
Forecast Correction Overlapping Rules
o Title: Forecast Correction Overlapping Rules
© [con: sap-icon://Fiori2/F0306
© Information: /DMF/FCC_MAINT RULES
o Use semantic object navigation: Select this option.
o Semantic Object: DemandPlanConfiguration
o Action: manage
o Leave the other options empty.

If you need more information about configuring tiles, see SAP Help Portal at https:/help.sap.com/

viewer/p/SAP_NETWEAVER and choose your SAP NetWeaver Platform. Select your support package

stack at the top right and search for “Static App Launcher Tiles”.
3. Configure the target mapping in the SAP Fiori launchpad designer.
If the target mapping has not yet been created, choose Target Mappings and create entries with the

following settings:
Adjust Forecast

o Semantic Object: ForecastDemand

o Action: editUDFAdjustForecast

© Application Type: SAP Fiori App using LPD_CUST

o Launchpad Role: UIDPL0O01

o Launchpad Instance: TRANSACTIONAL

o Application Alias: AdjustForecast

o Device Types: Select Desktop and Tablet.

o Allow additional parameters: Select this option.
Forecast Correction Classification

o Semantic Object: DemandPlanConfiguration

o Action: create

o Application Type: SAP Fiori App using LPD_CUST

o Launchpad Role: UIDPL0OO1

o Launchpad Instance: TRANSACTIONAL

o Application Alias: ForecastCorrClassification

© Information: /DMF/FCC_MAINT CLSCF

o Device Types: Select Desktop and Tablet.

o Allow additional parameters: Select this option.
Forecast Correction Overlapping Rules

o Semantic Object: DemandPlanConfiguration

o Action: manage

o Application Type: SAP Fiori App using LPD_CUST
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o Launchpad Role: UIDPL0OO1
© Launchpad Instance: TRANSACTIONAL
o Application Alias: ForecastCorrOverlapRules
© Information: /DMF/FCC_MAINT RULES
o Device Types: Select Desktop and Tablet.
o Allow additional parameters: Select this option.
If you need more information about configuring target mappings, see SAP Help Portal at https://
help.sap.com/viewer/p/SAP_NETWEAVER and choose your SAP NetWeaver Platform. Select your
support package stack at the top right and search for “Configuring Target Mappings”.
4. Complete the implementation on the front-end server.

i Note

You can find the general SAP Fiori Help section for this step at https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION [} Version: SAP NW 740 ¥ Implementation ¥ App Implementation ¥ App

Implementation for Analytical Apps ¥ Implementation Tasks on Front-End Server 4.

Use this section as your starting point. However, to configure Adjust Forecast, you only need to perform
a subset of the steps described there. Proceed as follows:

1. Check that the app-specific Internet Communication Framework (ICF) service
AdjustForecast /sap/bc/ui5 ui5/sap/adjustforecast is active. If the service is not active,
activate it as follows:
1. Execute transaction SICF.
2. As Service Path, specify the <service path/service name>and execute the search.

3. As Virtual Hosts / Services, select the ADJUSTFORECAST entry and choose |» Service/Host
Activate 3.
For more information on how to activate ICF services and OData services, see [ Implementation Tasks

on Front-End Server » Front-End Server: Activate ICF Services of SAPUI5 Application 3.
2. Activate and Maintain OData Services
Call up transaction Activate and Maintain Services (/ IWFND/MAINT SERVICE)and check if the
following services are already existing in your service catalog:
o Adjust Forecast OData Service
o Type:BEP
© Technical Service Name: zOD_ADJUST FORECAST SRV
o Service Description: DPL Fiori Adjust Forecast App OData Service
© External Service Name: OD ADJUST FORECAST SRV
o Namespace: /DPL/
If the service is not available, choose Add Service, enter back-end system alias, and choose Get
Services. Search for /DPL/0OD _ADJUST FORECAST SRV, select the entry and choose Add Selected
Services. Take over the provided data and enter the local package assignment.
o Time Series OData Service
o Type:BEP
© Technical Service Name: zOD_FC TIME SERIES VIZ SRV
o Service Description: OData Srv. for Forecast-Related Time Series Visualization
o External Service Name: OD FC TIME SERIES VIZ SRV
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o Namespace: /DMF/
If the service is not available, choose Add Service, enter back-end system alias, and choose Get
Services. Search for /DMF/OD _FC_TIME SERIES VIZ SRV, select the entry and choose Add
Selected Services. Take over the provided data and enter the local package assignment.
o Demand Plan OData Service for Reuse
o Type:BEP
o Technical Service Name: ZDEMAND PLAN UTILITIES SRV
o Service Description: Demand Plan OData Service for Reuse
o External Service Name: DEMAND PLAN UTILITIES SRV
o Namespace: /DMF/
If the service is not available, choose Add Service, enter back-end system alias, and choose Get
Services. Search for /DMF/DEMAND PLAN UTILITIES SRV, selectthe entry and choose Add
Selected Services. Take over the provided data and enter the local package assignment.
3. Copythe sap_DPL TCR_T PFCG role on the front-end server and enter a name from the customer
namespace. Assign the required launchpad catalogs and groups. SAP_DPL_TCR T is the front-end
server authorization role delivered for all demand planning apps in SAP Customer Activity Repository.

- Tip

If you already have an SAP Fiori launchpad open, clear your browser cache to apply the
modifications to your user roles. Otherwise, you cannot see the changes on the user interface.

Follow the steps in | Implementation Tasks on Front-End Server ¥ Create PFCG Role on Front-End and
Assign Launchpad Catalogs and Groups .

4. Set up the catalogs, groups, and roles in the SAP Fiori launchpad.
Follow the steps in |F Implementation Tasks on Front-End Server » Setup of Catalogs, Groups, and Roles

in the SAP Fiori Launchpad 3.

5. Take the front-end PFCG role that you created before and assign it to the users of the app. The role
contains the catalogs, groups, and start authorizations for the OData service that the users need.
Follow the steps in | Implementation Tasks on Front-End Server » Front-End Server: Assign Roles to

Users 3.

5. Complete the implementation on the back-end server.
Copy the role /DMF/DPL in the Role Maintenance (PFCG) of the back-end server and enter a name from the
customer namespace. /DMF/DPL is the back-end server authorization role. It is also required for accessing
the Adjust Forecast app via forward navigation from the Analyze Forecast app in SAP Customer Activity
Repository.

6. (Optional) Assign area of responsibility.
This step is only required if you wish to use the Product Hierarchy filter in the app. In this case, each user of
the app must have an area of responsibility (AOR) assigned to their ABAP back-end user. This assignment
enables the display of product hierarchies in the app. You assign AORs using the Maintain Area of
Responsibility Web Dynpro service in DDF.
Follow the steps in the Maintain Area of Responsibility section under https://help.sap.com/viewer/p/
CARAB | <Version> » Application Help ¥ SAP Customer Activity Repository # Demand Data Foundation
General Services » Maintenance Services 3.

7. (Optional) Set up Single Sign-On (SSO) between the front-end server and the back-end server.
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For information on available SSO mechanisms depending on your system landscape, see the following:

o https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION | <Version> * SAP Fiori: Security » User
Authentication and Single Sign-On (SSO) 3

o https:/help.sap.com/viewer/p/SAP_HANA_PLATFORM [ <Version> » Security » SAP HANA Security
Guide » SAP HANA Authentication and Single Sign-On » Single Sign-On Integration J

- Tip

If you encounter issues during the setup, see the Troubleshooting [page 154] section for possible solutions.

Result

You have successfully set up the Adjust Forecast app.

Related Information

Activate OData Services [page 91]

6.1.2.7.3 Set Up the Manage Demand Influencing Factors
App

Perform several tasks on the front-end server and the back-end server to set up the Manage Demand
Influencing Factors app.

Prerequisites

You have checked that the prerequisites described in Set Up Standalone SAP Fiori Apps for SAP Customer
Activity Repository [page 108] are fulfilled.

You are aware of the implementation information for the app in the SAP Fiori apps reference library: For the
latest delivery (wave), see: https://fioriappslibrary.hana.ondemand.com/sap/fix/externalViewer/index.html?
appld=F3885
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Procedure

To set up Manage Demand Influencing Factors, follow these steps:

1. To prepare the setup, read the app-specific information on SAP Help Portal at https:/help.sap.com/
viewer/p/CARAB | <Version> » Application Help » SAP Customer Activity Repository » SAP Fiori for SAP
Customer Activity Repository ¥ Standalone SAP Fiori Apps for SAP Customer Activity Repository # Manage

Demand Influencing Factors 3.

2. Customize the navigation target for the app in the SAP Fiori launchpad on the front-end server.
In Launchpad Customizing (transaction LPD_CUST), choose UIDPL0O01 TRANSACTIONAL Demand
Planning Apps and make the app-specific settings for all of the apps:
Application Settings for Manage Demand Influencing Factors

o

o

o

o

e}

o

o

Link Text: ManageDemandInfluencingFactors

Application Type: URL

URL: /sap/bc/ui5 ui5/sap/managedifs

Application Alias: DIFManagement

Additional Information: SAPUI5.Component=retail.dpl.managedif
Portal Parameters: Leave the default settings.

Switch Support: Leave the default settings.

Application Settings for Demand Influencing Factors Library

e}

o

o

o

e}

Link Text: Demand Influencing Factors Library

Application Type: TRA Transaction

Transaction Code: /DMF/DIF LIBRARY

System Alias: Enter the HTTP connection to the back-end client in the format SYSID CLNT HTTPS
Application Alias: DIFLibrary

GUI Type: WEB_GUI_SAP GUI for HTML

Entries Once Started: S Initial Screen

Portal Parameters: Leave the default settings.

Switch Support: Leave the default settings.

If you need more information about navigation targets, see SAP Help Portal at https://help.sap.com/
viewer/p/SAP_NETWEAVER and choose your SAP NetWeaver Platform. Select your support package
stack at the top right and search for “Customizing Navigation Targets in LPD_CUST".

3. Configure the SAP Fiorilaunchpad designer for CAR Demand Planning Apps.

i

Launch the SAP Fiori launchpad designer either in the cusT or in the CONF mode:

© CUST mode:
Use this mode for client-specific configurations, specifying the respective client. For the cusT
mode, use this URL:

https://<server>:<port>/sap/bc/ui5_ui5/sap/arsrvc_upb_admn/main.html?sap-

client=<client>#/Catalog/X-SAP-UI2-CATALOGPAGE:SAP DPL_TC_T
O CONF mode:

Use this mode for global configurations across all clients. Note that in this URL, you additionally

specify the scope parameter.
For the cCONF mode, use this URL:

https://<server>:<port>/sap/bc/ui5_ui5/sap/arsrvc_upb_admn/main.html?sap-

client=<client>&scope=CONF#/Catalog/X-SAP-UI2-CATALOGPAGE: SAP_DPL TC T
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Use this mode for global configurations across all clients. Note that in this URL, you additionally
specify the scope parameter.

2. Configure the app tiles in the SAP Fiori launchpad designer.

->Tip

By default, the tiles for Manage Demand Influencing Factors and Demand Influencing Factors
Library are in the SAP: CAR — Demand Planning Apps catalog (which is shipped with launchpad
configuration).

If the app tile for Manage Demand Influencing Factors has not yet been created, create it as static tile
using the following settings:
Manage Demand Influencing Factors
o Title:Manage Demand Influencing Factors
© Jcon: sap-icon://create-entry-time
o Use semantic object navigation: Select this option.
o Semantic Object: ForecastDemand
o Action: manage
o Leave the other options empty.
Demand Influencing Factors Library
o Title:Demand Influencing Factors Library
O Jcon: sap-icon://FioriInAppIlcons/Hierarchical Tree
© Information: /DMF/DIF_LIBRARY
o Use semantic object navigation: Select this option.
o Semantic Object: ForecastDemand
o Action: change
o Leave the other options empty.
If you need more information about configuring tiles, see SAP Help Portal at https:/help.sap.com/

viewer/p/SAP_NETWEAVER and choose your SAP NetWeaver Platform. Select your support package
stack at the top right and search for “Static App Launcher Tiles".

. Configure the target mapping in the SAP Fiori launchpad designer.

If the target mapping has not yet been created, choose Target Mappings and create entries with the
following settings:
Manage Demand Influencing Factors

o Semantic Object: ForecastDemand

o Action: manage

o Application Type: SAP Fiori App using LPD_CUST

© Launchpad Role: UIDPL0O01

o Launchpad Instance: TRANSACTIONAL

o Application Alias: DIFManagement

o Device Types: Select Desktop and Tablet.

o Allow additional parameters: Select this option.
Demand Influencing Factors Library

o Semantic Object: ForecastDemand

o Action: change

o Application Type: SAP Fiori App using LPD_CUST
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o Launchpad Role: UIDPL0OO1
© Launchpad Instance: TRANSACTIONAL
o Application Alias: DIFLibrary
o Device Types: Select Desktop
o Allow additional parameters: Select this option.
If you need more information about configuring target mappings, see SAP Help Portal at https://
help.sap.com/viewer/p/SAP_NETWEAVER and choose your SAP NetWeaver Platform. Select your
support package stack at the top right and search for “Configuring Target Mappings”.
4. Complete the implementation on the front-end server.

i Note

You can find the general SAP Fiori Help section for this step at https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION [} Version: SAP NW 740 ¥ Implementation ¥ App Implementation ¥ App
Implementation for Analytical Apps ¥ Implementation Tasks on Front-End Server 3.

Use this section as your starting point. However, to configure Manage Demand Influencing Factors, you
only need to perform a subset of the steps described there. Proceed as follows:

1. Check that the app-specific Internet Communication Framework (ICF) service
ManageDemandInfluencingFactors /sap/bc/ui5 uib5/sap/managedifs is active. If the service is
not active, execute these steps:

1. Execute transaction SICF.
2. As Service Path, specify the <service path/service name> and execute the search.

3. As Virtual Hosts / Services, select the MANAGEDIFS entry and choose | Service/Host »
Activate .
For more information on how to activate ICF services and OData services, see | Implementation Tasks

on Front-End Server ¥ Front-End Server: Activate ICF Services of SAPUI5 Application 3.

2. Activate and Maintain OData Services
Call up transaction Activate and Maintain Services (/IWFND/MAINT SERVICE)and check if the

following services are already existing in your service catalog:
o Demand Plan OData Service
o Type:BEP
o Technical Service Name: zOD DEMAND PLAN SRV
o Service Description: Demand Plan OData Service
o External Service Name: OD_DEMAND PLAN SRV
o Namespace: /DMF/
If the service is not available, choose Add Service, enter back-end system alias, and choose Get
Services. Search for /DMF/0OD DEMAND PLAN SRV , select the entry and choose Add Selected
Services. Take over the provided data and enter the local package assignment.
o Demand Plan OData Service for Reuse
o Type:BEP
o Technical Service Name: ZDEMAND PLAN UTILITIES SRV
o Service Description: Demand Plan OData Service for Reuse
o External Service Name: DEMAND PLAN UTILITIES SRV

o Namespace: /DMF/
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If the service is not available, choose Add Service, enter back-end system alias, and choose Get
Services. Search for /DMF/DEMAND PLAN UTILITIES SRV, select the entry and choose Add
Selected Services. Take over the provided data and enter the local package assignment.
3. Copythe sap_DPL TCR_T PFCG role on the front-end server and enter a name from the customer
namespace. Assign the required launchpad catalogs and groups. SAP_DPL_TCR T is the front-end
server authorization role delivered for all demand planning apps in SAP Customer Activity Repository.

->Tip

If you already have an SAP Fiori launchpad open, clear your browser cache to apply the
modifications to your user roles. Otherwise, you cannot see the changes on the user interface.

Follow the steps in | Implementation Tasks on Front-End Server ¥ Create PFCG Role on Front-End and
Assign Launchpad Catalogs and Groups 3.

4. Set up the catalogs, groups, and roles in the SAP Fiori launchpad.

Follow the steps in |l Implementation Tasks on Front-End Server ¥ Setup of Catalogs, Groups, and Roles
in the SAP Fiori Launchpad 3.

5. Take the front-end PFCG role that you created before and assign it to the users of the app. The role
contains the catalogs, groups, and start authorizations for the OData service that the users need.
Follow the steps in | Implementation Tasks on Front-End Server ¥ Front-End Server: Assign Roles to
Users 3.

5. Complete the implementation on the back-end server.
Copy the Demand Planner (Retail) role (/DMF/DPL) in the Role Maintenance (PFCG) of the back-end server
and enter a name from the customer namespace. Assign the users. This role /DMF/DPL is the back-end
server authorization role delivered for accessing the Manage Demand Influencing Factors app.

6. (Optional) Assign area of responsibility.
This step is only required if you wish to use the Product Hierarchy filter in the app. In this case, each user of
the app must have an area of responsibility (AOR) assigned to their ABAP back-end user. This assignment
enables the display of product hierarchies in the app. You assign AORs using the Maintain Area of
Responsibility Web Dynpro service in DDF.
Follow the steps in the Maintain Area of Responsibility section under https://help.sap.com/viewer/p/

CARAB | <Version> » Application Help # SAP Customer Activity Repository » Demand Data Foundation
General Services » Maintenance Services 3.

7. (Optional) Set up Single Sign-On (SSO) between the front-end server and the back-end server.
For information on available SSO mechanisms depending on your system landscape, see the following:

o https:/help.sap.com/viewer/p/FIORI_IMPLEMENTATION | <Version> » SAP Fiori: Security » User
Authentication and Single Sign-On (SSO) 4

o https:/help.sap.com/viewer/p/SAP_HANA_PLATFORM |} <Version> » Security » SAP HANA Security
Guide » SAP HANA Authentication and Single Sign-On » Single Sign-On Integration 3

->Tip

If you encounter issues during the setup, see the Troubleshooting [page 154] section for possible solutions.
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Result

You have successfully set up the Manage Demand Influencing Factors app.

Related Information

Activate OData Services [page 91]

6.1.2.74  Set Up the Manage Product Attributes App

Perform several tasks on the front-end server and the back-end server to set up the Manage Product Attributes
app. This transactional app is delivered with SAP Customer Activity Repository and supports different
scenarios and consuming applications (such as SAP Allocation Management and SAP Assortment Planning).
The app enables planning administrators to create, configure, assign, and maintain product attributes for a
selected product hierarchy.

Prerequisites

® You are aware of the technical implementation information for the app in the SAP Fiori apps reference
library:
For the latest delivery (latest wave), see: https://fioriappslibrary.hana.ondemand.com/sap/fix/
externalViewer/index.html?appld=F0829A
® You have implemented any mandatory corrections for the app in the current release:
o For the app in SAP Customer Activity Repository 4.0 FPSO1, implement SAP Notes 2762819# and
2763472¢% . The notes are required for the new SAP_ ISR _BR_DDF ADMIN role, which is mandatory for
the app and which you will need in the steps below.

To set up the app, do the steps in the following sections.

i Note

If your scenario includes SAP Allocation Management or SAP Assortment Planning, some of the steps
might already have been performed in your system landscape. If so, skip the step and continue with the
next one.

Activate ICF Services

Context

For security reasons, the Internet Communication Framework (ICF) services are delivered in an inactive state.
In this procedure, you activate the services that are required for the app.
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Procedure

1. Logon to your front-end server.
2. Execute transaction sICF.

In the Define Services screen, make the following selections:

o Hierarchy Type: SERVICE

© Virtual Host: DEFAULT_HOST

o Service Path: /sap/bc/ui5_ui5/sap/attribmgmt v2/
4. Choose Execute ([r8]).

5. Under Virtual Hosts / Services, double-click the attribmgmt v2/ service to open the Create/Change a
Service screen.

6. To activate the service, choose | Service/Host » Activate 3.
i Note

You can check the activation status by selecting the service and opening the context menu. If the
Activate Service option is grayed out, this means the service is already active.

7. Repeat steps 3 to 6 for the /sap/be/ui5_ui5/sap/ddfreuse_v2/ service.

Enable the App for SAP Fiori Launchpad

Context

To be able to access the app from the SAP Fiori launchpad, your front-end system user must have the
necessary role(s) assigned. Based on the role(s) assigned to your user, you can access the business catalogs
and business catalog groups required for the app.

SAP Customer Activity Repository is delivered with the following predefined objects for the app:

Front-End Business Content Front-End Technical Content
Technical

Business Role Business Catalog Business Catalog Group Technical PFCG Role  Catalog
SAP_RAP BCR PLANN SAP RAP BC PLANNI SAP RAP BCG PLANNING ADM SAP RAP TCR T SAP_RAP TC
ING_ADMIN NG_ADMIN T IN T T
Procedure

1. Logon to your front-end system.

2. Execute transaction su01 to open the User Maintenance screen.

3. Enter your front-end user name in the User field and choose Change.

4. Onthe Roles tab, assign the following roles to your user:

O SAP RAP BCR_PLANNING ADMIN (Planning Administrator)
© SAP ISR BR DDF ADMIN (Demand Data Foundation Administrator)

5. Save your changes.
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A\ Caution

If you already have an SAP Fiori launchpad open, clear your browser cache or you won't be able to see
the changes.

6. Verify the app and role settings for the SAP Fiori launchpad.
1. Execute transaction LPD_CUST to open the Overview of Launchpads.
2. Double-click the role UTRAP001 to view the role details.
3. Expand the role Planning Administrator and select the Manage Product Attributes app.
4

. Display the advanced parameters and check that the app has all the mandatory settings listed below.
You do not need to make any additional settings.

o Link Text: Manage Product Attributes

o Application Type: URL

o URL:/sap/bc/uib ui5/sap/attribmgmt v2

o Application Alias: AssignProductAttribute

o Additional Information: SAPUI5.Component=retail.ddf.attributemgmtv2
o Navigation Mode: EXT HEAD Leaderless Portal Window

o History Mode: 1 Navigation Entry can Occur Once in History

o Parameter Forwarding: G Get Parameters

Activate OData Services

There are common OData services for SAP Fiori that must be activated for any scenario. (mandatory). Then
select the OData services for your specific application and activate those as well./DMF/API_ATTRIBUTES SRV
(optional, to import external attributes for integration scenarios with a third-party source master data system)

1. Follow the instructions in Activate OData Services [page 91].

Assign Area of Responsibility (AOR) to ABAP Back-End User

You can only display and select product hierarchies in the app that have been assigned as AOR to your ABAP
back-end user.

Log on to your ABAP back-end system.
Execute transaction NwBC to open the SAP NetWeaver Business Client.

1
2.
3. Choose||r Services » Maintain Area of Responsibility » Product Hierarchy 3.
4. Select your ABAP back-end user, choose Continue, and define the AOR.
For instructions, see the Maintain Area of Responsibility section in the application help for SAP Customer
Activity Repository at https:/help.sap.com/viewer/p/CARAB.

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
Set Up the Applications PUBLIC 129


https://help.sap.com/viewer/p/CARAB

6.1.2.75 Set Up Additional Standalone Apps Included in
SAP Customer Activity Repository

In addition to the apps described in this guide, SAP Customer Activity Repository includes additional apps that
support different scenarios and consuming applications.

For information on the additional apps, see SAP Note 2774098 ¥ .

6.1.2.8 Configure Omnichannel Article Availability and
Sourcing for Use with SAP Customer Activity
Repository

You need to integrate SAP S/4HANA or SAP Retail, SAP Customer Activity Repository, SAP Commerce, and
SAP Commerce, integration package for SAP for Retail, as well as set up asynchronous order management and
the data replication between SAP S/4HANA or SAP Retail, SAP Commerce, and SAP Customer Activity
Repository.

6.1.2.8.1 Set up Data Replication Between SAP S/4HANA
or SAP Retail, and SAP Commerce

In SAP S/4HANA or SAP Retail, and SAP Commerce, set up the asynchronous order management scenario
as follows:

1. Set up asynchronous replication of articles via the Data Hub from SAP S/4HANA or SAP Retail to SAP
Commerce.
For more information, see the documentation for SAP Commerce at https://help.hybris.com/latest/hcd/
8bc6b884866910148532f2e1e500f95f. html Getting Started with SAP S/4HANA or SAP ERP Integration.
Follow the steps for the asynchronous order management scenario.

2. Setup asynchronous replication of orders via the Data Hub from SAP Commerce to SAP S/4HANA or
SAP Retail (see link above).

3. Configure asynchronous order management.
For more information, see the documentation for SAP Commerce at https://help.hybris.com/latest/hcd/
e2beb57ab501dadlccOebdf7cf7d3aa229.html Configuring Order Management for SAP Commerce with One or
More SAP Back Ends.

6.1.2.8.2 Set Up Data Replication Between SAP Commerce
and SAP Customer Activity Repository

1. In SAP Commerce, in the Backoffice application under |» SAP Integration » HTTP Destination i, create the
HTTP destination of SAP Customer Activity Repository that is used for availability calculation and sourcing.
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2. In SAP Commerce, in the Backoffice application under |+ SAP Integration » SAP Global Configuration
Backend Connectivity 3, enter the HTTP destination of SAP Customer Activity Repository created before.

i Note

In the standard Solr configuration for products in SAP Commerce, ProductStoreStockValueProvider
is used to replicate the store availability situation from the SAP Commerce database into the Solr index.

If you use OAA, availability information is provided through synchronous calls into SAP Customer Activity
Repository for every article/store combination instead. If your product catalog is rather large, this is why
indexing the complete product catalog can take very long. In this case, we recommend to either deactivate
the value provider or to create a custom one. If you deactivate the value provider, faceted search according
to store availability is not possible in the product catalog. OAA functionality is not affected.

6.1.2.8.3 Set Up Live Connection Between SAP Customer
Activity Repository and SAP Analytics Cloud

This step is optional. You only need to execute it if you want to use the set of OAA analyses that has been
predefined in SAP Analytics Cloud and that is part of the standard delivery of SAP Analytics Cloud. If you are
using a different analytics tool, or if you do not run analytics at all, you may skip this step.

Context

Procedure

1. Configure SAP Customer Activity Repository to support cross-origin resource sharing (CORS), for cross-
domain communication from the browser.

For more information, see Live Data Connection to SAP BW Using a Direct Connection and Password
Authentication, steps 1 and 2 of the procedure.

2. In SAP Analytics Cloud, navigate to [ Home # Connection 3 and select live connection SAPRTOAR (SAP
Retail Omnichannel Article Availability and Sourcing). This connection is part of the standard delivery.
3. Click Edit Connection and enter your custom details for Host, HTTPS Port, and Client.
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6.1.2.8.4 Activate OData Services for Omnichannel Article
Availability and Sourcing

A number of OData services are required to run the SAP Fiori apps for omnichannel article availability and
sourcing (OAA).

Context

Make sure that you have activated the OData services required for OAA, as described and listed in Activate
OData Services [page 91]. Depending on your back end, different services are required.

6.1.2.9 Configure Omnichannel Promotion Pricing for Use
with SAP Customer Activity Repository

1. In Customizing for SAP Customer Activity Repository under | Omnichannel Promotion Pricing ¥ Configure
Omnichannel Promotion Pricing 3, activate and configure omnichannel promotion pricing.

Optional: If you want to use Product Groups instead of Simple Product Groups (default), you have to do the
following:

In Customizing for SAP Customer Activity Repository under | Omnichannel Promotion Pricing (OPP)
Configure Omnichannel Promotion Pricing 3 set the indicator Activate Enhanced Product Groups.
Additionally, you have to activate product groups for the promotion pricing service. For more information
about the configuration of product groups, see the Development and Extension Guide for OPP on SAP Help
Portal at https://help.sap.com/viewer/p/CARAB |F <Version> » Development ¥ Development and
Extension Guide for Omnichannel Promotion Pricing 3 under |+ » Promotion Pricing Service » PPS Module
calcengine-gk ¥ Default Settings and Properties 3.

2. Intransaction SFW5, activate business function DRF_FOUNDATION.

This activates the Data Replication Framework (DRF) functionality. You need DRF to send regular prices
and OPP promotions to an external system via IDocs.

3. In Customizing for SAP Customer Activity Repository under |» Omnichannel Promotion Pricing (OPP) »
Define Number Ranges 1, you can maintain a number range interval for OPP promotions outbound
processing.

4. To use the central promotion pricing service, you have to install the XS Advanced (XSA) as Java runtime.
For information about the installation of the XS Advanced runtime, see the SAP HANA Server Installation
and Update Guide on SAP Help Portal at https://help.sap.com/viewer/p/SAP_HANA_PLATFORM
|» <Version> ¥ Installation and Upgrade » SAP HANA Server Installation and Upgrade » Installing an SAP

HANA System ¥ Installing XS Advanced Runtime 3.

- Tip

For more information about the configuration of the promotion pricing service in SAP Commerce, see the
Administrator Guide of SAP Commerce, integration package for SAP for Retail on SAP Help Portal under
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Configuration 3.

Related Information

Outbound Processing for Regular Prices and OPP Promotions [page 133]
Central Deployment of the Promotion Pricing Service [page 146]
Update the PPS XSA Application

6.1.2.9.1 Outbound Processing for Regular Prices and OPP
Promotions

Related Information

Local Deployment of the Promotion Pricing Service [page 133]
Location-Specific Outbound Processing of OPP Promotions [page 141]

6.1.2.9.1.1 Local Deployment of the Promotion Pricing Service

For a local deployment scenario, you have to replicate regular prices and OPP promotions from the central
price and promotion repository (SAP Customer Activity Repository) to an external system to create a local
storage for prices and promotions. For that, you have to configure application link enabling (ALE) for the
distribution of IDocs, and Data Replication Framework (DRF). For OPP promotions, there are two options to
configure this replication: the promotion-centric outbound processing and the location-specific outbound
processing.

Prerequisites

® You have performed the configuration steps during post-installation. For more information, see Configure
Omnichannel Promotion Pricing for Use with SAP Customer Activity Repository [page 132].
® You have defined receiving systems and clients in the system landscape directory (SLD).
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Application Link Enabling

In Customizing for SAP NetWeaver, under | Application Server » IDoc Interface / Application Link Enabling

(ALE) 73, see the system documentation to check the settings for distributing data between application
systems based on Application Link Enabling and IDoc interface technology. With omnichannel promotion
pricing, this functionality is used to distribute OPP promotions and regular prices from SAP Customer Activity
Repository to an external system, for example an SAP Commerce system. You need to perform the following
steps:

Transaction Bp54: Defining a Logical System

With ALE IDoc distribution, you can exchange data between logical systems. You use the logical system name
to identify a system uniquely within the network. If you already use ALE IDoc distribution, the logical system for
the sending system has already been defined. In this case, you only need to define a logical system for the
receiving system. In SAP Customer Activity Repository, do the following:

In Display View "Logical System": Overview, create a new logical system. Enter the following values:

Field Name Value
Log. System <receiving system>
Name <receiving system>

Transaction sm59: Defining an RFC Destination

1. Create the RFC destination in the HTTP Connections to External Server folder and enter the following

values:
Field Name Value
RFC Destination <name of the RFC destination>
Connection Type Enter connection type G HTTP Connection to External
Server.
Description Enter at least Description 1 in the description section.

2. In Technical Settings, enter the following values for Target System Settings:

Field Name Value
Target Host <name of the target host>
Path Prefix /sapppspricing/idocinbound
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Field Name Value

Port <service number for https or http

connection>

i Note

With OPP, an https connection is recommended.

3. InLogon and Security, select Basic Authentication for Logon with User, and enter the following values:

Field Name Value

User <user name that you have created in SAP

Commerce Backoffice>

Password <password that you have created in SAP

Commerce Backoffice>

In Security Options select SSLActive to send your data via https connection and enter an appropriate
certificate.

i Note
We strongly recommend to use Secure protocols (SSL, SCN) whenever possible.

For more information, see Transport Layer Security and Web Services Security in the SAP NetWeaver
Security Guide.

Transaction we21: Defining a Port

1. Create this ALE port in the XML HTTP folder and enter the following values:

Field Name Value

Port <name of port>

Description <description of port>

RFC destination <name of the RFC destination created in

the previous step>

2. Select Text/XML for Content Type.

Transaction we20: Defining a Partner Profile

A partner profile contains parameters that define the electronic interchange of data between systems using the
IDoc interface. There is only one partner profile required for the receiving system and it needs to contain all the
parameters that your scenario requires for sending OPP promotions and regular prices to that receiving
system.
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Basic Partner Profile Information

To set up the basic partner profile information, do the following:

1. InPartner Profiles, create a logical system partner. Enter the following values:

Field Name Value

Partner No. <partner number>, which must be the same as the receiving system that you

defined in section Defining a Logical System

Partner Type LS for regular prices and OPP promotions sent via promotion-centric outbound

processing

2. Inthe Post processing: permitted agent tab, enter the following values:

Field Name Value

Ty. US (for User)

Agent <users to be notified> should be an agent who can process IDocs with
errors

Lang. <notification language>

Outbound Parameters

Field Name Value

Message Type ® /ROP/BASE_PRICE for regular prices

® /ROP/PROMOTION for OPP promotions

Outbound Options tab
Receiver port <receiver port> as definedin section Defining a Port
Output Mode ® Pass|Doc Immediately
o Select this option to transfer IDocs directly after creation for a better integra-
tion to the DRF transfer log.
o Select this option to make sure that IDocs are sent in the same order in
which they have been created.
e Collect IDocs
o Select this option to collect IDocs and transfer them sequentially with trans-
action WE14.
IDoc Type ® /ROP/BASE PRICEO1 for regular prices

® Depending on the receiving system /ROP/PROMOTIONO1 or /ROP/PROMOTIONO2
for OPP promotions
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Field Name Value

Cancel Processing After Syntax Ensure that this field is selected to avoid sending erroneous IDocs.

Error

Data Replication Framework

In Customizing for Cross-Application Components under |+ Processes and Tools for Enterprise Applications

Master Data Governance, Central Governance » General Settings » Data Replication » Overall Information 7,
see the system documentation to check how data is sent to one or more target systems. With OPP, the Data

Replication Framework functionality is used to send regular prices and OPP promotions from an SAP Customer

Activity Repository system to external systems. You need to perform the following steps:

Transaction prrimc: Defining Custom Settings for Data Replication

In Customizing, you have to perform the following configuration steps under |» Data Replication » Define

Custom Settings for Data Replication 3:

1. In Customizing activity Define Technical Settings for Business Systems, define a business system and a
logical system for the receiving systems. The following business object types are available to send OPP
promotions and regular prices, and can be assigned to the business system:

Business Object Type Description Communication Channel
ROP_PROMO OPP promotion Replication via IDoc
ROP_PRICE Regular price Replication via IDoc

2. In Customizing activity Define Replication Models, specify the content of the replication model (regular

prices or OPP promotions), the outbound implementation that is to be used, and the business system to

which this object is to be sent. You can specify a different destination system for each outbound
implementation that contains business object, filter object, and business logic. You can also add an
expiration time for the log. The following predefined outbound implementations exist:

Outbound Imple- Supported Replication

mentation Description Model Filter Object

ROP_PRICE Outbound implementation Initialization, Change, and ROP_PRICE
for regular prices Manual

i Note

For this outbound implementa-

tion, the filter application time
needs to be set to Filter Before
Change Analysis.
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Outbound Imple- Supported Replication
mentation Description Model Filter Object

ROP_PROMO Outbound implementation Initialization, Change, and ROP_PROMO
for OPP promotions sent Manual
via promotion-centric out-
bound processing

Outbound Parameters
The following outbound parameters must be assigned to each replication model:

Outbound Parameter for
Regular Prices Description Typical Value*

/ROP/PACK_SIZE_BULK This parameter sets the maximum number of regular prices that  20,000-100,000
are processed per IDoc. This is an approximate value because
regular prices are assigned to different IDocs for each group of
business unit with items and prices.

i Note

If this parameter is set to O, restricting regular prices is not
possible and it is only the number of products that deter-
mines the IDoc size.

PACK_SIZE_ BULK This parameter controls the number of products for which regu-  200-1,000
lar prices can be stored in a compressed format at the same
time, and sets the maximum number of products that are proc-
essed per IDoc.

i Note

If this parameter is not set, the default is 1. If you increase
this value, performance at runtime is improved since fewer
IDocs need to be processed.

TASK_SIZE PROCMSG This parameter is only relevant if you execute the data replication 400-2,000
using parallel processing . This parameter sets the maximum
number of products that are processed per parallel package. It
must be greater or equal to the PACK_SIZE BULK parameter.

i Note

This parameter value does not define the number of regular

prices per package. If this parameter is set to O, all products

are processed in one package. This means that parallel proc-
essing is not possible.
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Outbound Parameter for
Regular Prices

Description

Typical Value*

/ROP/SEQ READ SIZE

This parameter sets the maximum number of products for which
the regular prices are read in one select statement. In this way
you can limit memory consumption for products with a large
number of regular prices.

i Note

If this parameter is set to O, all products of the correspond-
ing package are read within one call.

100-200

/ROP/DAY OFFSET PAST

This parameter is only used, if the selection of prices in the past
is restricted with the validity end date as a filter criteria and if the
validity end date is not too far in the past.

During a delta replication, this parameter defines a time range in
days that lies before the date of the last replication run. The sys-
tem subtracts this value from the last replication date and uses
the resulting date to construct the select-option for the validity
end date.

During an initial replication the system calculates a date (current
date minus the time range in days defined in this parameter). If
the date that you entered for the validity end is earlier than the
calculated date, the calculated date is used automatically.

In this way you ensure that also regular prices with a validity end
date in the specified past time range are transferred.

i Note

If this parameter is not set, relevant regular prices might not
be transferred. See SAP Note 2338714 % . In this case the
default is set to 30 days.

30

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0

FPSO1
Set Up the Applications

PUBLIC

139


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2338714

Outbound Parameter for
OPP Promotions

Description Typical Value*

PACK SIZE BULK

This parameter sets the maximum number of OPP promotions ~ 100-1,000
that are processed per IDoc. It must be smaller than the
TASK SIZE PROCMSG parameter and is relevant for both, the se-

quential and the parallel execution of DRF outbound.

i Note

If this parameter is not set, the default is 1. If you increase
this value, performance at runtime is improved since fewer
IDocs need to be processed.

TASK_SIZE_PROCMSG

This parameter is only relevant with parallel processing . It sets 100-5,000
the maximum number of OPP promotions that are processed

per parallel package. It must be greater or equal to the

PACK SIZE BULK parameter.

i Note

This parameter value does not define the number of OPP
promotions per package. If this parameter is set to O, inde-
pendently of the value that you enter in transaction
DRFOUT, parallel processing is not possible.

/ROP/Generic_ENH MAP

This parameter activates the automatic mapping of customer- X
specific fields that are stored in the Cl-Inlcudes of promotional
entities to the corresponding extension segments in the OPP
promotion IDocs.

i Note

Internal tables, structures, and so on, are not supported.

*This value gives you an idea of usable values for the replication of regular prices and OPP promotions, it is

not a recommendation.

3. Optional: In Customizing activity Define Business Object Settings, specify the application link enabling
(ALE) message type that is to be used for each business object. In this way, you can determine the
retention period for change pointers that are related to the business object. For the outbound processing of
regular prices, no change pointers are used and the retention period is not relevant. The following message
types are relevant for the outbound processing of regular prices and OPP promotions from the central
price and promotion repository:

Business Object Type

Message Type

ROP_PRICE

/ROP/BASE_PRICE
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Business Object Type Message Type

ROP_PROMO /ROP/PROMOTION

For more information, see Customizing for Cross Application Components under | Processes and Tools for
Enterprise Applications » Master Data Governance, Central Governance j» General Settings » Data
Replication ¥ Overall Information 3.

Transaction prrr: Defining Filter Criteria

In Define Filter Criteria, specify your data selection for each replication model and business object. The filter
criteria are valid for Initial replication and Change replication.

6.1.2.9.1.2 Location-Specific Outbound Processing of OPP
Promotions

The location-specific outbound processing of OPP promotions enables you to distribute a location-specific
view of OPP promotions. With this outbound option OPP promotions are sent from the central price and
promotion repository to its assigned locations. You can use this option if you, for example, want to send OPP
promotions to POS systems in your physical stores. This section describes how to configure the Application
Link Enabling (ALE) layer and Data Replication Framework (DRF) for the sending of IDocs.

Prerequisites

® You have performed the configuration steps during post-installation. For more information, see Configure
Omnichannel Promotion Pricing for Use with SAP Customer Activity Repository [page 132].

® You have defined receiving systems and clients in the system landscape directory (SLD).

Application Link Enabling

In Customizing for SAP NetWeaver, under | Application Server ¥ IDoc Interface / Application Link Enabling

(ALE) 7, see the system documentation to check the settings for distributing data between application
systems based on Application Link Enabling and IDoc interface technology. With omnichannel promotion
pricing, this functionality is used to distribute OPP promotions and regular prices from SAP Customer Activity
Repository to an external system, for example an SAP Commerce system. You need to perform the following
steps:

Transaction sm59: Defining an RFC Destination

For each receiving system that initially receives the created IDocs, you have to create an RFC destination. If you
use a middleware, this RFC destination refers to the host in which the middleware is running, If you use a 1:1
connection, all receiving systems require a separate RFC destination. The attributes of the RFC destination are
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determined by the receiving system. In the following we assume that we want to setup a location-specific
outbound processing to a local promotion pricing service in a SAP Commerce system that is directly
connected to the SAP Customer Activity Repository.

1. In Technical Settings, enter the following values for Target System Settings:

Field Name Value
Target Host <name of the target host>
Path Prefix /sapppspricing/idocinbound
Port <service number for https or http
connection>
i Note

With OPP, an https connection is recommended.

2. InLogon and Security, select Basic Authentication for Logon with User, and enter the following values:

Field Name Value

User <user name that you have created in SAP

Commerce Backoffice>

Password <password that you have created in SAP

Commerce Backoffice>

In Security Options select SSLActive to send your data via https connection and enter an appropriate
certificate.

i Note
We strongly recommend to use Secure protocols (SSL, SCN) whenever possible.

For more information, see Transport Layer Security and Web Services Security in the SAP NetWeaver
Security Guide.

Transaction we21: Defining a Port

1. Create this ALE port in the XML HTTP folder and enter the following values:

Field Name Value
Port <name of port>
Description <description of port>
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Field Name Value

RFC destination <name of the RFC destination created in

the previous step>

2. Text/XML.

Transaction we20: Defining a Partner ProfileSelect a content type supported with the
receiving system. If you configure a local promotion pricing service choose

A partner profile contains parameters that define the electronic interchange of data between systems using the
IDoc interface. There is only one partner profile required for the receiving system and it needs to contain all the
parameters that your scenario requires for sending OPP promotions and regular prices to that receiving
system.

Basic Partner Profile Information
To set up the basic partner profile information, do the following:

1. InPartner Profiles, create a logical system partner. Enter the following values:

Field Name Value

Partner No. External ID of the receiving DDF location

Partner Type LO for OPP promotions replicated via location-specific outbound processing
i Note

For this partner type, only the first 10 characters of the DDF location ID are taken into account, the
location type and logical system are ignored. If you want to use a different logic, use transaction we44
to define a different partner type or to change the validation logic.

Select a content type supported with the receiving system. If you configure a locallf you need a
different implementation of BAdl /ROP/PROMO STORE OUTBOUND, see Customizing for SAP Customer
Activity Repository and choose [ Omnichannel Promotion Pricing (OPP) ¥ Business Add-Ins (BAdls)
Outbound Processing of OPP Promotions # BAdI: Location-Specific Outbound Processing 4.

2. Inthe Post processing: permitted agent tab, enter the following values:

Field Name Value

Ty. US (for User)

Agent <users to be notified>, which should be an agent who can process IDocs
with errors.

Lang. <notification language>

Outbound Parameters
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Field Name Value

Message Type /ROP/PROMOTTON for OPP promotions

Outbound Options tab

Receiver port <receiver port> as definedin section Defining a Port
Output Mode ® Pass|Doc Immediately

o Select this option to transfer IDocs directly after creation for a better integra-
tion to the DRF transfer log.
o Select this option to make sure that IDocs are sent in the same order in
which they have been created.
e CollectDocs
o Select this option to collect IDocs and transfer them sequentially with trans-

actionWE14.

IDoc Type Depending on the receiving system /ROP/PROMOTIONO1 Or /ROP/PROMOTIONO2 for

OPP promotions

Cancel Processing After Syntax Ensure that this field is selected to avoid sending erroneous IDocs.

Error

Data Replication Framework

In Customizing for Cross-Application Components under |» Processes and Tools for Enterprise Applications ¥

Master Data Governance, Central Governance » General Settings # Data Replication » Overall Information 3,
see the system documentation to check how data is replicated to one or more target systems. With OPP, the
Data Replication Framework functionality is used to send regular prices and OPP promotions from an SAP
Customer Activity Repository system to external systems. You need to perform the following steps:

Transaction prrimc: Defining Custom Settings for Data Replication

In Customizing, you have to perform the following configuration steps under | Data Replication » Define
Custom Settings for Data Replication 3:

1. In Customizing activity Define Technical Settings for Business Systems, define a business system and a
logical system for the receiving systems. The following business object types are available to replicate OPP
promotions and regular prices, and can be assigned to the business system:

Business Object Type Description Communication Channel

ROP_PRO_ST Location-specific outbound process-  Replication via IDoc
ing of OPP promotions

2. In Customizing activity Define Replication Models, specify the content of the replication model (regular
prices or OPP promotions), the outbound implementation that is to be used, and the business system to
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which this object is to be sent. You can specify a different destination system for each outbound
implementation that contains business object, filter object, and business logic. You can also add an
expiration time for the log. The following predefined outbound implementations exist:

Outbound Imple- Supported Replication
mentation Description Model Filter Object
ROP_PRO_ST Outbound implementation Initialization, Change, and ROP_PRO_ST

for OPP promotions sent Manual
via location-specific out-
bound processing

Outbound Parameters
The following outbound parameters must be assigned to each replication model:

Outbound Parameter for
OPP Promotions Description Typical Value*

PACK SIZE BULK This parameter sets the maximum number of OPP promotions ~ 100-1,000
that are processed per IDoc. It must be smaller than the
TASK SIZE PROCMSG parameter and is relevant for both, the se-
quential and the parallel execution of DRF outbound.

i Note

If this parameter is not set, the default is 1. If you increase
this value, performance at runtime is improved since fewer
IDocs need to be processed.

TASK_SIZE PROCMSG This parameter is only relevant with parallel processing . It sets 100-5,000
the maximum number of OPP promotions that are processed
per parallel package. It must be greater or equal to the
PACK SIZE BULK parameter.

i Note

This parameter value does not define the number of OPP
promotions per package. If this parameter is set to O, inde-
pendently of the value that you enter in transaction
DRFOUT, parallel processing is not possible.
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Outbound Parameter for
OPP Promotions Description Typical Value*

/ROP/Generic_ ENH MAP This parameter activates the automatic mapping of customer- X
specific fields that are stored in the Cl-Inlcudes of promotional
entities to the corresponding extension segments in the OPP
promotion IDocs.

i Note

Internal tables, structures, and so on, are not supported.

*This value gives you an idea of usable values for the replication of regular prices and OPP promotions, it is
not a recommendation.

3. Optional: In Customizing activity Define Business Object Settings, specify the application link enabling
(ALE) message type that is to be used for each business object. In this way, you can determine the
retention period for change pointers that are related to the business object. For the outbound processing of
regular prices, no change pointers are used and the retention period is not relevant. The following message
types are relevant for the outbound processing of regular prices and OPP promotions from the central
price and promotion repository:

Business Object Type Message Type
ROP_PRICE /ROP/BASE_PRICE
ROP_PROMO /ROP/PROMOTION

For more information, see Customizing for Cross Application Components under | Processes and Tools for
Enterprise Applications » Master Data Governance, Central Governance i General Settings » Data
Replication ¥ Overall Information 3.

Transaction prrr: Defining Filter Criteria

In Define Filter Criteria, specify your data selection for each replication model and business object. The filter
criteria are valid for Initial replication and Change replication.

6.1.2.9.2 Central Deployment of the Promotion Pricing
Service

The promotion pricing service (PPS) is an SAP HANA XS advanced (XSA) application. Therefore the
configuration of, for example, database services and back-end connection information, is done before or during
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the deploy time. The needed configuration settings are provided via command line interface, or in an extension
descriptor file.

Prerequisites

® You have installed SAP HANA XSA version 1.0.88 or higher.

® You have access to the XSA command-line tool version 1.0.82 or higher.

® Your SAP HANA XSA user has the user parameter XS CONTROLLER ADMIN assigned.
® Your SAP HANA XSA user has the user parameter XS USER ADMIN assigned.

® You have downloaded the SCV file XSACOPPPPS02 <patch level>.zIP (for example patch level 0 for
the initial delivery) for the PPS from the SAP Support Portal at https:/support.sap.come.

For more information about SAP HANA XS advanced, see the SAP HANA Developer Guide for SAP HANA XS
Advanced Model on SAP Help Portal at https://help.sap.com/viewer/product/SAP_HANA_PLATFORM/

|» <Version> ¥ Development » SAP HANA Developer Guide 3.

For more information about the installation of SAP HANA XS advanced, see the SAP HANA Server Installation
and Update Guide on SAP Help Portal at https://help.sap.com/viewer/product/SAP_HANA_PLATFORM/

|» <Version> ¥ Installation and Upgrade » SAP HANA Server Installation and Upgrade Guide ¥ Installing an SAP
HANA System ¥ Installing XS Advanced Runtime 3.

Used XSA Services

The PPS application uses the following XSA services:

Service Instance Service Plan Resource Type Description

ppeHANA User-defined n/a org.cloudfoundry.exist- Service to acess the
ing-service database.

ppServiceUaa Xsuaa space com.sap.xs.uaa-space Service for for authen-

tication and authoriza-
tion services.

Plan space allows the
installation of the PPS
app in different XSA
spaces.

ppServiceAuditLog auditlog free com.sap.xs.auditlog Audit log broker on the
XSA platform.

i Note

The services ppServiceUaa and ppServiceAuditLog are created and bound automatically during the
installation of the PPS application.
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Creating the Database Service

To make the promotion pricing service run, you have to create the database service ppeHana. To do so, you
have to execute the following xs command:

=, Source Code

xs create-user-provided-service ppeHana -p "{\"user\":\"<DB USER>\",\"password
\":\"<DB USER PASSWORD>\",\"url\":\"jdbc:sap://<HOSTNAME>:<PORT>\",\"driver\":
\"com.sap.db.jdbc.Driver\", \"port\": \"<PORT>\", \"host\":\"<HOSTNAME>: <PORT>

\n } "

Adjust the entries in angle brackets (<...>) in the command line:

Entry Comment

<DB_USER> Replace this entry with a valid database user of your SAP
Customer Activity Repository system.

<DB_USER_PASSWORD> Replace this entry with the password of your database user
(in clear text) in your SAP Customer Activity Repository sys-
tem.

<HOSTNAME> Replace this entry with the database host name of your SAP

Customer Activity Repository system.

<PORT> Replace this entry with the database port of your SAP
Customer Activity Repository system.

i Note

When you have created the database service, clear the command history to prevent unauthorized
disclosure of the password.

For more information about security, see the Administration Guide on SAP Help Portal at https://
help.sap.com/viewer/product/CARAB/ under |+ <Version> » SAP Customer Activity Repository <Version>
Administration Guide » Security Information » Security for Omnichannel Promotion Pricing Using SAP HANA XS
Advanced .

Creating the Extension Descriptor File

1. Create a text file with suffix .mtaext, for example config-op.mtaext.

2. To create the extension descriptor file, copy the following content to the new file that you have created in
step 1

i Note

This content includes the minimum settings that are necessary to create the extension descriptior file.
Specific configuration settings, for example settings for caching, can be added to this file as required.
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=, Source Code

_schema-version: "2.0.0"
ID: com.sap.retail.ppservice.XSAC OPP PPS
extends: com.sap.retail.ppservice.XSAC OPP_PPS

modules:
- name: ppservice-approuter
parameters:

memory: 128M
- name: ppservice-webapp-central

parameters:
memory: 1024M
properties:
DISABLE SUCCESSFUL LOGIN AUDIT LOG: "<AUDIT LOG FLAG>"
JBP_CONFIG RESOURCE CONFIGURATION: "['tomcat/webapps/ROOT/WEB-INF/
classes/ppe-schema-orm.xml': {'sap.dataaccess-

common.schema':'<DB SCHEMA>'}, 'tomcat/webapps/ROOT/META-INF/context.xml':
{'ppeHana-service-name': 'ppeHana'}]"
JBP_CONFIG JAVA OPTS: 'java opts: -Dsap.dataaccess-
common.db.client="<DB CLIENT>" -Dsap.dataaccess-common.logSys=<LOGSYS>'
provides:
- name: java

i Note

This configuration is written in YAML format. Make sure that you copy the format of the code block
correctly.

3. Adjust the entries in angle brackets (<...>) in the file:

Entry Comment

<AUDIT_LOG_FLAG> If you set this flag to true, the system only creates audit
log messages for failed login attempts. If set to false, every
login is recorded. This is of limited use for an A2A commu-
nication. To achieve optimal performance, SAP recom-
mends to set this flag to true.

<DB_SCHEMA> Replace this entry with the database schema of your SAP
Customer Activity Repository system.

<DB_CLIENT> Replace this entry with the client of your SAP Customer
Activity Repository system.

<LOGSYS> Replace this entry with the logical system ID of your mas-
ter data system that is connected to your SAP Customer
Activity Repository client.

If you want to support multiple master data systems in
your SAP Customer Activity Repository client, you need
different promotion pricing services for each system.
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i Note

If you need higher values for memory settings, especially for ppservice-webapp-central, you can
choose larger cache sizes.

Assuming that your extension descriptor file is called config-op.mtaext and that the command is called
from the directory in which your extension descriptor file is stored, execute the following command to
install the application:

=, Source Code

xs install <pathToScvFile>/XSACOPPPPS<software component version>.ZIP -e
config-op.mtaext

Save the extension descriptor file for later update or patch activities.

i Note

If you want to reinstall the same software component version, add the following parameter to the install
command -o ALLOW_SC_SAME VERSION.

For more information about possible additional parameters, see the documentation of this install
command.

Configuring Authentication and Authorization Settings

To secure access to the promotion pricing service, you have to configure users and roles in SAP HANA user and
role management.

For more information about the XSA security concept, see the SAP HANA Administration Guide on SAP Help
Portal at https://help.sap.com/viewer/product/SAP_HANA_PLATFORM/ | <Version> ¥ Administration  SAP
HANA Administration Guide » Application Run-Time Services » Maintaining the SAP HANA XS Advanced Run
Time Model » Setting Up Security Artifacts 3.

Creating SAP HANA Users

This section describes how to create the SAP HANA users that you need for the authentication configuration of
the XSA server:

1.
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A system/admin user
Contact your system administrator to create this user.

. A user for the XSA user management

Use the system/admin user created in step 1to create the corresponding SAP HANA user. This user needs
the System Privileges USER ADMIN and ROLE ADMIN and the Granted Role sap.hana.ide.roles:
SecurityAdmin. You can create this user, for example, via the SAP HANA Studio.

A user for the application role management

Use the XSA user management user created in step 2 to create the corresponding role builder user. The
application role management user needs the Application Role Collections XS_AUTHORIZATION ADMIN and
XS _USER_ADMIN. You can assign these parameters with the user for XSA user management created in
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step 2 via xs commands (as descibed below in step 6 of the section Creating and Assigning a Role
Collection) or via the XSA Cockpit.

For more information, see the documentation of the following xs command (this command lists all
available xs commands):

=, Source Code

xs help-a

or the SAP HANA Administration Guide at https://help.sap.com/viewer/product/SAP_HANA_PLATFORM/
|» <Version> » Administration » SAP HANA Administration » Application Run-Time Services » Maintaining
the SAP HANA XS Advanced Model Run Time » Maintaining the XS Advanced Run Time Environment with

Graphical User Interface 3.

Creating and Assigning a Role Collection

This section describes how to define a role for the central promotion pricing service (ppservice-webapp-
central application) using the role builder.

For more information about building roles, see the SAP HANA Administration Guide, at https://help.sap.com/
viewer/product/SAP_HANA_PLATFORM/|p <Version> » Administration » SAP HANA Administrator Guide ¥
Application Run-Time Services ¥ Maintaining the SAP HANA XS Advanced Model Run Time ¥ Building Roles for
SAP HANA XS Advanced Model Applications 3.

1. Create arole collection for the promotion pricing service with the following xs command:
=, Source Code

xs create-role-collection <NAME> [<DESCRIPTION>]
e.g., Xs create-role-collection PPE ROLE COLLECTION "PPE ROLE COLLECTION"

2. Navigate to the space where the PPS has been installed with the following xs command:
‘=, Source Code

xs target-s <SPACE NAME>

3. Checkif the role template ppservice-webapp-central is listed in the space with the following xs
command:

=, Source Code

xs role-templates

If the installation has been successful, this role template must be listed in this space.
4. Create arole with the PPS role template:

=, Source Code

Xxs create-role <APP> <ROLE TEMPLATE> <ROLE NAME> <DESCRIPTION>
e.g., Xs create-role ppservice-webapp-central PPE ROLE TEMPLATE
PPE ROLE XYZ "PPE role for xyz"
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5. Add the new role to the new role collection:

=, Source Code

xs update-role-collection <ROLE COLLECTION> --add-role <ROLE>
e.g., xXs update-role-collection PPE ROLE COLLECTION --add-role PPE ROLE XYZ

6. Assign the new role collection to a SAP HANA (XSA) user of your choice:

=, Source Code

xs assign-role-collection <ROLE COLLECTION> <USER>
€.g., Xs assign-role-collection PPE ROLE COLLECTION PPSUSER

->Tip
You can call xs help -a to get an overview of other xs commands regarding role management.

7. With a REST Client, verify that the promotion pricing service user that you have created in the prior step is
working. For this, you have to set the following parameters in your REST Client (like Postman for Chrome):
o Request method = POST
o Authorization
o Type = Basic Authentication
o User name = <name of the user created in prior step>
o Password = <password of the user created in prior step>

i Note

If your password policy prompts users to change their password when they log on to the
system for the first time, this needs to be done before a request is sent via Rest Client.

o Headers
o Accept = application/xml
o Content-Type = application/xml
o URL
o Callthe command xs apps and check for the URL of the ppservice-approuter app.
© You can use this URL in a browser to import or download the corresponding certificate to your
REST Client.
o Append /restapi/ to the URL and enter this information in your REST Client.
o Body = <PriceCalculate xmIns="http://www.sap.com/|XRetail/namespacefs/"/>

If you send this request, you get HTTP response code 400 (Bad Request) because you send an empty request
body.

If you receive HTTP response code 401 (Unauthorized) or 403 (Forbidden), there is something wrong with your
service user, or application. Double-check all steps that you have performed in this chapter.
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Additional Configuration Settings (Optional)

There are a lot of settings that are not mandatory in a default case. However, they provide facilities to adapt the
promotion pricing service to your specific needs.

Configuration of Caches

By default, all database accesses to OPP promotion and regular price entities are cached. For this, you can use
the following two types of caches:

Object cache based on JPA

In this case, OPP promotions and their child entities (price rules, texts, and so on) are stored in the L2
object cache of the JPA provider, for example Eclipselink.

Query result cache based on Spring Framework

In this case, regular prices and the results of search queries for IDs of price derivation rule eligibilities are
stored in a cache. This cache is used via Spring cache abstraction. The cache provider determines the
settings for the query result cache (regular prices, eligibility IDs). Guava is the default cache provider and
allows the configuration of the cache via a cache specification string per cache region.

«* Example

How to Set the Query Result Caches Related to Promotional Information and Regular Prices

is the default setting!

sap.dataaccess-common.cachenamedqueries=true

# Spring cache for promotional information

sap.dataaccess-—

common . promocachespec=maximumSize=10000, expireAfterAccess=10m, expireAfte
riWrite=20m

# Spring cache for base prices

sap.dataaccess-—

common.basepricecachespec=maximumSize=10000, expireAfterAccess=10m, expire
AfterWrite=20m

=, Source Code
# Use Spring caching for promotional information and base prices - true

To apply these settings, they have to be part of the extension descriptor within the
JBP_CONFIG_JAVA OPTS property.

=, Source Code

JBP CONFIG JAVA OPTS: 'java opts: -Dsap.dataaccess-
common.db.client="<DB CLIENT>" -Dsap.dataaccess-common.logSys=<LOGSYS>'
-Dsap.dataaccess-common.cachenamedqueries=true -Dsap.dataaccess-
common . promocachespec=maximumSize=10000, expireAfterAccess=10m, expireAfte
rWrite=20m -Dsap.dataaccess-
common .basepricecachespec=maximumSize=10000, expireAfterAccess=10m, expire
AfterWrite=20m

For more information about optional properties that can be set via the extension descriptor, see the module
descriptions and the corresponding property files in the Development and Extension Guide for Omnichannel

Promotion Pricing on SAP Help Portal at https://help.sap.com/viewer/p/CARAB|p <Version> » Development »

Development and Extension Guide 3.
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For more information about caching options, see the Development and Extension Guide for Omnichannel
Promotion Pricing on SAP Help Portal at https://help.sap.com/viewer/p/CARAB|p <Version> » Development 3

under |+ Promotion Pricing Service ¥ PPS Module dataaccess-common 4.

Related Information

https://github.com/google/guava/wiki/CachesExplained #*
http:/www.eclipse.org/eclipselink/documentation/2.6/concepts/cache.ntm#CDEFHHEH #

https://docs.spring.io/spring/docs/current/spring-framework-reference/html/cache.html #

6.1.3 Troubleshooting

Diagnose and resolve issues that may arise when you install, upgrade, and set up your scenario. If you need to
report a customer incident, see the information at the end of this section.

->Tip

For quick access to support information, log in to the SAP ONE Support Launchpad at https:/
launchpad.support.sap.com/#/productsearch® and search for SAP CARAB (back-end) or SAP FIORI FOR
SAP CARAB (front-end). Find SAP Knowledge Base Articles, Documentation, Guided Answers, Questions &
Blogs, and Download information — all on one page.

Troubleshoot Installation, Upgrade, and Implementation Issues

Installation, Upgrade, and Implementation Issues

Area Symptom Cause Possible Solutions

Installation / Upgrade You want to download arevi-  You need the exact download See section Download and
sion of software component  path on the SAP Support Install the Application Func-
SAP RTL AFL FOR SAP Portal at http:// tion Library (SAP RTL AFL
HANA. support.sap.comfh’. FOR SAP HANA) [page 47].

Installation / Upgrade You get an error indicating You must install compatible  See section Download and
that software component releases (“revisions”) of the  Install the Application Func-
SAP RTL AFL FOR SAP following: tion Library (SAP RTL AFL

HANA is not compatible. FOR SAP HANA) [page 47].

® SAP RTL AFL FOR
SAP HANA

® SAP HANA DATABASE

® SAP HANA AFL
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Area

Symptom

Cause

Possible Solutions

Installation / Upgrade

You want to know what AFLs
(application function libra-

ries) are installed and active
in your SAP HANA database.

For example, you want to
check if an AFL was installed
or upgraded correctly.

SAP Note 2188129#k

Installation / Upgrade

You want to verify if your revi-
sion of SAP HANA Platform
is compatible with your ver-
sion of SAP HANA studio.

For example, you might be

experiencing compatibility is-

sues following an upgrade.

SAP Note 2375176 #

Installation / Upgrade

You have installed compati-
ble revisions of the following
components but are still ex-
periencing issues: SAP RTL
AFL FOR SAP HANA, SAP
HANA AFL, SAP HANA
DATABASE

Something went wrong dur-
ing the installation.

Revisit SAP Note 2377894 #%
and make sure that you have
carefully followed all the
steps for your scenario.

Installation / Upgrade

You want to install or upgrade
an application function li-
brary (such as SAP RTL AFL
FOR SAP HANA)and are ex-
periencing issues with the
SAP HANA Lifecycle Man-
agement tool (hdblcm,
hdblcmgui).

You need information on pos-

sible causes and solutions.

e SAP Note 2078425k

e SAP Note 2082466

e SAP HANA Server Instal-
lation and Update Guide
for your SAP HANA Plat-
form version under
https://help.sap.com/
viewer/p/
SAP_HANA_PLATFORM

I <version> »
Installation and

Upgrade }
Installation / Upgrade You get an import error when A program error must be SAP Note 2377525
installing the RTLAPPS soft-  fixed.
ware component of the SAP
CARAB back-end product
version.
Installation / Upgrade You get the error CAR RETAIL You are using the SAP HANA  SAP Note 2022080#%
APPLSAP DBTech JDBC: AFL software component and
[258]: insufficient privilege:  have performed an upgrade
Not authorized. of your SAP HANA Platform.
Previously assigned privi-
leges might have been lost
during the upgrade.
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Area

Symptom Cause

Possible Solutions

Installation / Upgrade

In an upgrade, you get the An issue with CDS views
following error when running  must be fixed.

program RUTDDLSCREATE:

3 ETW678Xstart export of
R3TRDDLS<CDS view
name> ...

3WETWOOO DDLS <CDS
view name> is not activated.

2EETWI90 "DDLS" <CDS
view name> has no active
version.

4 ETW679 end export of
R3TRDDLS<CDS view

name>.

SAP Note 2340418#

Installation / Upgrade

You have implemented an
SAP Note with a correction
for the SAPUI5 application or
for the calculation of the ap-
plication index. The SAPUI5
application index is not recal-

lation manually.

culated automatically.

You need to start the recalcu-

SAP Note 2227577 Far

SAP HANA content

You have run the /CAR/ You want to know which ob-

ACTIVATE HTA activationre- jects have not been activated

port but the selected SAP correctly and what errors
HANA content is not acti- have occurred.
vated.

Execute transaction
SLG1 to display the re-
port log:

Towards the bottom of
the log you will generally
find a section that lists
the objects with activa-
tion errors. Keep in
mind, though, that those
objects might not have
any issues themselves
but that the root cause
can also be in depend-
ent objects.

In transaction
SCTS_HTA DEPLOY,
try to reproduce the er-
rors by manually rede-
ploying the objects.
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Area Symptom Cause Possible Solutions

SAP HANA content You have run the /CAR/ The SAP HANA user needs SAP Note 2586850
ACTIVATE HTA activationre- additional authorizations
port but get the error (privileges).

Insufficient privilege: Not
authorized.

SAP HANA content You have run the /CAR/ You might have an authoriza- ® Check if SAP HANA da-
ACTIVATE HTA activationre- tionissue. tabase user _SYyS REPO
port but the selected SAP has been assigned privi-
HANA content is not acti- lege SELECT with option
vated. Grantable to others. If

not, you can grant the
missing privilege using
the following example
SQL statement:
GRANT SELECT ON
SCHEMA <your
schema name> TO
_SYS_REPO WITH
GRANT OPTION;

e Check that other re-
quired authorizations
have been set up cor-
rectly. For more informa-
tion, see section Verify
Back-End Users and
Roles [page 70].

SAP HANA content You have run the /CAR/ You might have a circular de- SAP Note 2404872 P

ACTIVATE_HTA activationre- pendency issue. In particular,

port but the selected SAP you get an error that a

HANA content is not acti- SQLScript procedure (such

vated. as
SP_SR_GET PROD HR XR B
Y DATE) cannot be acti-
vated.
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Area Symptom Cause Possible Solutions

SAP HANA content After running the /car/ You want to know whether SAP Note 2467113
ACTIVATE HTA activationre- the activation was successful
port, you get two conflicting ~ and whether any additional
messages: action is required.

® The following scenario
was deployed
successfully...

e Butreturned error/
warning/information

message(s)...
SAP HANA content You want to generate pre- You might not have activated When you run the /CaR/
season sales projections in all the required SAP HANA ACTIVATE_ HTA activation re-
SAP Assortment Planning content. port, make sure to select the
but get an error. required options. See Acti-
vate SAP HANA Content
[page 78].
SAP HANA content You want to check the de- You might need this informa- ® In SAP HANA studio: Se-
pendencies of a specific view. tion to solve a dependency or lect the view and choose
activation issue for SAP Auto Documentation
HANA views. from the context menu.

This generates a file with
detailed information on
the view. Consult the
Cross References sec-
tion.

e [fyou are using the SAP
HANA Live View Browser
app: Select the view and
choose Cross
References.
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Area

Symptom

Cause

Possible Solutions

SAP HANA content

You get an error indicating
that you are attempting to

access inactive or invalid SAP

HANA content.

You have not installed soft-
ware component SAP RTL
AFL FOR SAP HANA.The
component contains back-

end functionality for the Uni-

fied Demand Forecast mod-
ule and the On-Shelf Availa-
bility module in SAP
Customer Activity
Repository. If you don'tin-
tend to use those modules,
you don't need to configure

them. However, you must al-

ways install the software
component.

See section Download and

Install the Application Func-

tion Library (SAP RTL AFL
FOR SAP HANA) [page 47].

SAP HANA content

You get the error Table
ABAP:/DMF_ORG_ASSIGN
not found.

A program error must be
fixed.

e SAP Note 2218875/
e SAP Note 2224582

SAP HANA content You get the error Object A program error must be SAP Note 2224582 e
DDF_ORG_ASSIGN fixed.
(Calculation View), package
sap.is.ddf.udf.data_validation,
was processed with errors.
SAP HANA content You get the error SQLScript: A program error must be SAP Note 2125672
Could not derive table type fixed.
for variable
"UDF_FC_HORIZON".
SAP HANA content SAP HANA views in the A program error must be SAP Note 2203930#%
sap.is.ddf.fms package fixed.
do not activate properly.
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Area Symptom Cause Possible Solutions

SAP HANA content You need to manually deploy  The automatic deployment e Search for the following
SAP HANA objects and pack- to the SAP HANA repository sections in the product
ages. of the target system has documentation of your

failed. SAP NetWeaver plat-

form at https:/
help.sap.com/viewer/p/
SAP_NETWEAVER: SAP
HANA Transport for
ABAP and Manually De-
ploying SAP HANA Ob-
jects and Packages. Fol-
low the instructions.

e FExecute transaction
SCTS_HTA DEPLOY
for the manual deploy-
ment of SAP HANA con-
tent and consult the ac-
companying system
documentation.

SAP HANA content You get any of the following The root cause is the usage ~ You can ignore the error mes-
errors: of CDS (Core Data Services) sages and continue with the

o View "/AMR/ " does not on top of external views. installation or upgrade proc-

L ess. For explanations, see
exist in data base P

e "DDL Source" "/ SAP Note 2330184 #r .
AMR/...." could not be
activated
e "DDL Source""/DMF/
DIST_..." could not be
activated
SAP HANA content You get the error SQL Script ~ The root cause is the usage ~ You can ignore the error mes-
message: invalid table name:  of CDS (Core Data Services) sages and continue with the
Could not find table/ on top of external views. installation or upgrade proc-
view /AMR/V. ess. For explanations, see
SAP Note 2441184 #r .
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Area

Symptom

Cause Possible Solutions

SAP HANA content You get the error View with A data element that is new or SAP Note 2289913 ¥
par. <CDS view name>: data  has been redefined is used in
element <data element> par.  the new definition in a Core
& does not exist or not active. Data Services (CDS) view
with parameters for the defi-
nition of a parameter.
The system does not con-
sider the dependency be-
tween data elements and the
type definition of the param-
eters for views with parame-
ters.
SAP HANA content When doing ATC (ABAP Test  The system does not con- SAP Note 2374190 Far
Cockpit) checks of database sider base information of the
objects or runtime objects, AMDP table function entity.
you get errors related to ref-
erence tables and reference
fields:
e Priority 1 error: View
<view_name> is not
consistent
® Priority lerror:
<view_name-field> is not
consistent
® |nconsistencies in fields
related to reference ta-
bles and reference fields
SAP HANA Platform You cannot install the SAP You cannot install XSA as SAP Note 2388443 P
HANA XS advanced (XSA) long as SAP HANA dynamic
runtime. tiering is active on the same
For example, you need XSA host.
to use the Omnichannel Pro-
motion Pricing (OPP) module
in SAP Customer Activity
Repository.
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Symptom

Cause

Possible Solutions

SAP HANA Platform

You are encountering per-
formance issues in the SAP
HANA Platform.

Several causes are possible.

SAP Note 2600030 #%
(Parameter Recommen-
dations in SAP HANA En-
vironments)

SAP Note 2100040
(FAQ: SAP HANA CPU)
SAP HANA Trouble-
shooting and Perform-
ance Analysis Guide for
your SAP HANA Plat-
form version under
https://help.sap.com/
viewer/p/
SAP_HANA_PLATFORM

[ <Version>
Administration 1

SAP HANA Platform

You are not sure if the instal-
led SAP HANA revision is
compatible with the installed
SAP HANA studio version.

Consult the list of compatible SAP Note 2375176 #%

revisions and versions.

You get errors when creating
or updating location hierar-
chies and/or product hierar-
chies.

The system does not gener-
ate the flat structures for the
hierarchies. You need to do
some configuration steps so
that the hierarchies get flat-
tened automatically.

Follow the steps in Con-
figure Automatic Flat-
tening of Hierarchies
[page 86].

See the following sec-
tions of the SAP Cus-
tomer Activity Reposi-
tory Administration
Guide under https:/
help.sap.com/viewer/p/

CARAB b <Version> »
Administration }:

o Configuring De-
mand Data Founda-
tion (DDF)

o Configuring Data
Replication from
SAP ERP to DDF

You get errors when import-
ing article hierarchies (prod-
uct hierarchies) from your
master data system.

A program error must be
fixed.

SAP Note 2244521 ¥
SAP Note 2245134 ¥
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Area Symptom Cause Possible Solutions
Hierarchies You want to know which loca- You can implement an easy SAP Note 2208619 P
tions are included in each enhancement for ta-
version of an offer. ble /DMF/OFR_LG_LOC.
Hierarchies An error occurs for a DDL A program error must be SAP Note 2377525
SQL view when you execute  fixed.
the CREATE VIEW state-
ment.
DRF data replication frame-  You have deleted a vendor A program error must be SAP Note 1872136 ¥

work (transaction DRFOUT)

from the /DMF/D VENDOR
table but this deletion is not
replicated to the master data
system.

fixed.

DRF data replication frame-
work (transaction DRFOUT)

You get an error when using
the DRF with the pMPL SAP
ERP outbound implementa-
tion.

A program error must be
fixed.

e SAP Note 1904782

e SAP Note 2167629 #%

e See the application help
for SAP Customer
Activity Repository at
https://help.sap.com/
viewer/p/CARAB
I <Version>

Application Help > SAP
Customer Activity
Repository > Demand
Data Foundation >

Integration Information

> Master Data
Replication from SAP
ERP to Demand Data

Foundation 3

DRF data replication frame-
work (transaction DRFOUT)

You get the error Product &1,
location &2: The Valid From
time for &3 must be
00:00:00 (message 364 in
message class /DMF/
MSG_HL).

A program error must be
fixed.

SAP Note 2163602 #

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0

FPSO1
Set Up the Applications

PUBLIC 163


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2208619
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2377525
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1872136
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1904782
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2167629
https://help.sap.com/viewer/p/CARAB
https://help.sap.com/viewer/p/CARAB
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2163602

Area

Symptom

Cause

Possible Solutions

DRF data replication frame-
work (transaction DRFOUT)

You have changed the listing
information in your source
master data system and re-
plicated the changes to your
SAP Customer Activity
Repository system. However,
the listing information there
is not updated correctly.

A program error must be
fixed.

SAP Note 1932525¢

Performance You are experiencing per- You need information on how See the SAP HANA Trouble-

formance issues in your SAP  to troubleshoot and resolve  shooting and Performance

HANA database. those issues and how to en-  Analysis Guide under https://

hance performance in gen- help.sap.com/viewer/p/
eral. SAP_HANA_PLATFORM
| <Version> ¥
Administration 1

Performance You get a runtime error or Different causes are possible. Use the ABAP dump analysis

exit message and need infor- (transaction ST22) to search

mation about possible for short dumps and call up

causes and solutions. detailed error information.
Performance You are using the Update You can enhance the per- SAP Note 2080423

Sales Projection function in formance by implementing

SAP Assortment Planning an SAP Note.

(workbooks Product Planning

and Size Planning). You are

experiencing performance is-

sues when using the function

with large data volumes.
OData During the execution of an The Core Data Services SAP Note 238998 ¥

OData service based on (CDS) view uses a table func-

SADL with CDS, an assertion tion that is not active in the

fails in class database. The trigger that is

CL SADL SQL STATEMENT, supposed to activate it fails

method because of missing parame-

EXECUTE_PREPARED_STATE tersifonly Scount is quer-

MENT. The OData request ied.

uses the system query option

$count.
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Area

Symptom

Cause

Possible Solutions

Support

You have a customer incident
and need to set up a service
connection to SAP.

You need information on how
to set up the service connec-
tion.

e SAP Note 35010
(overview)

e SAP Note 1634848Fk
(service connection for
SAP HANA database)

e SAP Note 1592925
(service connection for

SAP HANA studio)
Source Master Data Systems  You get the error The error is caused by the SAP Note 2249880 ity
SYSTEM_ABAP_ACCESS_DE  Blacklist Monitor in SAP S/
NIED. 4HANA on premise.
SAP Fiori ® Youwanttostartan SAP  Youmust setup the adapta-  SAP Note 2283716/
Fiori app for akey user  tion transport organizer
and get the error (ATO) to be able to transport
Application is not key user extensions.
configured. Find details
in SAP Note 2283716.
e You want to activate ex-
tensibility for key users.
SAP Fiori You want to check the SA- There are several methods SAP Note 2282103
PUI5 version installed in your how you can check the ver-
system. sion.
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Area Symptom Cause Possible Solutions

SAP Fiori You cannot open the Analyze Several reasons are possible. Use section Set Up the Ana-
Forecast app. See the checklist at the right  lyze Forecast App [page 110]
and verify that the appis set  for reference and check the
up correctly. following:

1. Intransaction SE80,
navigate to package
UICAR001, subpackage
UISCARO1. Check that
the BSP Applications for
the app
(ANALYZFCST Vv2)and
the reuse library
(UDFREUSE) are de-
ployed.

2. InLaunchpad
Customizing (transac-
tion LPD_CUST), check
that the Internet Com-
munication Framework
(ICF) services for
ANALYZFCST_ V2 and for
UDFREUSE are active.

3. Clear the cache onthe
server side by running
the following reports in
transaction SE38:

o /UI5/
APP_INDEX CALCU
LATE: Select Single
SAPUI5 Repository
Only and run the re-
port once for
ANALYZFCST V2
and once for
UDFREUSE.

o /UIrz/
INVALIDATE GLOB
AL _CACHES: Run
this report in execu-
tion mode.

o /Julz/
INVALIDATE CLIE
NT CACHES: Run
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Area

Symptom

Cause

Possible Solutions

this report for all
users.

4. Clear the browser cache.

5. Check if you can now ac-
cess the app.

Upgrade On-Shelf Availability
Dispatcher (transac-
tion /OSA/DISPATCH)

The following error occurs
when executing the On-Shelf

Availability (OSA) Dispatcher:

"SQL Error Code 274 : in-
serted value too large for col-

umn

Local temporary tables
(LOCAL_EXCL_PRODUCT,
LOCAL LISTED PRODUCT,
and LOCAL PS CONF) cre-
ated and used by OSA for in-
ternal dispatcher processing
are not dropped automati-
cally during runtime there-
fore new tables, such as any
containing CHAR4O fields,
cannot get created. This
causes an SQL error when a

CHAR40 material is supplied.

Subsequent structural
change to the definition of
these tables requires manual
intervention in cases where
the tables may already exist.

SAP Note 2576497 Fr

Troubleshoot Operation Issues

You also may encounter issues during the day-to-day running of your application. For troubleshooting
information, see the application-specific Administration Guides under https://help.sap.com/viewer/p/CARAB

|» <Version> » Administration J:

e  SAP Customer Activity Repository Administration Guide: section Troubleshooting for SAP Customer Activity

Repository Modules

e  SAP Allocation Management Administration Guide: section Troubleshooting

e SAP Assortment Planning Administration Guide: section Troubleshooting

® SAP Merchandise Planning Administration Guide: section Troubleshooting

e SAP Promotion Management Administration Guide: section Management of SAP Promotion Management

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0

FPSO1
Set Up the Applications

PUBLIC 167


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2576497
https://help.sap.com/viewer/p/CARAB

Report a Customer Incident

e |f you encounter an issue with your system, we recommend that you first search the SAP Knowledge Base
and SAP Notes for existing solutions. For more information, see http:/support.sap.com/# ¢ My Support
Knowledge Base

e Toview or report an incident, see http://support.sap.com/#& [» My Support ¥ Incidents

e For more information on reporting incidents for SAP Customer Activity Repository, see the Support Desk
Management section of the SAP Customer Activity Repository Administration Guide.

6.2 SAP Merchandise Planning

Post-installation of SAP Merchandise Planning .

i Note

Some of the activities in this section may have already been performed in the corresponding section under
SAP Customer Activity Repository. Such activities do not need to be repeated during the setup and
installation of consuming applications.

6.2.1 Perform Core Steps for SAP Customer Activity
Repository

To set up this application, you must first perform the Core (Mandatory) steps for SAP Customer Activity
Repository. The core steps are mandatory for all the consuming applications.

Procedure

Perform all steps listed under Core (Mandatory for All Applications) [page 67].

6.2.2 Configure SAP Merchandise Planning

Use

SAP Merchandise Planning is a consuming application of SAP Customer Activity Repository, which contains
data that is imported from SAP ERP or SAP S/4HANA into the following:

e SAP HANA for SAP ERP using SAP LT Replication Server (SLT), which is saved in the sap_EcC authoring
schema.

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
168 PUBLIC Set Up the Applications


http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2F
http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2F

Or
SAP S/4HANA using SLT, which is saved in the SAP_S4H authoring schema.

e Demand Data Foundation (DDF)

Customizing Activities

There are key Customizing activities required to use the SAP Merchandise Planning application. These steps
are performed using transaction SPRO and navigating to the required Customizing activity.

Demand Data Foundation Customizing Node

This node is accessible under ¢ Cross-Application Components .

1. Perform the necessary configuration steps in DDF.
The mandatory activities are marked in the configuration document Configuring Demand Data Foundation
(DDF).

2. Configure data replication from SAP ERP to DDF.
SAP Merchandise Planning uses master data (such as product, location, and product hierarchy) as well as
organizational data (such as sales organization and distribution channel) that is replicated from SAP ERP
to DDF using DRFOQUT.
This step was performed during installation as described in section | SAP Customer Activity Repository
Core (Mandatory for All Applications) 3. See http://help.sap.com/viewer/p/CARAB# | <Version> 3
| Common Installation Guide for SAP Customer Activity Repository applications bundle ¥ Set Up the
Applications .
For more information on setting up this data replication, see the following document Configuring Data
Replication from SAP ERP to DDF.

3. Verify you have entered the Merchandise Planning and Planning Configuration relevant sections in
Customizing activity [ Cross-Application Components » Demand Data Foundation » Basic Settings ¥

Define Default Values 3. For more information see the documentation attached to each activity or the field
level help (F1).

i Note

Geo Hierarchy ID is only for Merchandise Planning for Retail version 1.1 or prior.

Merchandise Planning Customizing Node

As of SAP Merchandise Planning 2.0 FP2, there is a|» Cross Application Components » 4 Merchandise
Planning node containing mandatory steps for your implementation. Review the table below for applicable
activities for your environment. Each Customizing activity has attached documentation to further explain the
activity.

Technical Name Customizing Path Description

/RAP/MPR_CALC_ECC |’ Cross-Application Use this option if your source data system is SAP ECC.

Components » Merchandise
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Technical Name Customizing Path Description

Planning > Enhancements Using

Business Add-Ins » BAdI: ECC
Calculate Open Qty, Goods

Receipt and Returns KPI ]

/RAP/MPR_CALC_FMS Use this option if your source data system is SAP FMS.

|} Cross-Application
Components > Merchandise
Planning > Enhancements Using

Business Add-Ins ¥ BAdI: FMS
Calculate Open Qty, Goods

Receipt and Returns KP4

/RAP/MPR_CALC_S4H Use this option if your source data system is SAP S4H.

|+ Cross-Application
Components » Merchandise
Planning > Enhancements Using

Business Add-Ins  BAdI: S4H
Calculate Open Qty, Goods

Receipt and Returns KPI 3

/RAP/

MPR_COST_PRC_DETE )
Components > Merchandise ) ) ) )
RM The default implementation assumes moving average price

Planning } Enhancements Using is always available in the unit of measure.
Business Add-Ins » BAdI: Cost

Determination for Receipt, Open

Oty and Returns 4

|', Cross-Application You use this BAdI to determine the purchase price for goods

receipts, open purchase order and returns to vendor KPIs.

/RAP/

MPOC_CALC_PO_RECE c ts % Merchandi
IPTS_KPI omponents erehandise KPIs are based on segmentation and channel.

Planning » Enhancements Using

Business Add-Ins ¥ BAdl:
Calculate Goods Receipt KPIs by

|’ Cross-Application You use this BAdI to determine the calculation for goods

receipt, open purchase order quantity and returns to vendor

Segmentation & Channel 4

/RAPF/

MPOC_CALC_INVENTO )
Components > Merchandise )
RY_KPI and Excess Inventory Stock based on segmentation and

Planning > Enhancements Using  channel.

Business Add-Ins  BAd:
Calculate Inventory KPIs Based

You use this BAdI to Calculate Inventory KPIs like Beginning
of Period Cost and Unit Values for Distribution Centre, Store

| Cross-Application

on Segmentation & Channel 4
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Technical Name Customizing Path Description

/RAP/ |} Cross-Application You use this BAdI: to select the season year, season,
MPOC_PLANNING_YSC ) collection and theme relevant data for Merchandise
T Components » Merchandise Planning

ing.

Planning » Enhancements Using

Business Add-Ins ¥ BAdI: Select
Season Year, Season, Collection

and Theme 3§

Implementation Tasks

Use of Workbook Versions

The version concept allows you to plan and view different working versions, and to create special versions for
released and finalized plans. Each workbook can display up to two different versions in parallel, with the
capability to copy or provide a working plan version from any other available version to begin the planning
process

The version and planning levels are decided during installation. These concepts will affect your planning
configuration set and integration with SAP Assortment Planning. The recommended standard is planning at
the 5th node level of the product hierarchy (1-7 levels available). The installation will prompt you to create levels
5and 7. The workbook versions are named by concatenating the level with the version. For example the
merchandise financial plan for level 5 versions are:
e o Working Version - M51

o Simulated Version - M52

o Released Version - M5R

o Final Version - M5F

o In Season Version - M5P

Planning Configuration Sets

A Planning Configuration Set (PCS) is a prerequisite to creating a merchandise plan. A planning configuration
defines entry and exit levels for merchandise and option plans based on a market hierarchy (representing an
organizational view on top of retail stores and wholesale customers) and a product hierarchy. The PCS must be
specifically defined in order for the data to render properly in the workbook.

i Note

You must have an area of responsibility assigned for the product hierarchy and market hierarchy you will be
using. From your SAP Easy Access menu, use transaction code NWBC and navigate to menu |+ Services »

Maintain Area of Responsibility 3.

For more information about Planning Configurations see https://help.sap.com/viewer/p/CARAB and navigate
to | <your version> » SAP Assortment Planning » Assortment Planning » Manage Planning Configuration
Sets 1.
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Integration with SAP Assortment Planning.

SAP Assortment Planning is not aware of the finalized version maintained in SAP Merchandise Planning. This
means if you want to send your merchandise plans to an assortment plan, there are setup tasks. The standard
integration is implemented in an aMbP BAdI named /DMF/MPR_READ KPI DATA which resides in fallback
class /DMF/CL _MPR READ DATA DEFAULT. The BAdI works as follows:

While calling the API to fetch finalized version, the assortment plan interface selects product hierarchy
node(s) of the same level as the plan. For example, based on the product hierarchy node of level 3 (or 4, 5,
6, 7), the system will automatically look for version M3F (or M4F, M5F, etc.).

If standard integration is used, it is recommended that final released versions should be named as M<level
of product hierarchy node>F.

A specific custom extension is possible by implementing AMDP BAdI /DMF/MPR_READ KPI DATA if your
planning version used for the merchanise plan does not follow the recommended naming convention.

o The BAdI is available using transaction code sPrRo and navigating to Customizing node |+ SAP
Customizing Implementation Guide » SAP Customer Activity Repository # Demand Data Foundations ¥
Data Maintenance » Planning Configuration 1 Enhancements Using Business Add-Ins » BAdI: Read
Merchandise Planning KPI Data 3.

6.2.3 Generate Time Data - Gregorian Calendar

Generate time data (Gregorian calendar) required by time-dependent views included in the SAP HANA content
for SAP Customer Activity Repository applications bundle.

Use

Execute this procedure to generate time data (Gregorian calendar).

Procedure

172

Log on to SAP HANA studio.

In the Modeler perspective, on the Quick Launch tab, select your SAP Customer Activity Repository
applications bundle system and choose Generate Time Data.

Select Gregorian as the Calendar Type.

For example, SAP HANA views included in SAP HANA content for SAP Customer Activity Repository
require the presence of time datain _sys BI.TIME DIMENSION* SAP HANA database tables.

Enter a range of years that includes all the years of data that you plan to store in SAP Customer Activity
Repository.
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«» Example

If you plan to start using SAP Customer Activity Repository on January 1, 2014, enter 2014 as your
starting year. But if you plan to access sales documents created in SAP ERP that date from January
2013, you should specify 2013 as your starting year.

5. Define the granularity as Day, which is the minimum granularity required by SAP Customer Activity
Repository. You can choose a finer level of granularity, for example Hour, if necessary.

6. Choose the day that is the first day of the week in your company.
7. Choose Finish.

For more information, see:

e https://help.sap.com/viewer/p/SAP_HANA_LIVE|l Installation and Upgrade ¥ Administrator's Guide
Configuration Steps » Generate Time Data J

e https://help.sap.com/viewer/p/SAP_HANA_PLATFORM | <Version> » Development » SAP HANA
Modeling Guide (for SAP HANA studio) ¥ Creating Information Views and Previewing its Output » Generate
Time Data 3

6.2.4 Activate SAP Merchandise Planning Bl Planning
Framework Content

The planning framework used by SAP Merchandise Planning consists of the following elements:

e Business Intelligence Content (Bl Content) Objects: A collection of local Bl Content objects is used as
the basis for the SAP Analysis for Microsoft Office workbooks.
SAP Analysis for Microsoft Office workbooks are designed to consume data from Bl Content objects. The
local Bl Content objects that are provided with the SAP Merchandise Planning application use the
integrated planning engine in SAP Business Warehouse (SAP BW). These local Bl Content objects are used
as an interface between the SAP HANA views and the SAP Analysis for Microsoft Office workbooks.

i Note

The local Bl Content provided with the SAP Merchandise Planning application is entirely independent
of the SAP Business Warehouse Bl Content and Bl Content Extensions add-on.

e SAP Analysis for Microsoft Office Workbooks: Microsoft Excel-based spreadsheets that you use to plan
assortments for the different locations in your retail business.

This section of the guide provides information on the SAP HANA content activation, Bl Content activation and
configuration, and data upload activities required to set up the SAP Merchandise Planning planning framework.
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6.2.4.1 Activate SAP HANA Content for SAP Merchandise
Planning

Activate all SAP HANA Transport for ABAP (HTA) objects that are required for SAP Merchandise Planning
application.

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Merchandise Planning,
you must have successfully completed all of the procedures listed in the previous sections of this guide as

pertains to [r SAP Customer Activity Repository » Core (Mandatory for All Applications) 3. In particular, you
must have created all the necessary tables, as described in Create/Replicate Source Master Data System
Tables [page 76].

You must also have mapped all the necessary schemas, as described in Verify Correct Schema Mapping [page
40].

Context

In this procedure you perform the final activation of SAP HANA content (views and stored procedures) required
by the SAP Merchandise Planning application. This final activation results in a full activation of the SAP HANA
content for SAP Merchandise Planning. Several SAP HANA views depend on local Bl Content objects. The SAP
HANA views have to be activated before activating the Bl Content objects as described in Activate Application
Bl Content [page 176] .

For more information, see http://help.sap.com/hana [# HANA Platform JSection Activating Objects of the SAP
HANA Developer Guide SAP,

Procedure

1. Inyour back-end system, start transaction SE38.
2. Enter /CAR/ACTIVATE HTA and choose Execute.

3. Select all applicable ECC modes and the business scenarios Demand Data Foundation and Merchandise
Planning to activate the SAP HANA content. If all applicable scenarios show (Active) you can skip to step 6.

4. Optionally, select the Perform Prerequisite Check option to validate the processing and read the system log
prior to applying any database changes.

5. Choose Execute. Exit the screen when completed.

6. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA
content.
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Provide user sys REPO with object privilege SELECT, with option "Grantable to others"”, on the following

physical DB schemas:

o Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables

You can use the following example SQL statement to grant the required privilege:

GRANT SELECT ON SCHEMA <Your schema name> TO _SYS_REPO WITH GRANT OPTION;
Log on to SAP HANA Studio.

8. Open the Modeler and use the Navigator to access your back-end system.

9. Expand the Content folder located under your system name in the Navigator.

10. Expand the listed packages to verify the underlying folders listed below are active.

Based on the selected ECC Mode in the above report the following packages should exist:
o SAPERP:
O sap.is.ddf.ecc
O sap.is.retail.ecc
o Fashion Management:
O sap.is.ddf.ecc
O sap.is.retail.ecc
O sap.is.ddf.fms
o S/AHANA:
O sap.is.ddf.fms
© sap.is.retail.fms_ s4h
11. The following packages should exist resulting from the standard installation:
O sap.is.ddf.ddf
O sap.is.retail.rap.ap
© sap.is.retail.rap.common bw
O sap.is.retail.rap.mpr

© sap.is.retail.rap.mpr oc

If any of these packages are missing, you must activate those relative to the order above due to
dependencies. Use transaction SCTs HTA DEPLOY to activate each missing packages.

6.2.4.2 Activate SAP Merchandise Planning Local Bl
Content

Procedure

1. Onyour back-end system, open the Data Warehousing Workbench (transaction RSA1).
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In the Replicate Metadata dialog box, choose Only Activate.

. If amessage appears that you are only authorized to work in client. (Brain 009), then refer to SAP Note

316923#% (do not import the support package, but use the description under section Workaround).
Select Do not show this question Again in the dialog that appears.

Choose Yes.

Make sure that the current job has finished before you proceed with the next step. Check the status of the
background job using transaction sM370r SLG1. If there are problems, you must first solve them.

You can use transaction RSTCO_ADMIN to restart the activation of the technical content and to verify the
status of the activation.

i Note

In the case that you get the short-dump "RAISE_EXCEPTION" when installing InfoObjects from the Bl
content, see SAP Note 1637935 for a possible solution.

Also, see SAP Note 2090845#% for important information on technical content activation.

Following activation, you can locate the technical content in the Data Warehousing Workbench as follows:
1. Selecting Modeling in the left-hand frame.

2. Expand InfoObjects.

3. Intheright-hand frame, locate Technical Content.

6.2.4.3 Activate Application Bl Content

Use

A Caution

Proper authorization is required to complete these steps.

These instructions are to activate content for the InfoArea Merchandise Planning Omni Channel (/RAP/MPOC).
This will activate the following object types:

InfoObjects

Advanced DataStore Objects (aDSO)
Composite Providers

Aggregation Levels

Planning Sequences

Queries

Workbooks

After completing the activate sections, see the last section of this topic, Verify Installed Objects to insure all
objects have been installed and activated.
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Activate Advanced DataStore Objects

i Note

A window being referenced, may be hidden. Use the Data Warehousing Workbench menu in the main
window title bar to hide/unhide the following windows: Navigation, All Objects, and Collected Objects.

e Use transaction RSOR to launch the BW workbench Transport Connection.

® |nthe navigation window, locate and select Object Types. In the window All Objects According to Types,
expand node DataStore Objects (advanced) and double click Select Objects. In the popup window, select
the following objects and select button Transfer Selections.

DataStore Object (advanced)
aDSO0 Description aDSO

Market Hierarchy CR based on Planning Configuration Set /RAP/MHDS1

Market Hierarchy CR aDSO for LY and LLY /RAP/MHDS2
aDSO for actuals of LY and LLY KPIs /RAP/MPDSO
MP - Regional Month Sales Target for Omni Channel /RAP/MPDS1

MP - Local Month Sales Inventory Targets for Retail and E- /RAP/MPDS2
Co

MP - Local Month Sales and Inventroy Targets for Whol- /RAP/MPDS3
sale

Product Hierarchy CR based on Planning Configuration /RAP/PHDS1

Set
Product Hierarchy CR aDSO for LY and LLY /RAP/PHDS2
Merchandise Plan YSCT Characteristic Relationship /RAP/SCTDS

e Select Yes to the system prompt Do you want to add the objects to the personal list.
e \When prompted for Source System, do not choose any and select OK.

e Foreach aDs0, right click on the object and select option Install All Below.

® [nstall and Activate each aDSO.

Activate Analysis Office Excel Workbooks 2.0

In this section you will continue from the above step and activate the workbooks. :

e From the left navigation panel for Bl Content locate and expand folder More Types. Expand Analysis Office
Excel Workbook and double click Select Objects. Use the filter in the popup window to define a filter on
column Object Name having values of /RAP/MP_*.

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
Set Up the Applications PUBLIC 177



In the pop up window, select the following objects and select button Transfer Selections.

Workbooks
Object Name

/RAP/MP_ECOM_PHN5_WB_01

/RAP/MP_OTB_OTS_PHN5_WB_01

/RAP/MP_OTB_OTS_PHN5_WB_02

/RAP/MP_RTL_PHN5_WB_01

/RAP/MP_RT_PHN5_M_WB_01

/RAP/MP_RT_PHN7_WB_01

/RAP/MP_RT_SSN_PHN5

/RAP/MP_WHS_PHN5_M_WB_01

e Select Yes to the system prompt Do you want to add the objects to the personal list.
® For each workbook, right click and select option Install All Below.
e |nstall and Activate each workbook.

Activate Planning Sequence

In this section you will activate the Planning Sequence, Planning Function used for loading last year actual data,
From the left navigation panel for Bl Content locate and select Object Types. In the All Objects According to Type
window, perform the following:
® |ocate and expand Planning, Planning Sequence.
o Double click Select Objects and use the filter in the popup window to define a filter on column Object
Name having values of /RAP/MPDS*. In the results, use the Transfer Selections button to
transfer /RAP/MPDSO A0 PSO1, /RAP/MPDSO A2 PSO01,and /RAP/MPDS1 Al PSO1 to Collected
Objects, then Install.

Verify Installed Objects

Verify the installed objects exist using the associated tables below.

DataStore Object (advanced)
aDSO0 Description aDSO

Market Hierarchy CR based on Planning Configuration Set /RAP/MHDS1
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aDSO0 Description

aDSO
Market Hierarchy CR aDSO for LY and LLY /RAP/MHDS2
aDSO for actuals of LY and LLY KPIs /RAP/MPDSO
MP - Regional Month Sales Target for Omni Channel /RAP/MPDS1
MP - Local Month Sales Inventory Targets for Retail and E-Co /RAP/MPDS2
MP - Local Month Sales and Inventroy Targets for Wholsale ~ /RAP/MPDS3
Product Hierarchy CR based on Planning Configuration Set ~ /RAP/PHDS1
Product Hierarchy CR aDSO for LY and LLY /RAP/PHDS2
Merchandise Plan YSCT Characteristic Relationship /RAP/SCTDS

InfoObject Catalog (RAP)

Catalog Description

Catalog Name

RAP Character InfoObject Catalog

/RAP/CHAR_CAT

RAP Key Figure InfoObject Catalog

/RAP/KYF_CAT

InfoObjects Characteristics

InfoObject Description

InfoObject Name

Logical System ID /RAP/LOGSYS
Planning Configuration Node /RAP/PLCND
Planning Configuration Set /RAP/PLCSET
Market Hierarchy Node on Level 1 /RAP/PLNHN1
Market Hierarchy Node on Level 2 /RAP/PLNHN2
Market Hierarchy Node on Level 3 /RAP/PLNHN3
Market Hierarchy Node on Level 4 /RAP/PLNHN4
Market Hierarchy Node on Level 5 /RAP/PLNHN5
Market Hierarchy Node on Level 6 /RAP/PLNHNG6
Market Hierarchy Node on Level 7 /RAP/PLNHN7
Market Hierarchy Node on Level 8 /RAP/PLNHNS8
Market Hierarchy Node on Level 9 /RAP/PLNHNS
Market Hierarchy /RAP/PLNHR
Planning Process Level /RAP/PLPLVL
Markdown Sales Revenue /RAP/MRKDRV
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InfoObject Description

InfoObject Name

Markdown Sales Units /RAP/MRKDSU
Product Hierarchy Node on Level 1 /RAP/PRDHN1
Product Hierarchy Node on Level 2 /RAP/PRDHN2
Product Hierarchy Node on Level 3 /RAP/PRDHN3
Product Hierarchy Node on Level 4 /RAP/PRDHN4
Product Hierarchy Node on Level 5 /RAP/PRDHNb5
Product Hierarchy Node on Level 6 /RAP/PRDHNG6
Product Hierarchy Node on Level 7 /RAP/PRDHN7
Product Hierarchy Node on Level 8 /RAP/PRDHNS8
Product Hierarchy Node on Level 9 /RAP/PRDHN9
Product Hierarchy /RAP/PRDHR
Promotion Sales Revenue /RAP/PROMRV
Promotion Sales Units /RAP/PROMSU
Returns Revenue Loss /RAP/RETRRV
Regular Sales Revenue /RAP/RSLSRV
Regular Sales Units /RAP/RSLSUN
Collection /RAP/SCOLL
Sales Cost /RAP/SLSCV
Sales Revenue /RAP/SLSRV
Sales Units /RAP/SLSUN
Season /RAP/SSEAS
Season Year /RAP/SSYR
Theme /RAP/STHEME
Version /RAP/VERSN

InfoObjects Key Figures

InfoObject Description

InfoObject Name

BOP DC Excess Stock at Cost /RAP/BDEXCV
BOP DC Stock at Cost /RAP/BDCCV
BOP Store Stock at Cost /RAP/BSTCV
Channel Count /RAP/CHCNT
End of Period Stock DC Cost Value /RAP/EDCCV
EOP DC Excess Stock at Cost /RAP/EDEXCV
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InfoObject Description

InfoObject Name

EOP Store Stock at Cost /RAP/ESTCV
Inventory Adjustment at Cost /RAP/IADCV
Markdown Budget /RAP/MRKBUD
Markdown Sales Revenue /RAP/MRKDRV
Markdown Sales Units /RAP/MRKDSU
Month Of Supply Store /RAP/MOSUP
Month Of Supply at DC /RAP/MOSUPD
On Order Cost DC /RAP/DCOCV
On Order Units DC /RAP/DCOUN
On Order Units Store /RAP/ONOUN
On Order Cost Store /RAP/ONOCV
Open Sales Order Cost /RAP/SOOCV
Open Sales Order Units /RAP/SOOUN
Open to Sale at Cost /RAP/OTSC
OTB at Cost /RAP/OTBC
Promotion Budget /RAP/PROBUD
Promotion Sales Revenue /RAP/PROMRV
Promotion Sales Units /RAP/PROMSU
Receipt DC at Cost /RAP/RDCCV
Receipt Store at Cost /RAP/RDTCV
Receipt Units DC /RAP/RCPUND
Receipt Units Store /RAP/RCPUNS
Regular Sales Revenue /RAP/RSLSRV
Regular Sales Units /RAP/RSLSUN
Return Units DC /RAP/DCREUN
Return Units Store /RAP/RETRUN
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InfoObject Description

InfoObject Name

Returns at Cost DC /RAP/DCRECV
Returns at Cost Store /RAP/RETRCV
Returns Revenue Loss /RAP/RETRRV
Sales at Cost /RAP/SLSCV
Sales Order Intake Revenue /RAP/SOIRV

Sales Order Rejection Cost

/RAP. /SORCV

Sales Order Rejection Units /RAP/SORUN
Sales Revenue /RAP/SLSRV
Sales Store Fulfilled at Cost /RAP/STSCV
Sales Units /RAP/SLSUN
Shipment Fulfilled at Cost /RAP/SHPCV
Write Off Adjustment at Cos /RAP/WOFFAD

Composite Providers

Composite Provider Description

Composite Provider

Merchandise Financial Plan Omni Channel

/RAP/CP15

Aggregation Levels

Aggregation Description

Aggregation Name

MP Regional Targets Sales Mix - PHN 5 /RAP/C15A01
MP Regional Targets SSN Sales Mix - PHN 5 /RAP/C15A02
MP Regional Targets SSN Sales Mix - PHN 7 /RAP/C15A03
MP Local Targets - ECommerce - Sales Mix - PHN 5 /RAP/C15A11
MP Local Targets - ECommerce - Sales Mix - PHN 5 - PF RAP/C15A12

MP Local Targets - Retail - Sales Mix - PHN 5 /RAP/C15A21
MP Local Targets - Retail - Sales Mix - PHN 5 - PF /RAP/C15A22
MP Local Targets - WHS - Sales Mix - PHN 5 /RAP/C15A31
MP Local Targets - WHS - Sales Mix - PHN 5 - PF /RAP/C15A32
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Aggregation Description

Aggregation Name

MP - OTB - Retail - ECom - WHS /RAP/C15A41
AL for Market Hier CR for LY and LLY /RAP/MHDSA2
Product Hierarchy CR based on Planning Configuration Set =~ /RAP/PHDSAL
SCT CR based on Planning Configuration Set /RAP/SCTDAL
AL for Product Hier CR for LY and LLY /RAP/PHDSA2
Market Hierarchy Aggregation Level /RAP/MHDSA1
AL for Actuals of LY and LLY KPIs /RAP/MPDSAOQ

Planning Sequence

Workbook

Function

Planning Sequence

1.1 Regional Monthly Plan

Planning sequence for Ribbon in AO

/RAP/C15A01 PS00

1.1 Regional Monthly Plan

Delete

/RAP/C15A01 PSO1

1.1 Regional Monthly Plan

Release

/RAP/C15A01 PSO2

1.1 Regional Monthly Plan

Copy

/RAP/C15A01 PS03

1.1 Regional Monthly Plan

Bottom Up

/RAP/C15A01 PS04

1.2 Regional Seasonal Plan

Planning sequence for Ribbon in AO

/RAP/C15A02 PS00

1.2 Regional Seasonal Plan

Delete

/RAP/C15A02 PSO1

1.2 Regional Seasonal Plan

Release

/RAP/C15A02_ PS02

1.2 Regional Seasonal Plan

Top Down

/RAP/C15A02_ PS03

1.2 Regional Seasonal Plan

Copy

/RAP/C15A02_ PS04

1.2 Regional Seasonal Plan

Bottom Up

/RAP/C15A02_PS05

1.3 Regional Seasonal Plan

Planning sequence for Ribbon in AO

/RAP/C15A03_PS00

1.3 Regional Seasonal Plan

Delete

/RAP/C15A03 PSO1

1.3 Regional Seasonal Plan

Release

/RAP/C15A03 PS02

1.3 Regional Seasonal Plan

Top Down

/RAP/C15A03 PS03

1.3 Regional Seasonal Plan

Copy

/RAP/C15A03 PS04

4.1 Ecommerce Monthly Plan

Planning sequence for Ribbon in AO

/RAP/C15A12 PS00
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Workbook

Function

Planning Sequence

4.1 Ecommerce Monthly Plan

Delete

/RAP/C15A12 PSO1

4.1 Ecommerce Monthly Plan

Release

/RAP/C15A12 PS02

4.1 Ecommerce Monthly Plan

Copy

/RAP/C15A12 PS03

4.1 Ecommerce Monthly Plan

Top Down

/RAP/C15A12 PS04

4.1 Ecommerce Monthly Plan

Initialize BOP - M

/RAP/C15A12 PS05

4.1 Ecommerce Monthly Plan

Re-calculate BOP

/RAP/C15A12 PS06

4.1 Ecommerce Monthly Plan

Initialize BOP - T

/RAP/C15A12 PSO7

4.1 Ecommerce Monthly Plan

Initialize BOP - P

/RAP/C15A12 PS08

2.1 Retail Monthly Plan

Planning sequence for Ribbon in AO

/RAP/C15A22 PS00

2.1 Retail Monthly Plan Delete /RAP/C15A22_PS01
2.1 Retail Monthly Plan Release /RAP/C15A22 PS02
2.1 Retail Monthly Plan Copy /RAP/C15A22 PS03
2.1 Retail Monthly Plan Initialize BOP - M /RAP/C15A22 PS04
2.1 Retail Monthly Plan Top Down /RAP/C15A22 PSO5
2.1 Retail Monthly Plan Initialize BOP - T /RAP/C15A22 PS06
2.1 Retail Monthly Plan Initialize BOP - P /RAP/C15A22 PS07

2.1 Retail Monthly Plan

Re-calculate BOP

/RAP/C15A08 PS08

3.1 Wholesale Monthly Plan

Planning sequence for Ribbon in AO

/RAP/C15A32 PS00

3.1 Wholesale Monthly Plan Delete /RAP/C15A32 PSO1
3.1 Wholesale Monthly Plan Release /RAP/C15A32 PS02
3.1 Wholesale Monthly Plan Copy /RAP/C15A32 PS03
3.1 Wholesale Monthly Plan Top Down /RAP/C15A32 PS04
3.1 Wholesale Monthly Plan Initialize BOP - M /RAP/C15A32_PS05
3.1 Wholesale Monthly Plan Initialize BOP - T /RAP/C15A32_PS06
3.1 Wholesale Monthly Plan Initialize BOP - P /RAP/C15A32 PSO7
3.1 Wholesale Monthly Plan Re-calculate BOP /RAP/C15A32 PS08
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Workbook

Function

Planning Sequence

5.10TB & OTS Reconciliation

Planning sequence for Ribbon in AO

/RAP/C15A41 PS00

5.10TB & OTS Reconciliation

MP - OTB - Reconciliation

/RAP/C15A41 PSO1

5.10TB & OTS Reconciliation

MP - OTB - Reconciliation - Finalize

/RAP/C15A41 PS02

5.2 OTB & OTS Reconciliation - Season

Planning sequence for Ribbon in AO

/RAP/C15A42 PS00

5.2 OTB & OTS Reconciliation - Season

MP - OTB - Reconciliation

/RAP/C15A42 PSO01

5.2 OTB & OTS Reconciliation - Season

MP - OTB - Reconciliation - Finalize

/RAP/C15R42 PS02

Final

Queries

Query Name

Technical Name

MP - Regional Targets -

Prompt Query - PHN5

/RAP/CP15A01_QO01

MP - Regional Targets -

Sales Mix - PHN5

/RAP/CP15A01_IRQO1

MP - Regional Targets -

Season Prompt Query - PHN5

/RAP/CP15A02_Q01

MP - Regional Targets -

Season Flow - PHN5

/RAP/CP15A02_IRQO0O

MP - Regional Targets -

Season Sales Mix - PHN5

/RAP/CP15A02_IRQO1

MP - Regional Targets -

Season Flow Chart - PHN5

/RAP/CP15A02_Q00

MP - Regional Targets -

Season Flow - PHN7

/RAP/C15A03_IRQ0O0

MP - Regional Targets -

Season Sales Mix - PHN7

/RAP/CP15A03_IRQO1

MP - Regional Targets -

Season Flow Chart - PHN7

/RAP/CP15A03_Q00

MP - Regional Targets -

Prompt Query - PHN7

/RAP/CP15A03_Q01

MP - Local Targets - ECom - Sales Mix - PHN5

/RAP/CP15A11_IRQO1

MP - Local Targets - ECom - Inventory Mix - PHN5

/RAP/CP15A11_IRQO2

MP - Local Targets - ECom - Prompt Query - PHN5S

/RAP/CP15A11_QO1

MP - Local Targets - Rtl - Sales Mix - PHN5S

/RAP/CP15A21_IRQO1

MP - Local Targets - Rtl - Inventory Mix - PHN5

/RAP/CP15A21_IRQ02

MP - Local Targets - Rtl - Prompt Query - PHN5

/RAP/CP15A21_QO01

MP - Local Targets- WHS - Sales Mix - PHN5

/RAP/CP15A31_IRQO1
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Query Name

Technical Name

MP - Local Targets - WHS - Inventory Mix - PHN5S

/RAP/CP15A31_IRQ02

MP - Local Targets - WHS - Prompt Query - PHN5

/RAP/CP15A31_Q01

MP - OTB Reconciliation Report - Prompt Query

/RAP/CP15_Q001

MP - OTB Reconciliation Report

/RAP/CP15_Q01

MP - OTB Reconciliation Season Prompt Query

/RAP/CP15_Q002

MP - OTB Reconciliation Report - Season

/RAP/CP15_Q02

Workbooks 2.0

Workbook Description

Workbook Technical Name

1.1 Regional Monthly Plan

/RAP/MP_RT PHN5 M WB 01

1.2 Regional Seasonal Plan

/RAP/MP RT SSN PHNS

1.3 Regional Seasonal Plan

/RAP/MP RT PHN7 WB 01

2.1 Retail Monthly Plan

/RAP/MP RTL PHN5 WB 01

3.1 Wholesale Monthly Plan

/RAP/MP WHL PHN5 M WB 01

4.1 Ecommerce Monthly Plan

/RAP/MP_ECOM PHN5 WB 01

5.1 0TB & OTS Reconciliation

/RAP/MP OTB OTS PHN5 WB 01

5.2 OTB & OTS Seasonal Reconciliation

/RAP/MP OTB OTS PHN5 WB 02

Change aDSO Behavior

You must change the loading behavior for each aDSO. To do this, locate each object in the DataStore

(advanced) table above and right click to select |+ Planning-Specific Properties » Change Real-Time Load

Behavior... J. Select radio button Real-Time Target Can Be Planned; Data Loading Not Allowed.
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6.2.4.4 Configure SAP Merchandise Planning Local Bl
Content

6.2.4.4.1 Enable the Planning Application Kit (PAK)

Use

To be able to use the SAP Analysis for Microsoft Office workbooks provided as part of the SAP Assortment
Planning planning framework content, you must enable the Planning Application Kit.

Procedure

Read SAP Note 1637199¢% .

In your back-end system, launch table/view maintenance (transaction sM30).
Enter RSPLS_HDB_ACT in the Table/View field and choose Maintain.

Choose New Entries.

os W

In the HANA Integratn. Active column select Deep HANA Integration Active andinthe Functn. Active
column, enable the checkbox.

6.24.42 Maintain RSADMIN Parameter for Input Cells

In this procedure, you maintain the RSADMIN parameter for Input Cells in the SAP BW application to suppress
zero values for actual data versions.

Log on to your back-end system.

Open the ABAP Editor (transaction SE38).

Run program SAP_RSADMIN MAINTAIN

AW

In RSAD Table Maintenance, insert ZERO SUPPRESSION ON INPUTCELLS in OBJECT and Execute.

i Posting Instructions

Refer to 1126478 ¥

for further information.
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6.2.4.4.3 Maintain Fiscal Year Variants

Use

In this section you maintain the required fiscal year variant values for month, RM. These instructions are for SAP
Merchandise Planning 2.0 FP2 or later. In addition, the years used in the examples are to depict the relationship
between the years. You will need to create the range of years applicable for your implementation.

A Caution

SAP Merchandise Planning uses activated time objects 0F1SCPER (fiscal year period) and OFISCVARNT
(fiscal year variant), provided as part of the technical BT Content.

i Note

SAP Merchandise Planning for Retail 1.0 Workbooks supports time hierarchy YR/MON. For more
information please see Maintain Time Hierarchy [page 1941].

Procedure

Fiscal Variant RM

You must maintain 0OFISCVARNT 'RM' using the standard 12 month calendar entries. If you are using
alternative fiscal periods in your business, you can provide your own entries instead of the ones suggested in
this guide.

Log on to your back-end system.

Launch the fiscal year variant maintenance (transaction GvaRr). Choose New Entries.

In the Fiscal Year Variants view, choose New Entries.

AW

On the New Entries: Overview of Added Entries screen make the following sets of entries:

Field Name User Entry

vV RM

Description  Planning month

Calendar yr Do notselect

Year- Select
dependent

Number of 12
period

postings
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8.
9.
10.
11.
12.

13.
14.

15.
16.

17.

Field Name User Entry

No.of
special

periods

Choose Enter.

Choose Back.

You can see the newly created entry.

Mark the entry RM and select Periods from the Dialog Structure and double click to open the Calendar year
dialog.

Enter the year, for example 2014, in the Calendar yr field and choose Continue.

Choose New Entries. For the year selected to enter the information that will define each period.

Enter the last valid calendar date of the period being added in the Month and Day fields.

Enter the relevant Period number.

In the Year Shift field, enter +1 if the fiscal year is later than the calendar year enter. Enter -1 if the fiscal year
is before the calendar year.

Press Enter to accept the first row.

Continue adding each period to complete the fiscal year. Choose Save after you have finished the entries
for a year.

Continue adding the fiscal year variants for each year required by your scenario by repeating steps 2-13.

For more information about setting up the calendar for additional years, see SAP Note 2112634 # . Note
that this SAP Note is applicable for both SAP Merchandise Planning and SAP Assortment Planning.

Choose Save after you have finished the maintenance for the last year.

2015 Monthly Calendar (sample)

Month Day Period Year Shift
1 31 12 -1
2 28 1 0
3 28 2 0
5 2 3 0
5 30 4 0
6 27 5 0
8 1 6 0
8 29 7 0
9 26 8 0
10 31 9 0
11 28 10 0
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Month Day Period Year Shift

12 26 1 0

12 31 12 0

6.2.4.4.4 Generate Time Dimension

Use

In this procedure you generate the time dimension. There is a weekly and monthly time dimension required.
The steps provided in this procedure allow you to maintaintheM FISCAL CALENDAR tableinthe sys BI
schema. Perform the steps for the weekly (RW), then the monthly (RM) dimensions.

Procedure

1. Log on to your SAP HANA studio.
2. From the Quick Launch tab page, choose Generate Time Data.
3. Inthe Generate Time Data dialog, input the following values:

i Note

The sample dates are to match generated sample data. It is recommended the dates are 3 years prior
and 5 forward.

Field Value Comment
Calendar Type Fiscal
From Year 2010 Ensure that you choose the first year that you

have entered in transaction GVAR.

To Year 2020 Ensure that you choose the last year that you
have entered in transaction GVAR.

Variant RW: (Client) (Istiteration) Ensure that you choose the fiscal year variant

) ) that you have defined in transaction GVAR for
RM: (Client) (2nd iteration) ) )
the appropriate client..

4. Choose button Generate.
5. ChecktableM FISCAL CALENDARINnthe sSYS BI schema to confirm the time generation.

Return to Step 2 in the procedure and repeat the steps for the monthly dimension.
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6.2.4.4.5 Maintain Versions

In this step, you maintain the master data for the InfoObject /RAP/VERSN to support versions in workbooks.

1. Launch HANA Studio, and open perspective BW Modeler. Open your BW Project and expand BW

Repository. Navigate to | /RAP/MPOC » Aggregation Level 3. Expand any object built on /RAP/C15A*

and navigate to a query. Open the query and navigate to the InfoProvider tab.

2. Expand |l InfoProvider Fields » General . Open field /RAP/VERSN. In the Properties tab select the Master

Data link.

3. You are on the Change Master Data of InfoObject /RAP/VERSN maintenance screen.

4. Select the section below matching the scenario of workbooks you will be using to enter the correct

information.

Be sure to save your entries and close the window.

Merchandise Planning 2.0 and Above

The default workbooks are planned at product hierarchy node levels 5 and 7. Entries for those are listed in the
table below. For more information about versions see https://help.sap.com/viewer/p/CARAB | <Version> »
Administration » SAP Merchandise Planning Administration Guide » Configuration Information » Configure

SAP Merchandise Planning ¥ Implementation Tasks 3.

Merchandise Planning Versions 2.0

Version Text

Mb51 Working Version
M52 Simulation Version
M5F Finalized Version
M5R Reporting Version
M71 Working Version
M72 Simulation Version
M7F Finalized Version
M7R Reporting Version
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Merchandise Planning for Retail 1x

Merchandise Planning for Retail

Version Text
MO1 MO Working Version
MO2 MO Simulation Version
MOR MO Reporting Version
MOP MO In Season Version
MD1 MD Working Version
MD2 MD Simulation Version
MDR MD Reporting Version
MDP MD In Season Version
MP1 MP Working Version
MP2 MP Simulation Version
MPR MP Reporting Version
MPP MP In Season Version
MM1 MM Working Version
MM2 MM Simulation Version
MMR MM Reporting Version
MMP MM In Season Version
MMF MM Final Version
FO1 FO Working Version
FO2 FO Simulation Version
FOR FO Reporting Version
FOP FO In Season Version
FD1 FD Working Version
FD2 FD Simulation Version
FDR FD Reporting Version
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Version Text

FDP FD In Season Version
FM1 FM Working Version
FM2 FM Simulation Versio
FMR FM Reporting Version
FMP FM In Season Version
FL1 FL Working Version
FL2 FL Simulation Versio
FLR FL Reporting Version
FLP FL In Season Version
SAP Store Area Plan

6.2.4.4.6 Activate Internet Communication Framework

(ICF) Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Merchandise
Planning application are made available in an inactive state.

In this procedure, you activate the ICF service.

1. Log on to your back-end system.

2. Openthe HTTP Service Hierarchy Maintenance screen (transaction SICF).
Enter the following data:
Field name User action and values
Hierarchy Type SERVICE

4. Choose Execute.

5. Onthe Maintain Service screen, expand the hierarchy of Default host.

6. Expand SAP.

7. Select the BW entry.

8. From the context menu choose Activate service.

9. Inthe confirmation dialog box, choose Yes to activate all sub-nodes below the Bw node in the hierarchy.

10. Choose Back.
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6.2.4.4.7 Connect File System in SAP BW (Optional)

In this procedure, you perform the settings that are necessary for the connectivity for an external system - PC
files on the Workstation (for example Excel files) or files on the application server in SAP BW.

Log on to your back-end system.

Open the Data Warehouse Workbench: Modeling screen (transaction RSA1).
Choose Modeling.

Choose Source Systems.

In the right-hand frame, mark the entry File.

Right-click the folder of File.

Choose Create.
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Enter the following data:

Field name User action and values

Logical system name FILE

Source system name FILE

9. Choose Continue.
10. Right-click the FILE Source System.
11. Follow the context menu path Activate.

6.2.4.4.8 SAP Merchandise Planning for Retail 1.0
Workbooks

These steps are for users who have upgraded to or installed SAP Fiori 3.0 SPSO3 for SAP Customer Activity
Repository applications bundle 2.0 and are choosing to continue using the SAP Merchandise Planning for Retail
1.0 workbooks.

6.2.4.4.8.1 Maintain Time Hierarchy

The time hierarchy is used to summarize the fiscal periods for planning. In this step, you create 2 time
hierarchies: YR/MON. Use transaction RSH1 to create the hierarchies for the InfoObject 0FTSCPER. The
instructions are an example of the required steps that will be repeated for each year and time period
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InfoObject Time hierarchy example

0FISCPER e Create the ORP_FISCHIERO3 hierarchy name with the entry YR/MON in the Short

Description field.

e (Create the Year hierarchy node with Month in the Short Description.

® Choose the Year hierarchy node, and create the Year hierarchy node with the Month
in the Short Description field under the Month hierarchy node. Click continue

e (Choose the Period hierarchy node, use the Characteristic Nodes Button to insert the
Fiscal year/Period value for each period for that year.

e Continue the process for each year, month and period. Save and activate the hierarchy
when completed.

e Createthe ORP_FISCHIERO1 hierarchy name with the entry YR/MON in the Short
Description field.

e (Create the Year hierarchy node with Month value in the Short Description field.

e Choose the Year hierarchy node, and create the Month hierarchy node with Month in
the Short Description field under the period hierarchy node.

e Choose the Year hierarchy node, and create the Month hierarchy node with Month in
the Short Description field under the Period hierarchy node.

e Choose the Year hierarchy node, use the Characteristic Nodes Button to insert the
Fiscal year/Period value for each period for that month.

e Continue the process for each year, month and period as desired. Save and activate the
hierarchy when completed.

6.2.4.4.8.1.1 Maintain Fiscal Year Variants

Use

In this section you maintain the required fiscal year variant values for week and month; OFISCVARNT 'RW' and
'RM'.

A\ Caution

SAP Merchandise Planning for Retail uses activated time objects 0FTSCPER (fiscal year period) and
OFISCVARNT (fiscal year variant), provided as part of the technical BT Content.

If you are also using the SAP Assortment Planning application, you use the same fiscal year variant that
was created for this application.

Procedure

Fiscal Variant RW
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The steps provided in this procedure allow you to maintain 0FISCVARNT 'RW' using the standard 4-5-4
calendar entries. If you are using alternative fiscal periods in your retail business, for example, each week
starting on a Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in

this guide.

~ W

10.

11.

12.

13.
14.
15.

196

Log on to your back-end system.

Launch fiscal year variant maintenance (transaction GVAR).

Choose New Entries.

On the New Entries: Overview of Added Entries screen make the following sets of entries:

Field Name User Entry

vV RW

Description  Planning week

Year- Select

dependent

Calendar yr Do notselect

Number of 53
period

postings

No.of
special

periods

Choose Enter.

An information message is displayed about creating more than 16 periods, choose Continue.

Choose Back.

You can see the newly created entry.

Mark the entry RW and select Periods from the Dialog Structure.

Enter 2012 in the Calendar yr field and choose Continue.

Data for the previous year must be maintained.

Choose New Entries.

Open SAP Note 2112634#%, locate the entries for year 2012, and enter the data by copy-and-paste. Note
that this SAP Note is applicable for both SAP Merchandise Planning for Retail and SAP Assortment
Planning for Retail.

Choose Enter to finish your input.

While making the fiscal year entries, an information message might be displayed stating that there are
Gaps in financial year variant periods RW. This is an information message only, and the entered fiscal year
datais saved.

Maintain the weekly fiscal year variant in the same way for the year 2017. The entries for year 2017 are also
available in SAP Note 2112634 ¥ .

Select Shortened Fiscal Years from the Dialog Structure.
Enter 2013 in the Fiscal year field and choose Continue.

Choose New Entries.

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
PUBLIC Set Up the Applications


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2112634
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2112634

16.

17.

18.

19.

Enter 52 in the No. of posting periods field.
Choose Back twice.

Maintain the weekly fiscal year variant in the same way for the shortened fiscal years, that is, years 2013,
2014, 2015, 2016, and 2017. The corresponding tables are available in SAP Note 2112634 # .
Choose Save after you have finished the maintenance for year 2018.

Fiscal Variant RM

The next steps allow you to maintain 0FISCVARNT 'RM' using the standard 12 month calendar entries. If you
are using alternative fiscal periods in your retail business, you can provide your own entries instead of the ones
suggested in this guide. These month entries must align with the week values used in the prior step.

1
2.

© o N O

11.

In the Fiscal Year Variants view, choose New Entries.
On the New Entries: Overview of Added Entries screen make the following sets of entries:

Field Name User Entry

FV RM

Description  Planning month

Year-— Select
dependent

Calendar yr Do notselect

Number of 12
period

postings

No.of
special

periods

Choose Enter.

Choose Back.

You can see the newly created entry.

To get the information to enter in the next step, open SAP Note 2112634 #% . Note that this SAP Note is
applicable for both SAP Merchandise Planning and SAP Assortment Planning. If you have used these dates
for your weekly calendar, then align the month end dates to match. An example is contained in the table
below using the 2015 calendar entries from the SAP Note.

Mark the entry RM and select Periods from the Dialog Structure and double click to open the Calendar year
dialog.

Enter 2012 in the Calendar yr field and choose Continue.

Choose New Entries. For the year selected to enter the information that will define each period.

Enter the last valid calendar date of the period being added in the Month and Day fields.

Enter the relevant Period number.

. In the Year Shift field, enter +1 if the fiscal year is later than the calendar year enter. Enter -1 if the fiscal year

is before the calendar year.
Press Enter to accept the first row.
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12. Continue adding each period to complete the fiscal year.
Maintain the monthly fiscal year variant in the same way for the remaining years.

13. Choose Save after you have finished the maintenance for year 2018.

Choose Save after you have finished the maintenance for the last year.

2015 Monthly Calendar (sample)

Month Day Period Year Shift
1 31 12 -1
2 28 1 0
3 28 2 0
5 2 3 0
5 30 4 0
6 27 5 0
8 1 6 0
8 29 7 0
9 26 8 0
10 31 9 0
11 28 10 0
12 26 11 0
12 31 12 0

6.2.4.5 Generate Missing Data Reports

Use

There are two reports required to populated supporting tables.

Procedure

The first report will generate entries for table /RAP/RS_VARCUSTS.

e Use transaction code. SE38 and enter /RAP/SEED_BW _CUSTOMIZING DATA in the Program field. Use the
Execute button to run the report.
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The second report is only for SAP Merchandise Planning for Retail 1.0 or (1.1) and is used to set the session
client on the HANA system.

e Use transaction code. SE38 and enter /RAP/MPR_REPORTING CLIENT inthe Program field. Use the
Execute button to run the report.

6.2.4.6 Verify the Connection Between the SAP
Merchandise Planning System and SAP Analysis for
Microsoft Office

The SAP Merchandise Planning application includes several SAP Analysis for Microsoft Office workbooks.
These workbooks, which are installed on your back-end system as part of the local Bl Content, can only be
opened using SAP Analysis for Microsoft Office.

In this step, you verify that you can open the SAP Merchandise Planning workbooks from SAP Analysis for
Microsoft Office.

1. Open SAP Analysis for Microsoft Office from | Start ¥ All Programs # SAP Business Intelligence # SAP
BusinessObjects Analysis # Analysis for Microsoft Excel 4.

2. From the File menu, select | Analysis » Open Workbook (Open Workbook from SAP NetWeaver) 1.

3. Select your back-end system.
Tip: The list of systems corresponds to the systems available in your SAP Logon.

4. If single sign-on is not configured provide your user information.
5. Search for /RAP/MP* on the Search tab.

6. Open any of the workbooks from the list of SAP Merchandise Planning workbooks.
The opening of the workbook indicates that there are no issues with the connection between your back-
end system and SAP Analysis for Microsoft Office.

6.2.4.7 Retail Version 1.0 Workbooks

You may choose to use the original retail workbooks contained in this configuration.

The following topics are not used in SAP Merchandise Planning 2.0 FP2. If you are configuring for the 1.0
workbooks you must complete these next topics.

Create Geographical Location Hierarchies [page 200]
Maintain Article and Geographical Hierarchy [page 201]

Reporting Currency for Geo Hierarchy Level 2 [page 201]

6.2.4.71 Maintain BEX Variables

In this step, you maintain the variables /RAP/HIEID MSM Oland /RAP/UNIT MSM 01.To do this launch the
Query Designer and follow the steps below.

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
Set Up the Applications PUBLIC 199



1. Loginto the system desired and select the Open query icon. In the prompt, search the InfoAreas for
Merchandise, Financial Planning for Retail and select.

2. Open query Channel Mix - query/PF ( /RAP/CP11A02 IRQO1).

3. Inthe Filter panel, Characteristic Restrictions and select Hierarchy ID and expand. Choose the variable
Hierarchy ID beneath to focus the value in the Properties panel.

4. Select the Default Values tab and enter the same hierarchy id used in the Customizing activity.

5. Return to the Filter panel, Characteristic Restrictions and select Unit of Measure and expand. Choose the
variable Unit of Measure beneath to focus the value in the Properties panel.

6. Select the Default Values tab and enter the value 'PC' to represent the default unit of measure value for
pieces.

7. Save the Query and exit.

to support versions in workbooks.

6.2.4.7.2 Create Geographical Location Hierarchies

i Note

This step is relevant to SAP Merchandise Planning for Retail versions prior to SAP Merchandise Planning 2.0
FP2.

SAP Merchandise Planning for Retail supports up to 2 levels of geographical location hierarchies. For
example, you create the first level for the world regions, the second level for countries, and then the location
hierarchy. The location hierarchy node assigned to a geographical location hierarchy must be a distribution
chain hierarchy (DC), which is a type 04 or a promotion location hiearchy which is a type 05.

Do the following steps to create a geographical location hierarchy:

1. Login to the application server using SAP GUI and execute transaction code NWBC.
2. Select the Services menu.
3. Inthe left navigation menu select |» Location Services ¥ Location Hierarchy 3.
In the POWL menu on the right, select the Create button, then Market Hierarchy in the dropdown.

4. Enter the location hierarchy name, description and the master data system for your new geographical
location hierarchy.

5. Select the Editor tab.

i Note

o The Location and Import tabs are disabled.

Enter or search for the distribution chain location hierarchy or promotion location hierarchy that you want
to add to your geographical location hierarchy.

6. Add the desired DC location hierarchy or promotion location hierarchy to your geographical location
hierarchy. You may have either or both types of hierarchies added to the same geographical location
hierarchy node.

7. Save your entries.

In the example below you have two level 2 hierarchies. The level 3 hierarchies are the actual distribution chain
location hierarchies and/or promotion location hierarchies that were selected (created in a previous activity).
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e GLOBAL (GEOLEVELI)
© NORTH_AMERICA (GEOLEVEL?2)

o DC Hierarchy for Sales Org/Dist. Channel XYZ (GEOLEVEL3)
This will assign all locations for the sales org / distribution channel XYZ to North America's node.

o Promotion location hierarchy PL123 (GEOLEVEL3)
This will assign all locations for the promotion location hierarchy PL123 to North America's node.

o SOUTH_AMERICA (GEOLEVELZ2)

o DC Hierarchy for Sales Org/Dist. Channel ABC (GEOLEVEL3)
This will assign all locations for the sales org / distribution channel ABC to South America's node.

6.2.4.73 Maintain Article and Geographical Hierarchy

Use

This information is relevant to versions prior to SAP Merchandise Planning 2.0 FP2. There are two types of
hierarchies used in SAP Merchandise Planning for Retail, the geographical and the article hierarchy.

Procedure

There is a Customizing activity to define the required hierarchies. Use transaction code SPRO and in the Dialog

Structure navigate to [ Cross-Application Components » Demand Data Foundation » Basic Settings 3 and
choose Define Default Values.

® |nthe Hierarchy ID field use the prompt to select the applicable article hierarchy id.
® |nthe Geo Hierarchy ID field, use the prompt to select the applicable geo hierarchy ID.

6.2.4.74 Reporting Currency for Geo Hierarchy Level 2

This information is relevant to versions prior to SAP Merchandise Planning 2.0 FP2. The geographical hierarchy
level 2 requires a reporting currency. Do the following steps to create a geographical location hierarchy
currency:

In your back-end system, launch table/view maintenance transaction code sM30.

S I

In the Maintain Table Views: Initial Screen enter /RAP/GEOLVL CUST in the Table/view field and select the
Maintain button

Choose New Entries .

Use the F4 help to select the Geographical Level O2 desired.

Use the F4 help to select the Reporting Currency associated with the Geographical Level O2 selected.
Repeat for each Geographical Level 02 required.

N oo s W

Save your entries.
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6.2.4.7.4.1 Maintain Process Chain Related

Maintain BW process chain variants relevant for SAP Merchandise Planning for Retail.

Context

In this optional procedure, you activate the following infoobjects and maintain the BW process chain variants .

Planning: Characteristic Relationships

InfoObject Description InfoObject Name
Characteristic Rels. for Financial Merchandise Planning Plan /rRaP/MPRCO1
Characteristic Rels. for Channel Planning Plan /RAP/MPRCO2

Planning: Data Slices

InfoObject Description InfoObject Name
Data Slices for Financial Merchandise Planning, Plan /RAP/MPRCO1
Data Slices for Channel Planning, Plan /RAP/MPRC02

Process Chain Doc Process Chain

InfoObject Name

/RAP/MPPCO1 01

Process Chain Starter

InfoObject Name

/RAP/MPPCO1 01

Procedure

In this process you will create variants and activate the BW process chains.

1. Planning Sequence Data Slice Activation
1. Gototransaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A02 Ps08 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter Data Slice Activation and select the Cross-User
Variant check box.
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9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose Edit.

14. In the right tree, right click on Execute Planning Sequence Data Slice Activation (/RAP/
MPPCO01_10) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
2. Planning Sequence Deactivation of Data Slice
1. Gototransaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A02_ Ps09 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter Data Slice Deactivation and select the Cross-User
Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction rRSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose Edit.

14. In the right tree, right click on Execute Planning Sequence Data Slice Deactivation (/RAP/
MPPCO1_11) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
3. Planning Sequence Channel Mix - Actualization
1. Gototransaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A02_ PsS07 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter Channel Mix - Actualization and select the Cross-
User Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Channel Mix - Actualization (/RAP/
MPPCO01_02) and choose Maintain Variant.
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15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
4. Planning Sequence Financial Merchandise Plan - Division - Actualization
Go to transaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A07_PsS11 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter MP - Division - Actualization and selectthe
Cross-User Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Division -
Actualization(/RAP/MPPCO01_03) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
5. Planning Sequence Financial Merchandise Plan - Department - Actualization
Go to transaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A03 Ps10 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter MP - Department - Actualization and selectthe
Cross-User Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Department
- Actualization(/RAP/MPPCO01_04) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
6. Planning Sequence Financial Merchandise Plan - Class - Actualization
1. Gototransaction RSPLAN
2. Select the Planning Sequence button.
3. Inthe planning sequence field, enter /RAP/C11A08 PS10 and choose Edit button.
4. Select the Variables button.
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Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.

© N O O,

Enter a variant name. For description enter MP - Class - Actualization and select the Cross-
User Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction rRSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Class -
Actualization(/RAP/MPPCO01_05) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
7. Planning Sequence Financial Merchandise Plan - Subclass - Actualization
Go to transaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A09 PsS13 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter MP - Subclass - Actualization and select the
Cross-User Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.

11. Go to transaction RSA1.

12. In the navigation panel, select the Modeling button, then Process Chain.

13. In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

14. In the right tree, right click on Execute Planning Sequence Financial Merchandise Plan - Subclass -
Actualization(/RAP/MPPCO01_06) and choose Maintain Variant.

15. Load the variant created in step h (if not already loaded).
16. Select the Transfer button and save.
8. Planning Sequence Channel Plan - Store Comp - Actualization
Go to transaction RSPLAN
Select the Planning Sequence button.
In the planning sequence field, enter /RAP/C11A19 Ps04 and choose Edit button.
Select the Variables button.
Select the Geographical Level 1 Input help and select a value.
Select the Save As Button.
In the Variables prompt, choose F9 to turn Cross User-variant on.
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Enter a variant name. For description enter CP - Store Comp - Actualization and selectthe
Cross-User Variant check box.

9. Select the Continue button.

10. Select the Continue button in the variables screen.
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11.
12.
13.
14.

15.
16.

Go to transaction RSA1.
In the navigation panel, select the Modeling button, then Process Chain.
In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

In the right tree, right click on Execute Planning Sequence Channel Plan - Store Comp -
Actualization(/RAP/MPPCO01_07) and choose Maintain Variant.

Load the variant created in step h (if not already loaded).
Select the Transfer button and save.

9. Planning Sequence Channel Plan - Multi Store - Actualization

1
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9.

10.

11.

12.
13.
14.

15.
16.

Go to transaction RSPLAN

Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A18 Ps05 and choose Edit button.

Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.

Enter a variant name. For description enter CP - Multi Store - Actualization and selectthe
Cross-User Variant check box.

Select the Continue button.

Select the Continue button in the variables screen.

Go to transaction RSA1.

In the navigation panel, select the Modeling button, then Process Chain.

In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

In the right tree, right click on Execute Planning Sequence Channel Plan - Multi Store -
Actualization(/RAP/MPPCO01_08) and choose Maintain Variant.

Load the variant created in step h (if not already loaded).
Select the Transfer button and save.

10. Planning Sequence Channel Plan - Single Store - Actualization

206

1
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10.

11.

12.
13.
14.

15.
16.

Go to transaction RSPLAN

Select the Planning Sequence button.

In the planning sequence field, enter /RAP/C11A16 PS08 and choose Edit button.

Select the Variables button.

Select the Geographical Level 1 Input help and select a value.

Select the Save As Button.

In the Variables prompt, choose F9 to turn Cross User-variant on.

Enter a variant name. For description enter CP - Single Store - Actualization and selectthe
Cross-User Variant check box.

Select the Continue button.

Select the Continue button in the variables screen.

Go to transaction RSA1.

In the navigation panel, select the Modeling button, then Process Chain.

In the process chain panel, right click on Merchandise Planning - Actualization and choose edit.

In the right tree, right click on Execute Planning Sequence Channel Plan - Single Store -
Actualization(/RAP/MPPCO01_09) and choose Maintain Variant.

Load the variant created in step h (if not already loaded).
Select the Transfer button and save.
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6.2.5 Configure Data Replication Steps

6.2.5.1

Use

Initial Load of Data to DDF Using DRFOUT

SAP Merchandise Planning uses master data, such as product, location, and product hierarchy, that is
replicated from SAP ERP to the DDF module in SAP Customer Activity Repository using the DRFOUT data

replication framework.

i Note

Not all of the master data is replicated into DDF using DRFOUT. Some data must be replicated separately

using SLT replication.

SAP Merchandise Planning requires that the following master data is replicated from a connected SAP ERP

system using DRFOUT:

Sequence Master Data Technical Details For more information, see:
1 Product Hierarchy ® SAP ERP Description: Material Group http://help.sap.com/car&'w <your
Hierarchy
. release> > Application Help > <> >
e DRFOUT Outbound Implementation:
PMCH Demand Data Foundation  Integration
e DDF Inbound Interface: /pDMF/ Information > Inbound Interfaces For
MDIF PROD HIER INBOUND Remote Function Call (RFC)
Communication > Product Hierarchy
Master Data }
2 Product e SAP ERP Description: Material

DRFOUT Outbound Implementation:
PMAT

DDF Inbound Interface: /DMF/
MDIF PRODUCT INBOUND

http://help.sap.com/car!‘}l} <your
release> > Application Help > Demand

Data Foundation > Integration Information

> Inbound Interfaces For Remote Function

Call (RFC) Communication > Product
Master Data }
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Sequence Master Data Technical Details For more information, see:
3 Location * SAPERP Description: Plant http://help.sap.com/car | <your
e DRFOUT Outbound Implementation: o
- release> > Application Help > Demand
e DDF Inbound Interface: /DuF/ Data Foundation > Integration Information
MDIF LOCATION INBOUND > Inbound Interfaces For Remote Function
Call (RFC) Communication @ Product
Location Master Data }
4 Product Location ~® SAP ERP Description: Material/Plant http://help.sap.com/car'h'l} <your
e DRFOUT Outbound Implementation: o
release> > Application Help > Demand
PMPL
e DDF Inbound Interface: /DM, Data Foundation > Integration Information
MDIF_ PROD LOC_INBOUND > Inbound Interfaces For Remote Function
Call (RFC) Communication » Product
Location Master Data }
5 Product Location ~® SAP ERP Description: Sales Price http://help.sap.com/car [P <your
e DRFOUT Outbound Implementation: o
bspR release> > Application Help > Demand
e DDF Inbound Interface: /DuF/ Data Foundation > Integration Information
MDIF_ PROD LOC_INBOUND ¥ Inbound Interfaces For Remote Function
Call (RFC) Communication > Product
Location Master Data }
6 Inventory ® SAP ERP Description: Inventory http://help.sap.com/car |l <your
e DRFOUT Outbound Implementation: o
- release> > Application Help > Demand
e DDF Inbound Interface: /DuF/ Data Foundation > Integration Information
OPIF INVENTORY INBOUND » Inbound Interfaces For Remote Function
Call (RFC) Communication > Inventory
Master Data }
7 Product Location ~® SAP ERP Description: Moving Aver- http://help.sap.com/car P |p <your
age Price
. release> j» Application Help ¥ Demand
e DRFOUT Outbound Implementation:
PMAP Data Foundation # Integration Information
e DDF Inbound Interface: /DMF/ > Inbound Interfaces For Remote Function
MDIF_PROD_LOC_INBOUND Call (RFC) Communication ¥ Product
Location Master Data ]
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Sequence Master Data

Technical Details

For more information, see:

9 Location ¢ SAP ERP Description: Vendor http://help.sap.com/car | <your
e DRFOUT Outbound Implementation: o
release> > Application Help > Demand
PVEN
e DDF Inbound Interface: /DuF/ Data Foundation > Integration Information
MDIF LOCATION INBOUND > Inbound Interfaces For Remote Function
Call (RFC) Communication ¥ Location
Master Data }
10 Product Hierarchy ® SAP ERP Description: Article Hierar- http://help.sap.com/car'h'l} <your
chy
. release> > Application Help > Demand
e DRFOUT Outbound Implementation:
PAHY Data Foundation » Integration Information
e DDF Inbound Interface: /pME/ > Inbound Interfaces For Remote Function
MDIF_PROD_HIER INBOUND Call (RFC) Communication » Product
Hierarchy Master Data 4
Prerequisites

Before replicating data from SAP ERP to DDF using DRFOUT, the following prerequisites must be fulfilled:

e The following business functions are activated in SAP ERP:
O0 ISR APPL OUTBOUND DMF

© ISR RETAIL OUTBOUND DMF

® You have noted the different terms for the following objects:

DDF / SAP Merchandise Planning

SAP ERP SAP Retail for Retail
Material Article Product
Plant Site Location

6.2.5.2

Use

Initial Load of Sales Data from BW

If you have accumulated large amounts of historical sales data using SAP POS Data Management or SAP

Customer Activity Repository, it is possible that you are storing these large data sets in a connected SAP BW
system. In such a case, you can perform the initial load of the sales time series (historical POS data) data into
DDF using the Bl Interface for Time Series report.

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0

FPSO1
Set Up the Applications

PUBLIC 209


http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fcar
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Fcar

i Note

These instructions extract historical sales data from an Infocube in BW. If you are using BW/4HANA,
additional project work will be required to re-implement the BAdl /DMF/BI_IF READ BI. For technical
details, see 2764634 ¥ .

Procedure

Log on to your back-end system.
Execute transaction SE38.
Specify /DMF/BI_IF_TS in the Program field and choose Execute.

AW

Read the documentation associated with the report, carry out the described customizing, and run the
report accordingly.

More Information

http://help.sap.com/carf| Application Help » Demand Data Foundation ¥ Integration Information » Inbound
Interfaces For Remote Function Call (RFC) Communication  Sales Time Series 3.

6.2.5.3 Initial Load of Goods Movement KPIs

Load goods movement Key Performance Indicators (KPI) for returns, receipts, and open quantity.

Context

The goods movement data is stored in the SLT replicated tables EKPO, EKET, EKBE, MARA, and MARM in the
Customer Activity Repository. You perform the initial load of this data into Demand Data Foundation (DDF)
using the report /RAP/MPR_ECC_KPI_CALC. When run in initial mode, this report will load 2 years of data from
the current date. Further information is available in the documentation attached to the report.

In addition there are some prequisite steps to follow.

® You have maintained fiscal year variants using SPRo. Navigate to |F SAP Customizing Implementation
Guide ¥ Cross-Application Components » Demand Data Foundation § Basic Settings # Define Default
Values 3.
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Procedure

1. Logon to your back-end system.

2. Verify your user has the role /RAP/BW MPR_WORKBOOKS assigned.

3. You have maintained fiscal year variants using SPro. Navigate to | SAP Customizing Implementation
Guide » Cross-Application Components » Demand Data Foundation }» Basic Settings ¥ Define Default
Values 3.

4. Execute transaction SE38.

5. Specify /RAP/MPR_REPORTING CLIENT inthe Program field and select Execute.

6. Specify /RAP/MPR_ECC_KPI_CALC in the Program field, select radio button Initial and select Execute.

Next Steps

It is recommended you run this report weekly to update the aggregated KPIs with the ongoing ERP activity

6.2.5.4 Initial Load of Sales Orders and Shipments

Load replicated data for sales orders and shipments to Demand Data Foundation (DDF) table /DMF TS WS.

The sales order and shipment data is stored in the SLT replicated tables LIKP, LIPS, VBAK, VBAP, VBEP, VBPA,
VBKD, KONV, VBFA and MSEG. in the Customer Activity Repository. You perform the initial load of this data into
DDF using the /DMF/WHOLESALE_SO_SHP_TO_TS_WS report. Use transaction sE38 to execute or display
documentation for the report.

When you execute the report you select the following:

® The Master Data Logical System (mandatory).

® force Initial Run. Check box, not required for the true initial execution. (Used to reinitialize data. This will
force delete all entries previously processed and re-populate TS_WS).

® Past Days for Initial Load. When the report is run the first time it will default to initial mode and will load any
sales orders and shipments created or modified with a date greater than or equal to the date resulting from
the calculation of current date minus the value in this field. This value is also required if you have checked
Force Initial Run.

e Past Days to Check Deletions specifies how far back in days to look for deleted sales orders or shipments.
This allows the customer to go back as far as needed for potentially deleted documents without processing
data that may have been archived already in ECC.

i Note

This report should be run on a recurring cycle based on your activity.
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6.2.5.5 Delta Load of Data to DDF Using DRFOUT

We recommend that you schedule a weekly periodic task to replicate inventory data (outbound implementation
PINV) from the SAP ERP system to the system for SAP Merchandise Planning. This replication builds up the
inventory history data that is needed by SAP Merchandise Planning.

6.2.5.6 Delta Load of Sales Data in SAP Customer Activity
Repository

Use

Once the initial load of historical sales data is completed or, if you are working on a brand new system
implementation and do not have to perform an initial sales data load, you need to configure the periodic delta
load of sales data in SAP Customer Activity Repository.

Procedure

1. Ensure that you have properly configured the POS Sales Transfer and Audit functionality in SAP Customer
Activity Repository to receive transaction data from your connected POS systems.

For more information, see https://help.sap.com/viewer/p/CARAB#|» <Version> ¥ Application Help

SAP Customer Activity Repository ¥ POS Data Transfer and Audit 4.
2. Ensure that you have configured the Supply - DMF-Based Applications outbound tasks to load sales data
from POS Sales Transfer and Audit to DDF.

For more information, see https://help.sap.com/viewer/p/CARAB# | <Version> » Application Help »
SAP Customer Activity Repository i POS Data Transfer and Audit » Task Processing » Tasks for Sending
Data to Follow-On Applications 3.

- Recommendation

If you are not storing aggregated sales data in an SAP BW system, and have historical sales data that
you would like to load into DDF from POS Sales Transfer and Audit, you can configure the Supply - DMF-
Based Applications outbound tasks to perform this initial load.

3. Monitor the transfer of sales time series data as described in https://help.sap.com/viewer/p/CARAB #r
| <Version> » Application Help » SAP Customer Activity Repository » Demand Data Foundation »

Integration Information ¥ Inbound Processing 3.
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More Information

https://help.sap.com/viewer/p/CARAB# |» <Version> ¥ Application Help » SAP Customer Activity Repository
» Demand Data Foundation  Integration Information » Inbound Interfaces For Remote Function Call (RFC)

Communication ¥ Sales Time Series 3.

6.2.5.7 Delta Load of Goods Movement KPIs

Once the initial load of historical goods movement KPIs data is completed you should continue to update your
data on arecurring basis. As data is replicated from SAP ERP activity, the values for goods movement KPIs can
only be added to the Demand Data Foundation when you execute the report /RAP/MPR_ECC_KPI_CALC. The
delta load sets the timeframe to start one month (30 days) prior to the current date and one year in the future
from the current date.

To execute the report, log on to your back-end system and execute transaction SE38. Specify /RAP/
MPR_ECC_KPI_CALC in the Program field and use the Execute button. Select radio button Delta and select
Execute. For further information see the documentation attached to the report by selecting Documentation,
Display on the ABAP Editor: Initial Screen.

6.2.5.8 Delta Load of Sales Orders and Shipments

Load replicated data for ongoing sales orders and shipments to Demand Data Foundation (DDF) table /
DMF TS WS

The sales order and shipment data is stored in the SLT replicated tables LIKP, LIPS, VBAK, VBAP, VBEP, VBPA,
VBKD, KONV, VBFA and MSEG. in the Customer Activity Repository. You perform the delta load of this data into
DDF using the /DMF/WHOLESALE_SO_SHP_TO_TS_WS report. Use transaction SE38 to execute or display
documentation for the report.

When you execute the report you select the following:

e The Master Data Logical System (mandatory).

e force Initial Run. Check box unchecked for delta mode.

® Past Days for Initial Load. When the report is run the first time it will default to initial mode and will load any
sales orders and shipments created or modified with a date greater than or equal to the date resulting from
the calculation of current date minus the value in this field. This value is also required if you have checked
Force Initial Run.

e Past Days to Check Deletions specifies how far back in days to look for deleted sales orders or shipments.
This allows the customer to go back as far as needed for potentially deleted documents without processing
data that may have been archived already in ECC.

i Note

This report should be run on a recurring cycle based on your activity.
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6.2.5.9 Replicate SAP ERP Tables for SAP Merchandise
Planning

Use

Verify that all SAP ERP or SAP S/4HANA tables that are relevant for SAP Merchandise Planning KPIs have not
only been created but have also been filled with data.

i Note
You have already replicated all of the relevant tables in a prior step, Create/Replicate Source Master Data

System Tables [page 76].

In particular, SAP Merchandise Planning requires that the following master data table are replicated in order to
calculate KPls:

Master Data SAP ERP Table
General Material Data MARA

Units of Measure for Material MARM
Purchasing Document Item EKPO

History per Purchasing Document EKBE
Scheduling Agreement Schedule Lines EKET

6.2.6 Create Market Hierarchy

SAP Merchandise Planning supports market hierarchies, a logical structuring of selling locations (stores,
wholesale customers, digital customers) that align with your goals for planning.

The market hierarchy allows you to group locations by markets or across multiple sales organizations. In
addition, your Area of Responsibility (AOR) must be aligned with your market hierarchy before using the
planning applications. Do the following steps to create a market hierarchy:

1. Loginto the application server using SAP GUI and execute transaction code NWBC.
2. Select the Services menu.
3. Inthe left navigation menu select |» Location Services ¥ Location Hierarchy 3.
In the POWL menu on the right, select the Create button, then Market Hierarchy in the dropdown.
4. Enter the location hierarchy name, description and the master data system for your new hierarchy.
5. Select the Editor tab. Enter or search for the locations that you want to add to your market hierarchy.
6. Add the locations to your market hierarchy by selecting the row or rows and selecting the move arrow.
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i Note

The same location ID cannot be used more than once in a market hierarchy. For example location ID
ABC can exist as multiple location types. It can exist as a distribution chain (DC) type, a store type, and
a customer type. You may not have the type of DC and store in the same hierarchy

7. Save your entries.

More Information

For more information regarding location and market hierarchies, see Maintain Location Hierarchies located at
https://help.sap.com/viewer/p/CARAB | <version> » Application Help ¥ SAP Customer Activity Repository
applications bundle » Demand Data Foundation ¥ General Services » Maintenance Services 4

For more information about AOR see Maintain Area of Responsibility located at https://help.sap.com/viewer/p/
CARAB | <version> » Application Help » SAP Customer Activity Repository applications bundle » Demand
Data Foundation » General Services 3.

6.2.7 Specify Analysis Workbook Settings

6.2.71 Enable Macros

Use

In this procedure, you enable your SAP Analysis for Microsoft Office workbooks to use macros.

Procedure

1. Open the SAP Analysis for Microsoft Office from | Start » All Programs » SAP Business Intelligence »
Analysis for Microsoft Excel 3.

Choose | File » Options ¥ Customize Ribbon 3.

Under Customize the Ribbon, select Main Tabs.

Enable the entry Developer and confirm by choosing OK.

Now you will see the new Developer tab in your SAP Analysis for Microsoft Office.

o oA WD

Select the Developer Tab and choose Macro Security.
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7. Choose Enable all macros.

6.2.7.2 General Workbook Settings

Use

You use SAP Analysis for Microsoft Office to launch the planning workbooks.

Procedure

If you are unable to see the Analysis , MP Selection, and MP Info options on the menu of Analysis for Microsoft
Excel, perform the following steps in the Options, Add-Ins of the Excel options:
1. Enter coMin the Manage field and choose Go.

2. Inthe coM Add-1Ins box, select the Analysis and Planning options and choose Go. If you do not find them
in the list, Enter Disabled in the Manage field and choose Go.

Now you are able to view the Analysis , MP Selection and MP Info options.

6.3 SAP Assortment Planning

i Note

Some of the activities in this section may have already been performed in the corresponding section under
SAP Customer Activity Repository. Such activities do not need to be repeated during the setup and
installation of consuming applications.

The following diagram depicts the main steps of the post-installation process for SAP Assortment Planning and
contains links to the descriptions of these steps. There are two further steps in the back-end system following
Configure Assortment Planning [page 218]:

e Maintain Fiscal Year Variant for Retail Week [page 219]
e Generate Time Data - Fiscal Calendar [page 223]
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e Perform Core Steps for SAP Customer Activity Repository [page 168]

e Configure Assortment Planning [page 218]
e Activate Planning Framework Content (SAP Assortment Planning) [page 224]

e (Configure Data Replication [page 233]
® Run the Validation Report [page 233]

e Perform General SAP Gateway Configuration [page 89]

e Configure SAP Fiori Launchpad [page 96]

e Activate OData Services [page 91]

e Activate SAP Assortment Planning ICF Services [page 235]

e Define System Alias for Back-End Transactions [page 236]

® Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad [page 237]

e Configure Index Calculation [page 235]
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6.3.1 Perform Core Steps for SAP Customer Activity

Repository

To set up this application, you must first perform the Core (Mandatory) steps for SAP Customer Activity
Repository. The core steps are mandatory for all the consuming applications.

Procedure

Perform all steps listed under Core (Mandatory for All Applications) [page 67].

6.3.2 Configure Assortment Planning

Use

To use SAP Assortment Planning, you must define several application-specific settings in Customizing.

Procedure

218

Specify assortment list settings.

In the Assortment List Settings Customizing activity, found under |» Cross-Application Components
Assortment Planning j Assortment Lists J, you can specify general settings for assortment lists. For
example, you can define whether you can assign an assortment list product to more than one module.
Verify settings under |» Cross-Application Components  Assortment Planning # Imported Demand Data

Foundation Settings 3.

Although you might have specified most of these settings when configuring DDF, the activities under
Imported Demand Data Foundation Settings are particularly important for the SAP Assortment Planning
application.

Define the required number ranges.

You must set all of the number ranges under | SAP Customizing Implementation Guide ¥ Cross-
Application Components » Assortment Planning » Number Range .

Define the business week (using transaction SPRO) under | Cross-Application Components  Demand
Data Foundation ¥ Basic Settings ¥ Define Business Week 3.

Verify the default implementations of BAdIs under [» SAP Customizing Implementation Guide » Cross-

Application Components » Assortment Planning ¥ Enhancements Using Business Add-Ins 3, and if
necessary, provide custom implementations.
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i Note

We recommend that you activate BAdl implementations that enable the use of the Omnichannel SAP
BW Structure. For more information, see Activate Planning Framework Content (SAP Assortment
Planning) [page 224].

6. To use forecasted values in the Sales & Inventory Analysis view within the My Assortment Lists app,
configure Unified Demand Forecast (UDF). For more information, see the SAP Customer Activity Repository
Administration Guide, section Configuring Unified Demand Forecast (UDF).

Related Information

Configuration Information

6.3.3 Maintain Fiscal Year Variant for Retail Week

Use

In this procedure you maintain the required fiscal year variant ( OFISCVARNT 'RW'). SAP Assortment Planning
uses time objects 0FISCPER (fiscal year period) and 0OFISCVARNT (fiscal year variant), provided as part of the
technical Bl Content, and activated in the Activate Technical Content [page 224] procedure.

A\ Caution

You must maintain fiscal year variants for a period far enough into the past and into the future to cover the
full range required for your planning activities. For example, two years into the past and five years into the
future.

The steps provided in this procedure allow you to maintain OFISCVARNT 'RW' using the standard 4-5-4
calendar entries. If you are using alternative fiscal periods in your retail business, for example, each week
starting on a Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in
this guide.

Procedure

1. Logon to your back-end system.
2. Launch fiscal year variant maintenance (transaction GVAR).
3. Choose New Entries.
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10.

11.

12.

13.

14.
15.
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On the New Entries: Overview of Added Entries screen make the following sets of entries:

Fiscal year variants ‘

_|FV Description Year-depen... Calendar yr Number of postin... No.of special peri [
RW Assort. Plan Week ™ ] Is3 -
i r

o
Create New Fiscal Year Variant

Choose Enter.

An information message is displayed about creating more than 16 periods, choose Continue.

Choose Back.

You can see the newly created entry.

Mark the entry RW and select Shortened Fiscal Years from the Dialog Structure.

Change View "Fiscal year variants": Overview
&2 NewEnties [ B » E. B B

Dialog Structure Fiscal year variants
M F'Lsmly.earvariants FV Description calen... Year-... Mumber of... No.of spe... Fiscal.. Offset ... Offset
Per!ods Kl cal Year, 1 Special .. 12 1 "~
Period texts 2 I ol 13 5 -
| Shortened Fiscal Year5| Cal. Year, 2 Spedal .| I
K3 Cal Year, 3 Special .. 12 3
K4 Cal. Year, 4 Special .. 12 4
= Assortm. Plan Week v 53

Shortened Fiscal Years in Dialog Structure
In the Fiscal year dialog, enter the year (for example, 2015 ) in the Fiscal year field and choose Continue.
On the Change View "Shortened Fiscal Years": Overview screen, choose New Entries.
In the Shortened Fiscal Years table, enter 52 in the No. of posting periods field.
Choose Back twice.
On the Change View "Fiscal Year variants": Overview screen, mark the entry RW and select Periods from the
Dialog Structure.
In the Calendar yr dialog, enter the year (for example, 2015 ) in the Calendar yr field and choose Continue.
Data for the previous year must be maintained.
On the Change View "Periods": Overview screen, choose New Entries.
In the Periods table, enter the data (month, day, period, year shift) for each period according to your fiscal
calendar. For an example, see the following table. For more examples, see SAP Note 2112634 # . If you
want to copy data from this note, locate the required year and enter the data by copy-and-paste.

2015 Weekly Calendar
Month Day Period Year Shift
1 3 48 -1
1 10 49 -1
1 17 50 -1
1 24 51 1
1 31 52 -1
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Month Day Period Year Shift

16. Repeat steps 7-15 to maintain the weekly fiscal year variant for all of the required years, entering each year
as shortened fiscal year. The corresponding tables are available in SAP Note 2112634 #r .

17. Choose Save.

18. Launch transaction RSREIERARCHYVIRT and ensure that the dates specified in the From and To fields
under Time Interval cover the years maintained for the fiscal year variant in the previous steps.

6.3.4 Maintain Fiscal Year Variant for Month

Context

In this section, you maintain the required fiscal year variant values for the fiscal month, 'rRM'. This is especially
required for using the Sales & Inventory Analysis view in the My Assortment Lists app.

A\ Caution

You must maintain fiscal year variants for a period far enough into the past and into the future to cover the
full range required for your planning activities. For example, two years into the past and five years into the
future.

If you are using alternative fiscal periods in your retail business, you can provide your own entries instead of the
ones suggested in this guide.

Procedure

1. Log on to your back-end system.

2. Launch fiscal year variant maintenance (transaction GVAR).

3. Choose New Entries.

4. Onthe New Entries: Overview of Added Entries screen make the following sets of entries:
Field Name User Entry
FV RM
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Field Name User Entry

Description Planning month
Calendar year Do not select
Year-dependent Select

Number of posting periods 12

No. of special periods

5. Choose Enter.
6. Choose Back.

You can see the newly created entry.

To get the information to enter in the next step, open SAP Note 2112634 # .

7. Mark the entry RM and select Periods from the Dialog Structure and double click to open the Calendar year
dialog.
Enter the year (for example, 2015) in the Calendar yr field and choose Continue.

9. Onthe Change View "Periods": Overview screen, choose New Entries.

10. In the Periods table, enter the data (month, day, period, year shift) for each period according to your fiscal
calendar. For an example, see the following table.

2015 Monthly Calendar (sample)

Month Day Period Year Shift
1 31 12 -1
2 28 1 0
3 28 2 0
5 2 3 0
5 30 4 0
6 27 5 0
8 1 6 0
8 29 7 0
9 26 8 0
10 31 9 0]
1 28 10 0
12 26 1 0
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Month Day Period Year Shift

12 31 12 0

11. Enter the last valid calendar date of the period being added in the Month and Day fields.

12. Enter the relevant Period number.

13. In the Year Shift field, enter +1 if the fiscal year is later than the calendar year enter. Enter -1 if the fiscal year
is before the calendar year.

14. Press Enter to accept the first row.

15. Continue adding each period to complete the fiscal year. Choose Save after you have finished the entries
for a year.

16. Continue adding the fiscal year variants for each year required by your scenario by repeating steps 3 to 15.

17. Choose Save after you have finished the maintenance for the last year.

6.3.5 Generate Time Data - Fiscal Calendar

In this procedure, you generate time data (Fiscal calendar) required for SAP Assortment Planning.

Use

Execute this procedure to generate time data (Fiscal calendar). This is especially required for using the Sales &
Inventory Analysis view in the My Assortment Lists app.

Procedure

1. Logonto SAP HANA studio.

2. Inthe Modeler perspective, on the Quick Launch tab, select your SAP Customer Activity Repository
applications bundle system and choose Generate Time Data.

3. Select Fiscal as the Calendar Type.

4. Enter the same range of years as defined in the previous procedure, Maintain Fiscal Year Variant for Retail
Week [page 219].

5. Inthe Variant Schema field, enter the name of the database schema that contains the tables holding the
fiscal year variant data.
For SAP Assortment Planning, these are tables T009 and T0098B, which you filled with data in the previous
procedure, Maintain Fiscal Year Variant for Retail Week [page 219].

6. Select the RW fiscal year variant, defined in the previous procedure, Maintain Fiscal Year Variant for Retail
Week [page 219].

7. Choose Generate.
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For more information, see:

e https://help.sap.com/viewer/p/SAP_HANA_LIVE | Installation and Upgrade » Administrator's Guide
Configuration Steps » Generate Time Data J

e https://help.sap.com/viewer/p/SAP_HANA_PLATFORM | Development # SAP HANA Modeling Guide (for
SAP HANA studio)  Creating Information Views and Previewing its Output » Generate Time Data 3

6.3.6 Activate Planning Framework Content (SAP
Assortment Planning)

In a new installation, only the Omnichannel SAP BW structure is supported in SAP Assortment Planning. The
Retail SAP BW Structure is supported in an existing installation with maintenance, however no new
functionality will be developed for this structure.

Prerequisite
To use the Omnichannel SAP BW structure, the following prerequisites must be met:

e Fnable the usage of planning configurations under | Cross-Application Components » Assortment

Planning ¥ Imported Demand Data Foundation Settings » Basic Settings » Define Default Values 3. The
Omnichannel SAP BW structure only works when planning configurations are used.

e |fyou are integrating with SAP Merchandise Planning, enable the implementation of BAdI: Read
Merchandise Planning KPI Data under |» Cross-Application Components  Demand Data Foundation  Data

Maintenance » Planning Configuration » Enhancements Using Business Add-Ins 3.

The Omnichannel SAP BW structure consists of local Bl Content only. To create workbooks on top of the
Omnichannel SAP BW structure, contact SAP Digital Business Services for a custom implementation project.

The following subsections describe the activation steps.

6.3.6.1 Activate Technical Bl Content

Use

The first time you enter the Data Warehousing Workbench, the system runs a background job to activate
technical content. Technical content consists of technical information that is generated by the system, for
example, data required for the general operation of Bl Content, or time data.

Procedure

1. Onyour back-end system, open the Data Warehousing Workbench (transaction RSA1).
2. If prompted, in the Replicate Metadata dialog box, choose Only Activate.
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3.

4.
5.

6.

If a message appears that you are only authorized to work in client ... (Brain 009), then refer to SAP Note
316923 (do not import the support package, but use the description under section Workaround).
Select Do not show this question Again in the dialog that appears.

Choose Yes.

Make sure that the current job has finished before you proceed with the next step. Check the status of the
background job using transaction sM370r S1.G1. If there are problems, you must first solve them.

i Note

If you get the short dump "RAISE_EXCEPTION" when installing InfoObjects from the Bl content, see
SAP Note 1637935#% for a possible solution.

Also, see SAP Notes 2090845/% and 2056106/ for important information on technical content
activation.

Following activation, you can locate the technical content in the Data Warehousing Workbench as follows:
1. Selecting Modeling in the left-hand frame.

2. Expand InfoObjects.

3. Intheright-hand frame, locate Technical Content.
You can use transaction RSTCO ADMIN to restart the activation of the technical content and to verify the
status of the activation.

6.3.6.2 Enable Optimized In-Memory Planning Capabilities

of SAP BW Integrated Planning

Use

To be able to use the SAP Analysis for Microsoft Office workbooks built on top of the SAP Assortment Planning
planning framework content, you must enable the optimized in-memory planning capabilities of the integrated
planning engine in SAP Business Warehouse (SAP BW Integrated Planning). This includes the enabling of the
Planning Application Kit (PAK).

Procedure

o s W

Read SAP Note 1919631 #% .

In your back-end system, launch table/view maintenance (transaction sM30).

Enter RsPLS HDB_ ACT in the Table/View field and choose Maintain.

Choose New Entries.

In the HANA Integratn. Active column select Deep HANA Integration Active andinthe Functn. Active
column, enable the checkbox.

In the HANA Integratn. Active column select BPC Embedded Model Active and inthe Functn. Active
column, enable the checkbox.
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6.3.6.3 Activate Application Bl Content (Omnichannel SAP
BW Structure)

Context

In this procedure, you perform a sequential, step-by-step activation of the local Bl Content objects delivered in
the Omnichannel SAP BW structure of the SAP Assortment Planning application. SAP Assortment Planning
uses this application Bl Content to consume data stored in the back-end system

i Note

To ensure correct activation of the Bl Content objects, carry out the activation sequentially, as specified in
the following procedures. Resolve any activation warnings, except for the ones listed under Result [page
233], which can be ignored.

Also, do not disable the default Bl setting to collect and activate all dependencies. The instructions below
activate a minimum subset of objects, and it assumed that all their dependencies are collected and
activated.

The consumed data from the back-end system can be created by the SAP Assortment Planning application, or
be replicated from a source master data system. In both cases, beware of limitations with regard to the
characters allowed by SAP BW. For more information, see:
e SAP Assortment Planning Administration Guide under Initial Load of Data to DDF Using DRFOUT
o 173241#
e Customizing activity Maintain permitted extra characters under | SAP NetWeaver » Business Warehouse ¥
General Settings 3.

Procedure

1. Onyour back-end SAP Assortment Planning system, open the Data Warehousing Workbench (transaction
RSAL).
2. \Verify transport connections.
1. Select Transport Connection in the left-hand frame.
2. Select Object Types.
3. Expand Source System.
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Data Warehousing Workbench: Transport Connection

O T2 TacCollected & Spelete A& Zcto [ Econversion | GBBEx  Ehobject Changeabiity  Switch (Business Functions)

[ Modeing ] ;@[ﬁyemupng .J[B5]( package || Collection Mode .|[ Displar *
| Administration 1| a1 objects A ording to Type Collected objects | T | Technical name | Elevated... | Last... |
|  Transport Connection ]l » 4 InfoArea
L v & Application

~ €3 5AP Transport : g ::I:Oh’m Catalog

- @ InfoProviders by InfoAreas

. & InfoObjects by InfoAreas

- & InfoSources by Applcation Component
+ @ Roles

- [ Object Types
Tansport Reque
- (@ Packages
* B ML

= [ export
+ @ InfoProviders by InfoAreas
» & InfoObjects by InfoAreas
« & InfoSources by Appication Component
- @ Roles
+ (1 Object Typas
+ B Transport Request
~ @@ Packages

* 95 BEx Web Template

» [1# BEx Web Irem

v [E) crystal Report

» @3 Xcelsius Dashboard

» [ Enterprise Report

v E Workbook

v [ Query View

v [H query Elements

* & Broadeast Setting

» % CompositeProvider

» [ Open ODS View

* 2 SAP HAMA Analysis Process

v @& MultiProvider

+ B8 Infoset

v & HybridProvider

» [ semantically Partitioned Object
» €9 InfoCube

» @ Datastore Object (Advanced)
v & infoobject

v P Transformation

v+ & InfoSource
b [ED

"% Open Hub Destination
+ BB Data Flow
* (@) InfoPackage
» &) Data Transfer Process
v @3 process Chain
» [ Processes

» 3 Panning

Selecting Source Systems

4. Use Select Objects to ensure that the back-end system is selected as the source system.

5. Choose Transfer Selections.

6. Atthe top of the right-hand frame, above the list of Collected objects, choose Grouping and select Only

Necessary Objects.

7. Atthe top of the right-hand frame, choose Collection Mode and select Collect Automatically.
Data Warehousing Workbench: Transport Connection

O Te Tacokcted S E O Doekte & Lcro [Elconversion  BhBEx [ Object Changeabiity  Switch (Business Functions)
[_modeing (@ | ¥ Grouping .|| ]| Packege | colection Mode .| Dispay .|
[ A o Al Objects Accordng to Type Collected objects | T| Technical name | Elevated... | Last.. | LestCha.. Tt
| Transport Connection + & Infosource
B g DataSource
= all* Source System
5185 Tasput « | * # Open Hub Destination
* @& Infoproviders by InfoAreas + BF Data Flow
+ A nfnnhiects by TnfnAreas » Bl TnfaPackans
Grouping and Collection Settings
3. Determine if you need to enable to Match (X) or copy option for the Bl Content, which you will activate in
the subsequent steps.
Match(X) or copy Selection
Installation Type Selection
New Installation Do not enable the Match (X) or copy option for any of the Bl Content objects.
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Installation Type Selection

Upgrade Standard /rap/* Bl Content ob- Standard /rap/* Bl Content objects have been
jects have not been modified in modified in your local environment!

(Previously installed/ . 1
your local environment

activated any of
the /rap/* Bl Content) Do not enable the Match (X) or copy  Enable the Match (X) or copy option.
option for any of the Bl Content ob-

) During the activation of each Bl Content object type,

jects. you will be asked to carry out an additional Transfer
selections step. In this step, select to install the
Active Version (that is, your modified version) or the
Content Version (that is, the SAP delivered, and pos-
sibly updated version of the object). The project im-
plementation team should advise you on which op-

tion is required for each object.

A Caution

When you choose to install the Content Version,
the SAP delivered objects included in the current
release will be installed regardless of any modifi-
cations made to the currently existing Bl Con-
tent objects.

1 As a system administrator, you may need to contact the SAP Assortment Planning project implementation team to
learn if standard, SAP-delivered, Bl Content objects have been modified in your local environment.

& Data Warehousing Workbench ~ Edt  Goto  System  Help

[ v | « e [i1] S8 e
Data Warehousing Workbench: BI Content

| =|g ?-gtulzﬂed @ 20 Clelete /[ mCI'O %BEx s Object Changeabity  Switch (Business Functions)

[ Modeing | [F= ] |75 [+ Grouping l# Instal .| _Colection Mode [ Display .|I[ff>
| Admini | | Al Objects According to Type Technical Name S. Colected Objects T S.  A. Technical name =3
| Transport Connection | i ” InfoArea AREA = Match (X) or copy
] » 4, Appication APCO -
[ Documents » &2 InfoObject Catalog |roBC
[ BI content | | » @ Role |ACGR
» ©= BEx Web Template |BTMP
+ (8 InfoProviders by InfoAreas & IE gEx :’IE: Ite:' ?PIATB
. A - » |4 Crystal Repol |
A Infolibjects bydinfofiess + = Xcekus Dashboard xcts
+ € InfoSources by Application Component » [ Enterprise Report |ERPT
. G Roles » ﬁ Workbook |XLwB
B Object Types » 5 Query View uiw

4. Activate InfoObject catalogs.

If at any point during the installation of Bl Content objects you are presented with a dialog asking you to
add objects to a personal list, we recommend that you select No.

- Remember

You can ignore activation warnings listed under Result [page 233].

1. Select Bl Content in the left-hand frame.
2. Select Object Types and expand InfoObject Catalog.
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+ [2] Objects in BW Patch » [ Enterprise Report EERW

n » 351 Workbook XLWB

+ s«& Transport Request = Query View \wa
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i Packages » 22 Query Elements JELEM

No o~ w

Choose Install.

Choose Transfer Selections.
In the right-hand frame, in the list of Collected objects, verify that both InfoObject catalogs are listed.
Right-click on each of the InfoObject catalogs, and choose Install all Bellow.

Use Select Objects to select the /RAP/CHAR CAT and the /RAP/KYF CAT catalogs.

If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

5. Activate Variables.

- Remember

You can ignore activation warnings listed under Result [page 233].

1. Select Bl Content in the left-hand frame.

2. Select Object Types and expand Query Elements followed by Variable.

3. Use Select Objects to select the following variables:

© /RAP/PLCND ESM 02

© /RAP/PLCSET ESM 02

© /RAP/PCYCLE EMM 01

© /RAP/PLNHR MSO 01

© /RAP/PLNHN1 MSO 01to /RAP/PLNHNS MSO 01 (inclusive)
© /RAP/PRDHN1_MMO_01 to /RAP/PRDHN9_MMO_01 (inclusive)

[ Data Warehousng Workbench ~ Edt  Goto  System  Hep
Data Warehousing Workbench: BI C
[ Tg Tacoleced &) OF Dloeete /& gicto [l EsBEx  HaObject Changeabity  Switch (Business Functions)

[ Modeing I B  [odrGrovong L7 Instal J|  Colection Mode L[| Display i+
Admaistration All Objects According to Type Technical Name 5. | Colected Objects L. M.|S. A Technicalname E..
[ Transport Connecton + % Infosrea ARER =
» &, Applcation APCO >
[ Documents )| + &2 infoObject Catalog 10BC
[ B1 content | | * @ Role ACGR
+ €= BEx Web Template BTMP
* (@ InfoProviders by InfoAreas : %E’E‘:g’: IW:‘ 2::5
. epo
Z5¥ InfoObjects by InfoAreas + @2 ¥cekius Dashboard %CLs
+ [3 Enterprise Report ERPT
S » 5 Workbook XLWB
am
~ 5] Objects n BW Patch :g =
BTy .
i .-:E ransport Request FLEM.STR
8% Packages ELEM.SEL
ELEM.CIF P - P— M=
ELEM.VAR S (E 6L B ) (S5 JE) &
D Object Name 0 :
ELEM.SOB
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4. Choose Transfer Selections.

5. Intheright-hand frame, in the list of Collected objects, verify that all of the selected variables are listed
and that the option in the Install column is enabled .

6. Choose Install.

If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

6. Maintain version master data.

1. Inthe left-hand frame, select | Modeling ¥ InfoObjects 3.
2. Intheright-hand frame under | Assortment Planning for Retail » RAP Character InfoObject Catalog 3,
search in the object list for the InfoObject /RAP/VERSN.

3. Right-click the InfoObject /RaP/VERSN, choose Maintain Master Data from the context menu, and
maintain the following entries on the Time Independent tab:

Version Short description
# An empty version value that you must maintain
ALV Assortment List Vsn
APF Vsn of final plan
i Note

Save your changes and activate them.

7. Activate Advanced DataStore Objects.

If during the installation, you are presented with a message stating that your source system is not active,
navigate to the Modeling tab, locate your source system under Source Systems, and activate it by right-
clicking and selecting Activate. If prompted, choose Only Activate .

- Remember

You can ignore activation warnings listed under Result [page 233].

Select Bl Content in the left-hand frame.

Select Object Types and expand DataStore Object (advanced).

Use Select Objects to select all DataStore Objects starting with /RAP/DS*.
Choose Transfer Selections.

ok w N

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

6. Choose | Display » List .

Right-click the tree node DataStore Object (advanced) and choose Install all Below.

8. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

~

8. Activate CompositeProviders.
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- Remember

You can ignore activation warnings listed under Result [page 233].

Select Bl Content in the left-hand frame.

Select Object Types and expand CompositeProvider.

Use Select Objects to select all CompositeProviders from /RAP/CP40 to /RAP/CP46 (inclusive).
Choose Transfer Selections.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

6. Choose | Display » List 3.

Right-click the tree node DataStore Object (advanced) and choose Install all Below.

8. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

ok w N

~

9. Activate Aggregation Levels.

- Remember

You can ignore activation warnings listed under Result [page 233].

1. Select Bl Content in the left-hand frame.

2. Select Object Types and expand |+ Planning » Aggregation Level 3.
3. Use Select Objects to select the following Aggregation Level:

Aggregation Levels

Aggregation Levels

/RAP/C44A01

/RAP/C44A02

/RAP/C44RA03

/RAP/C44A04

/RAP/C46A02

4. Choose Transfer Selections.

5. Inthelist of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

6. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

10. Activate Planning Sequence Objects.
-> Remember

You can ignore activation warnings listed under Result [page 233].

1. Select Bl Content in the left-hand frame.
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2. Select Object Types and expand |+ Planning ¥ Planning Sequence .
3. Use Select Objects to select the following Planning Sequences:

Planning Sequences

Planning Sequences

/RAP/D50A01_PSO1

/RAP/D57A01_PSO1

/RAP/C40A01_PSO1

/RAP/C40R05 PSO1

/RAP/C46A01 PSO1

/RAP/C46A03 PSO1

/RAP/C46A04 PSO1

/RAP/C46A04 PS02

4. Choose Transfer Selections.

5. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

6. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

11. Activate Planning Function Type Objects.

- Remember

You can ignore activation warnings listed under Result [page 233].

1. Select Bl Content in the left-hand frame.

2. Select Object Types and expand | Planning ¥ Function Type for Planning 3.
3. Use Select Objects to select the following Planning Function:

Planning Functions

Planning Functions

/RAP/OP_BUFFER DATA

4. Choose Transfer Selections.

5. Inthelist of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

6. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

12. Choose Exit to leave the transaction.
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Results

If activation warnings similar to the ones displayed below appear, you can ignore them.

CMP problem occurred in characteristic <CHAR> for InfoProvider <INFO_PROV>

Rounding inaccuracies occur with data type FLOAT for AMOUNT and QUANTITY

Characteristic <CHAR>: Lower case makes selection of char. values difficult

Data type of char. <CHAR> (<TYPE1>) is not equal to data type of attribute <ATTR> (<TYPE2>)

Length of characteristic <TEXT CHAR> (<LENGTH1>) and assigned attribute <ATTR> (<LENGTH2>) not
same

The short text of DataSource <SOURCE> is not maintained in language <LANG>
Skip key figure <KYF>: aggregation type NO2 not supported

Attribute <ATTR>: Conversion routine <CONV> ignored

Attribute <ATTR>: Compounding ignored

Datatype FLTP for datafield <FIELD> of the DSO is not allowed

Conversion problems possible for source field <FIELD1> / target field <FIELD2>

6.3.7 Configure Data Replication

SAP Assortment Planning uses master data, sales history data, inventory data, and merchandise planning data
originating from connected systems, such as SAP Retail (SAP ERP) or SAP BW.

For more information, see SAP Assortment Planning Administration Guide under Configure Data Replication.

6.3.8 Run the Validation Report

1

Run transaction /DMF/VAL CAR INSTALL.
Alternatively, run transaction SE38 and execute the /DMF/VALIDATE CAR INSTALLATION report.

Select the Assortment Planning scenario and select Execute.

In the dialog that appears, select whether to validate the Retail SAP BW structure, the Omnichannel SAP
BW structure, or both. The SAP BW structure to validate depends on the structure that you have selected
to activate during the previous step Activate Planning Framework Content (SAP Assortment Planning)
[page 224].
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Running this report allows you to verify the success of the installation, providing a log of potential issues.
For example, you may be presented with the following results:

WL (S R [P . 5 L ) [ R L o]

Type Message Text LTxt
- Check - Installed SAP Notes

- Check - Planning Application Kit (PAK)
— Check - Fiscal Calendar

Maintain fiscal year variant 'RW'.

— Check - SAP HANA Time Dimension
Maintain SAP HANA time dim. at least 2 years back and 5 years in future. 2]
- Check - Table /RAP/RS_VARCUST

--- Check - BI Master Data for Planning Versions

— Check - BI Technical Content Activation

— Check - BI APR Content Activation

— Check - SAP HANA AFL PAL

— Check - SAP HANA AFL OFL

CODDDODsD@OmD

L |

W Technical Information JE Help JE

Validation Report Results

View the long text associated with each message to see the link to the documentation describing the
procedure you have to troubleshoot.

Related Information

Activate Planning Framework Content (SAP Assortment Planning) [page 224]

6.3.9 Configure Front-End

6.3.9.1 Configure SAP Gateway

For information about the configuration and activation of SAP Gateway as well as the activation of all the
common OData services for SAP Fiori, see Configure SAP Gateway [page 88].
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6.3.9.2 Configure Index Calculation

We recommend that you schedule the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report
(/UI5/APP_INDEX CALCULATE) to runas abackground job on your front-end server.

This is one of the mandatory tasks under |» SAP Customer Activity Repository & Core (Mandatory for All

Applications) 4 that you have most likely performed already. If not, see Configure Calculation of SAPUIS
Application Index [page 97].

6.3.9.3 Activate SAP Assortment Planning ICF Services

Use

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Assortment

Planning application are made available in an inactive state.

You have activated the central ICF services as described in Perform General SAP NetWeaver Gateway
Configuration [page 89] and Configure SAP Fiori Launchpad [page 96]. This procedure provides the
instructions to activate ICF services required for the SAP Assortment Planning SAP Fiori apps.

Procedure

o1

Log on to your front-end server.
Open service maintenance (transaction SICF).

. Inthe Define Services screen, select the Location Clustering service by specifying the following:

© Hierarchy Type: SERVICE

© Virtual Host: DEFAULT HOST

o Service Path: /sap/bc/ui5_ui5/sap/locclsts_v2/
Choose Execute.

To activate the service, choose Service/host Activate.
Repeat steps 3 to 5 to ensure that all of the following services are activated:
© /sap/bc/ui5 uiS/sap/attribmgmt v2/

0 /sap/bc/uib uib/sap/assortlist/

© /sap/bc/uib ui5/sap/ddfreuse v2/

© /sap/bc/uib uiS5/sap/locclsts v2/

© /sap/bc/ui5 ui5/sap/modulemgmt v2/

0 /sap/bc/uib5 uib5/sap/optionplan v2/

© /sap/bc/uib ui5/sap/phpmatch v2/

© /sap/bc/ui5 uib5/sap/plnconfig/

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
Set Up the Applications PUBLIC

235



6.3.9.4 Define System Alias for Back-End Transactions

Use

A number of SAP Assortment Planning SAP Fiori apps, installed on your front-end system, launch transactions
directly on the back-end system. For example, the Manage Products tile actually launches the Demand Data
Foundation (DDF) powL_EaAsSY WebDynpro application.

To enable this behavior, you need to create a dedicated RFC connection between the front-end and the back-
end systems.

Procedure

Log on to your front-end system, that is, the system where you have installed the user interface (Ul)
components of the SAP Assortment Planning application.
Launch Configuration of RFC Connections (transaction sM59).

. Create an RFC connection with the RFC Destination set to SAP_ ISR _CARAB and Connection Type set to H

(HTTP connection).

Ensure to maintain all of the settings required to connect to your back-end system, in particular, the Target
Host entry on the Technical Settings tab.

Save your changes.

Create another RFC connection with the RFC Destination set to SAP ERP ISR CARAB and Connection
Type set to 5 (HTTP connection).

Ensure to maintain all of the settings required to connect your front-end system to the SAP Retail or SAP
S/4HANA system, in particular, the Target Host entry on the Technical Settings tab.

6. Save your changes.

Open Launchpad Customizing (transaction LPD _CUST).

8. Select the SAP Assortment Planning role (UTIRAP001), and choose Display.

236

The two catalogs, Assortment Planner and Planning Administrator, are displayed.
In each of the catalogs, selecting one app at a time, make the following settings:

Catalog App System Alias Description

Assortment View Log SAP ISR CARAB This setting allows the My Assortment Lists app to

Planner launch transaction s1.G1 on the back-end system.
i Note

This application is only used to configure a link to
the back-end system, you do not need to add this
app to your SAP Fiori launchpad.
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Catalog App System Alias Description

View ExtAssort SAP _ERP ISR CAR This setting allows the My Assortment Lists app to
Listing Conditions ~ AB launch transaction wsL.10 on the connected SAP Retail
or SAP S/4HANA system.
iNote

This application is only used to configure a link to
the SAP Retail or SAP S/4HANA system, you do not
need to add this app to your SAP Fiori launchpad.

View External SAP_ERP ISR CAR This setting allows the My Assortment Lists app to
Assortments AB launch transaction WRF_wWSOA3 on the connected SAP
Retail or SAP S/4HANA system.

i Note

This application is only used to configure a link to
the SAP Retail or SAP S/4HANA system, you do not
need to add this app to your SAP Fiori launchpad.

Planning Manage Category SAP ISR CARAB This setting allows the Manage Category Responsibilities
Administrator responsibilities app to launch the corresponding DDF WebDynpro appli-
cation.
Manage Market SAP ISR CARAB This setting allows the Manage Market Responsibilities
responsibilities app to launch the corresponding DDF WebDynpro appli-
cation.

Manage Products SAP ISR CARAB This setting allows the Manage Products app to launch
the corresponding DDF WebDynpro application.

Manage Locations ~ SAP ISR CARAB This setting allows the Manage Locations app to launch
the corresponding DDF WebDynpro application.

6.3.9.5 Assign Roles, Catalogs, and Groups in SAP Fiori
Launchpad

Use

To be able to access SAP Fiori apps that constitute the SAP Assortment Planning user interface from the SAP
Fiori launchpad, your front-end system user must have the necessary roles assigned. Based on the role(s)
assigned to your user, you can access certain business catalogs and business catalog groups.
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Your SAP Assortment Planning application is delivered with two predefined roles, catalogs, and groups. These
include technical content as well as business content:

Front-End Server Business Content Front-End Technical Content

Technical
Business Role Business Catalog Business Catalog Group Technical Role Catalog
SAP_RAP BCR AP PL SAP RAP BC AP PLA SAP RAP BCG AP PLANNER SAP_RAP TCR T SAP_RAP TC
ANNER NNER T

SAP RAP BCR PLANN SAP RAP BC PLANNI SAP RAP BCG PLANNING ADM
ING_ADMIN NG_ADMIN IN

To test the installation of SAP Assortment Planning from the SAP Fiori launchpad, you need to assign the roles
above to your user on the front-end system.

Procedure

Log on to your front-end system.

Launch User Maintenance (transaction su01).

Enter your user name in the User field and choose Change.

Onthe Roles tab, assign the roles SAP RAP BCR AP PLANNER and SAP_RAP BCR PLANNING ADMIN to

AW

your usetr.

A\ Caution

If you already have an SAP Fiori launchpad open, you must clear your browser cache to apply any
modifications made to your user roles. Otherwise, your changes will not be reflected in the SAP Fiori
user interface.

More Information

Security Information section of the SAP Assortment Planning Administrator's Guide.

6.3.10 Additional Information for Retail SAP BW Structure

6.3.10.1 Specify Analysis Workbooks Settings

The Retail SAP BW Structure of SAP Assortment Planning is delivered with some SAP Analysis for Microsoft
Office workbooks. These are template workbooks that you can adapt to use in your retail business. However,
you should not use the Retail SAP BW Structure in a new installation but the Omnichannel SAP BW Structure.
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For an example of how to create customized versions of the workbooks, see Workbook Design Example [page
242].

6.3.10.1.1 Enable Macros

Use

In this procedure, you enable your SAP Analysis for Microsoft Office workbooks to use macros.

Procedure

1. Open SAP Analysis for Microsoft Office from |r Start » All Programs » SAP Business Intelligence » SAP
BusinessObjects Analysis # Analysis for Microsoft Excel .

Choose |+ File » Options ¥ Customize Ribbon 3.

Under Customize the Ribbon, select Main Tabs.

Enable the entry Developer and confirm by choosing OK.

Now you will see the new Developer tab in your SAP Analysis for Microsoft Office.

Select the Developer Tab and choose Macro Security.

NoO o RN

Choose Enable all macros.

6.3.10.1.2 Set Language for Ribbons and Buttons in
Workbooks

Use

In this procedure, you can set the desired language of the following user interface objects that are specific to
the workbooks of SAP Assortment Planning:

® Ribbons Planning Functions, Refinement Functions, and Extended Features
® Tooltips for planning functions

® Message texts

e Buttons.

The content of the workbooks consists of multiple parts:

® The language of the standard menus and standard ribbons depends on the language set for Microsoft
Excel.

e The language of the contents in the cells (mainly KPIs) depends on the user-selected system language of
the back-end system.

Common Installation Guide for SAP Customer Activity Repository applications bundle 4.0
FPSO1
Set Up the Applications PUBLIC 239



e The language of the user interface objects that are specific to the workbooks of SAP Assortment Planning,
is not set by the selected system language of the back-end system, but you can change it for each
workbook according to the following procedure. The default language is English.

Procedure

1. Unhide the worksheet SAP_TEXT_CUSTOMIZING using standard functionality of Microsoft Excel.

2. Onthe worksheet SAP_TEXT_CUSTOMIZING, copy the column of the desired language to column B -
Custom Text.

3. Hide the worksheet SAP_TEXT_CUSTOMIZING.
4. Save your changes in the worksheet on the SAP NetWeaver Server by choosing |# File » Analysis ¥ Save
Workbook to SAP NetWeaver 3.

i Note

To allow for correct interpretation of the texts by screen readers, make sure that the language for all parts
of the workbooks is set to the same desired one. Set the language as described in this section.
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6.3.10.1.3 Set ResultSetSizeLimit Registry Setting

Use

By default, SAP Analysis for Microsoft Office workbooks are set to display 500,000 cells. This setting might not
be sufficient for the productive use of SAP Assortment Planning. For example, if you have more than 300
products in your assortment plan, you might encounter the following error message:

@ H ) «- ™ .;-'-
Home Insert Page Layout Formulas Data Review

@ )

j \ Verdana -8 A= E:;i - E
" - Tl fe—
e (Bl u- - &-A- E== & G
Clipboard Ix Font s Alignment
2

A B (= D
1 Assortment Plan Status |Reference fi
2 |Spring 2014 123451010(2 01.08.2013
3
4
5 Size limit of result set exceeded

Size Limit Error

To resolve this issue, you need to increase the default setting of the ResultsetSizeLimit registry setting.

Procedure

Read and implement SAP Note 1662968 # .

i Note

As the administrator overseeing the installation of SAP Assortment Planning, you need to carry out the
steps listed in this procedure on the workstation of each SAP Assortment Planning user.
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6.3.10.2 Workbook Design Example

Use

In this procedure, you walk through an example of creating an SAP Analysis for Microsoft Office workbook. You
can use steps of this procedure to create customized versions of the SAP-delivered assortment planning
workbooks.

Prerequisites

The necessary Bl queries must exist in the back-end system.

Procedure

© N OO AW

10.

11.

12.
13.

14.

15.

242

Open SAP Analysis for Microsoft Office from |» Start » All Programs » SAP Business Intelligence » SAP
BusinessObjects Analysis ¥ Analysis for Microsoft Excel 4.

Select the cell in the worksheet where the crosstab with the data from the selected data source should be
inserted.

From the menu, choose |+ Analysis » Insert » Select Data Source 3.

Choose Skip on the popup window Logon to SAP BusinessObjects Bl Platform.

In the Select Data Source dialog box, select the source system, then choose Next.

In the Logon to system <Your System Name> dialog box, enter your logon data, then choose OK.

In the Select Data Source dialog box, choose tab Search.

In the Search tab, you can search for the description or technical name of a data source, that is, the name
of the Bl query that will provide the data for your workbook.

For example, search for /RAP/MO1A01 IRQO2 or /RAP/MO1A01 IRQOL.In general, you can search for /
RAP* to find any SAP Assortment Planning query.

Select the required data source, and then choose OK.

On the Prompts screen, make the relevant entries base on the selected query in the Specify Value for
Prompts area.

Choose OK, and then you will see the table is inserted in the sheet. You can now analyze the data and
change the displayed data set according to your needs. You can also add other components to your
analysis, for example charts.

Choose menu [ Analysis ¥ Display 3 to open the design panel.

Choose the Components tab in the bottom right corner, and right-click Bookl and choose Use Planning
Sequence.

In the Search For field of the Open Planning Sequence dialog box enter your planning sequence and choose
Search.

Select the required planning sequence, and then choose OK. The planning sequence will be displayed

under |+ Bookl j Planning Objects 4 in the design panel.
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16. Select the cell in the worksheet where a button should be inserted.

17. From the menu, choose [* Developer ¥ Insert  Button (Form Control) 4, and insert the button using drag

and drop.

18. In the Assign Macro dialog box, choose New.

19. In the VB edit, maintain the relevant code in the Sub ButtonX_Click area.

20.Choose Close.

21. Right-click the button, and choose Edit Text. Replace the button name with a meaningful name.

22.Position your cursor where the condition will be defined, and make the relevant entries.

23. Select the sheet and position the cursor where the variable list will be inserted, for example cell H1 in
sheetl.

24.Choose menu|l» Analysis » Info » Field » Variables 3, and the variables will be inserted into the relevant
sheet.

25. Maintain the relevant entries in the sheet.

26.Choose your Planning Sequence in the design panel.

27. In the section of Variables of Planning Sequence, make the relevant entries.

28.Choose Save Button.

29. Provide a file name and save the workbook as type Excel Macro-Enabled Workbook (*xIsm).

30.Choose Save.

Result

The customized workbook is created.

6.4 SAP Promotion Management

6.4.1 Perform Core Steps for SAP Customer Activity
Repository

To set up this application, you must first perform the Core (Mandatory) steps for SAP Customer Activity
Repository. The core steps are mandatory for all the consuming applications.

Procedure

Perform all steps listed under Core (Mandatory for All Applications) [page 67].
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6.4.2 Activate Internet Communication Framework (ICF)

Services

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Promotion
Management application are made available in an inactive state. In this procedure, you activate an ICF service
required for the SAP Manage Promotional Offers Fiori app.

1.
2.

Log on to your front-end system.
Open service maintenance (transaction SICF).

3. Inthe Maintain Service screen, select the service by specifying the following:

o

o Hierarchy Type: SERVICE
© Virtual Host: DEFAULT HOST
o Service Path: /sap/bc/bsp/sap/
Choose Execute
To activate the service, choose Service/host Activate
Repeat steps 3 to 5 to ensure that all of the following services are activated:
O pmroffers
O pmrcontent
O prodgrps
O locsubgrp

6.5 SAP Allocation Management

Post-installation setup for SAP Allocation Management

R

244

Perform Core Steps for SAP Customer Activity Repository [page 168]

Activate SAP Allocation Management SAP HANA Content [page 245]

Check Procedure Associated with Function GENIOS_SOLVE is Active [page 249]
Configure SAP Allocation Management [page 249]

Configure Data Replication [page 250]

Configure Front End [page 253]
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6.5.1 Perform Core Steps for SAP Customer Activity
Repository

To set up this application, you must first perform the Core (Mandatory) steps for SAP Customer Activity
Repository. The core steps are mandatory for all the consuming applications.

Procedure

Perform all steps listed under Core (Mandatory for All Applications) [page 67].

6.5.2 Activate SAP Allocation Management SAP HANA
Content

Once all previous steps are successfully completed, you can activate SAP Allocation Management SAP HANA

content.

Prerequisites

Before you can start to activate the SAP Allocation Management SAP HANA content, perform these activities:

e Ensure that you have at least one of the SAP_ECC or SAP_s4H schemas in the SAP HANA database. Based

on your source system for all SAP ERP data, you have either a SAP_ECC schema or a SAP_S4H schema

(either physical schemas with these names, or at least authoring schemas). If you have both these
systems, you must have two schemas.

e Ensure that all tables listed for SLT replication are available in the relevant schemas. The spreadsheet with

tables that are relevant for replication and for SAP HANA content activation is available on the SAP Help
Portal at https://help.sap.com/viewer/p/CARAB. Select the desired version at the top right and download
the SLT Tables for SAP Customer Activity Repository applications bundle archive from under Installation
and Upgrade and extract the spreadsheet.

Ensure that you have successfully set up the SLT tables in the schemas.

SAP HANA Content Activation Steps

1. Deploy SAP Allocation Management delivered procedures, functions, and views.

SAP Allocation Management delivers several native HANA objects as a part of the application. These
objects are delivered via HANA transport for ABAP (HTA) and must be explicitly deployed into the SAP
HANA database. Without this deployment, you do not see these objects in the SAP HANA database. Once
deployed, you can find the content via the path sap.is.retail.rap.amr.db.
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2. Activate SAP Customer Activity Repository and Demand Data Foundation (DDF) SAP HANA content.

i Note

If the SAP Customer Activity Repository and DDF SAP HANA content is already active, you can skip this
step.

SAP Allocation Management depends on active SAP HANA content for SAP Customer Activity Repository
and DDF. Therefore, it is recommended that you first activate the SAP Customer Activity Repository and
DDF SAP HANA content.

Run the programActivate SAP HANA Content for SAP CARAB (/CAR/ACTIVATE HTA) and select the ECC
Mode relevant to your installation. Under Business Scenario Activation, select the Customer Activity
Repository and Demand Data Foundation options.

Execute the activation report. As a result, you have successfully activated and deployed the SAP HANA
content for SAP Customer Activity Repository and DDF.

A\ Caution

Do not select Allocation Management within this activation run for a simultaneous activation of SAP
Allocation Management SAP HANA content as simultaneous activation leads to activation problems.

3. Set Prework Done for SAP Allocation Management packages.
A precondition for SAP HANA Transport for ABAP (HTA) activation is that the PREWORK DONE indicator is
set for all packages with activation mode P - prework needed. You can check this setting in the table
CTS HOT PACKAGE infield HOT ACTIVATION MODE. Setthe PREWORK DONE indicator for all packages
relevant for SAP Allocation Management:

1. Calltransaction sE16 (Data Browser) and display the content of table CTS HOT PACKAGE.

Search for package names sap.is.retail.rap.amr* inthe field HANA PACKAGE ID. Please note,
that the package names are case-sensitive.

You should find 163 entries that match the search criterion. Copy the package names from the result
list of your search.

2. Display the selection screen of table CTS HOT PREWORK. Enter the HANA PACKAGE 1D for all
packages from the result list of your search in table CTS HOT PACKAGE.

3. Setthe PREWORK DONE indicator to X for all packages in the CTS_HOT_PREWORK table. The indicator
shows that the SAP HANA content in all packages relevant for SAP Allocation Management is ready for
deployment.

4. Runthe dummy schema and dummy table creation reports.
The reports check for a missing physical schema and create this physical schema and the corresponding
dummy tables in the schema if necessary. The successful completion of this step is a prerequisite for a
successful SAP HANA content activation for SAP Allocation Management.

i Note

The running of the report requires a database user in the ABAP system with the authorization to create
the dummy schema. Check the application log for the report if there were errors.

In your back-end system, start transaction sE38 and execute the following two reports, in the sequence
they are listed:

© /DMF/CREATE SLT TABLES (Create SLT Tables)

1. Select your source system. For S/4HANA, enter the release.
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2. Enter the physical source and dummy schema names. For the Physical Source Schema, enter the
physical schema name into which your SLT tables are replicating. For the Physical Dummy Schema,
enter the name for the schema to be created. If the physical source schema already exists in the SAP
HANA database, then only the dummy tables in this schema are created when you execute the report.

3. Select the simulation mode for a test run. After the simulation run, you can check for errors in the
application log.

© /AMR/CREATE DYNAMIC SLT TABLES (Create SLT Tables Dynamically)

1. Select your source system. For S/4HANA, enter the release.

2. Enter the physical source and dummy schema names. For the Physical Source Schema, enter the
physical schema name into which your SLT tables are replicating. For the Physical Dummy Schema,
enter the name for the schema to be created. If the physical source schema already exists in the SAP
HANA database, then only the dummy tables in this schema are created when you execute the report.

3. Select the simulation mode for a test run. After the simulation run, you can check for errors in the
application log.

5. Grant Authorization
The two SLT table creation reports use the database user maintained in the ABAP system to create the
dummy schemas. The SYS REPO user needs the exact same authorizations on the newly created dummy
schema that this user already has on the physical source schema. In addition, to display the schema in the
navigator, a SELECT authorization on the schema (with GRANT option) must be provided to the database
user for the content activation.

i Note

This step must be performed by the SAP HANA database administrator, who has the authorization for
these activities.

6. Check and maintain schema mapping.
Check the names you use for your physical schema. If you are using the default names below, no further
action is required:

o saAp s4H, for your S/AHANA schema
o sapP_Ecc, for your ECC or FMS schema

If you have chosen names for your physical schema, which are different from the names above, you must
do the following:

Maintain a schema mapping in your SAP HANA database, where your customer-specific names are used
as authoring schemas for the physical schema.
7. Activate relevant inactive SAP HANA content for DDF.
Based on your scenario, there can be inactive packages in DDF, even though you have activated the content
earlier via the report /CAR/ACTIVATE HTA (Activate SAP HANA Content for SAP CARAB).
For the following packages in DDF, perform these actions:
o InthetablecTS HOT PREWORK, setthe PREWORK DONE indicator to X for these packages.
o Callup transaction scTs_HTA DEPLOY (SAP HANA Transport for ABAP - Deployment) to check and to
deploy (if not already deployed) these packages, in strictly the sequence they are listed. Do not select
the option to Include subpackages:

O sap.is.ddf.ecc

O sap.is.ddf.fms

© sap.is.ddf.fms s4h

O sap.is.ddf.cross.ecc

O sap.is.ddf.cross.fms
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© sap.is.ddf.cross.fms_ s4h

O sap.is.ddf.cross

i Note

The package names are case-sensitive.

8. Once you have successfully deployed all content as described in the previous steps, call up transaction SAP
HANA Transport for ABAP - Deployment (SCTS_HTA DEPLOY). To deploy the SAP Allocation Management
packages, enter package name sap.is.retail.rap.amr* and choose Execute.

i Note

With this step, the SAP Allocation Management SAP HANA content is finally deployed. It is the last and
most critical activation step.

Checking for Missing Views

If content activation errors occur, check for missing views in the database. For more information, see
Troubleshooting: Missing Views in Database [page 248].

Related Information

Create/Replicate Source Master Data System Tables [page 76]
Activate SAP HANA Content [page 78]
Create/Replicate Source Master Data System Tables

6.5.2.1 Troubleshooting: Missing Views in Database

After the SAP HANA content activation, you can check for missing views in transaction DB02.

Check if SAP Allocation Management views are highlighted as objects missing in the database. There could be
some missing objects, despite having received success messages from the previous step of activating SAP
Allocation Management SAP HANA content.

Call up transaction Diagnostics: Missing Tables and Indexes (DB02)

1
2. Select | Diagnostics » Tables/Views 3 and enter the technical name.

3. Check if any SAP Allocation Management views are displayed as missing in the database.
4. If there are views missing in the database, raise a support ticket.
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6.5.3 Check Procedure Associated with Function
GENIOS_SOLVE is Active

For SAP Allocation Management, confirm that the procedure associated with function GENIOS SOLVE is active
inthe sYs AFL catalog.

Prerequisites

You have configured the AFL usage and confirmed that the OFL algorithm was installed successfully as
described in section Check the OFL Installation [page 43].

Context

Procedure

1. GotoSAP HANA Systems viewinthe SAP HANA Development Perspective.
2. Inyour system, filter for catalog _sys AFL.
3. Inthe sys AFL catalog, filter on procedures to search for OFL_AREA GENIOS DOLVE PROC

4. Confirm this procedure OFL_AREA GENIOS SOLVE_PROC is available.

6.5.4 Configure SAP Allocation Management

Configuration of SAP Allocation Management

To use SAP Allocation Management, you must define several application-specific settings in Customizing.
Define the settings under |+ SAP Implementation Guide # Cross-Application Components # Allocation

Management .
SAP Allocation Management provides optional integration scenarios with:

e UDF (Unified Demand Forecast)
e SAP Assortment Planning

Both scenarios require additional installation steps, which are described in sections SAP Assortment Planning
[page 216] and Complete UDF Setup [page 105] of this guide.

Allocation information from allocation plans can be transferred to follow-on systems to create the
corresponding allocation tables. You set up the transfer of allocation plans with the implementation of SAP
Notes in the follow-on systems. For more information, see Implement SAP Notes for the Installation [page 25].
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6.5.5 Configure Data Replication

SAP Allocation Management uses master data such as product, store, and product hierarchy that is imported
to the Demand Data Foundation (DDF) and Unified Demand Forecast (UDF) modules using the data replication
framework (DRF, transaction DRFOUT).

i Note

Not all of the master data is replicated using the data replication framework. Some data must be replicated
separately using SAP Landscape Transformation Replication Server (SLT).

For a detailed information on the SLT replication procedure, see Create/Replicate Source Master Data
System Tables [page 76].

6.5.5.1 Initial Load of Data to DDF Using DRFOUT

SAP Allocation Management uses master data, such as product, location, and product hierarchy, that is
replicated from SAP Retail or SAP S/4HANA to DDF using DRFOUT.

Procedure

SAP Allocation Management specifically requires that the following data is replicated sequentially from a
connected SAP ERP system using DRFOUT:

Sequence Master Data Technical Details For more information, see:

1 Product Hierarchy ® SAP ERP Description: Material Group http://help.sap.com/car'h'l’ <your

Hierarchy

. release> > Application Help > Demand
e DRFOUT Outbound Implementation:

PMCH Data Foundation # Integration Information
e DDF Inbound Interface: /DMF/ } Inbound Interfaces For Remote Function
MDIF_PROD_HIER INBOUND Call (RFC) Communication ¥ Product

Hierarchy Master Data }

2 Product * SAPERP Description: Material http://help.sap.com/carl'hrlb <your
e DRFOUT Outbound Implementation: o
SMAT release> > Application Help > Demand

e DDF Inbound Interface: /DME/ Data Foundation > Integration Information
MDIF_PRODUCT INBOUND > Inbound Interfaces For Remote Function
Call (RFC) Communication > Product

Master Data }
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Sequence Master Data Technical Details For more information, see:
3 Location * SAPERP Description: Plant http://help.sap.com/car | <your
e DRFOUT Outbound Implementation: o
- release> > Application Help > Demand
e DDF Inbound Interface: /DMEF/ Data Foundation > Integration Information
MDIF LOCATION INBOUND > Inbound Interfaces For Remote Function
Call (RFC) Communication @ Product
Location Master Data }
4 Product Location =~ ® SAP ERP Description: Material/Plant http://help.sap.com/car P <your
e DRFOUT Outbound Implementation: o
release> > Application Help > Demand
PMPL
e DDF Inbound Interface: /DMEF/ Data Foundation > Integration Information
MDIF_ PROD LOC_INBOUND > Inbound Interfaces For Remote Function
Call (RFC) Communication » Product
Location Master Data 4
5 Product Location ¢ SAP ERP Description: Sales Price http://help.sap.com/car | Application
e DRFOUT Outbound Implementation: )
Help > Demand Data Foundation >
PSPR
e DDF Inbound Interface: /DMF/ Integration Information > ln?ound
MDIF PROD LOC_INBOUND Interfaces For Remote Function Call (RFC)
Communication > Product Location
Master Data }
6 Inventory * SAPERP Description: Inventory http://help.sap.com/car!‘}l} <your

e DRFOUT Outbound Implementation:

PINV

e DDF Inbound Interface: /DMF/
OPIF INVENTORY INBOUND

release> > Application Help > Demand
Data Foundation > Integration Information
> Inbound Interfaces For Remote Function
Call (RFC) Communication > Inventory
Master Data }
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Sequence Master Data Technical Details For more information, see:

7 Transportation ® SAP ERP Description: Source of Sup- http://help.sap.com/car P |p <your
Lane ply L
i release> > Application Help > Demand

e DRFOUT Outbound Implementation:
PSOS Data Foundation  Integration Information

e DDF Inbound Interface: /pMr/ > Inbound Interfaces For Remote Function
MDIF_ LANE_INBOUND Call (RFC) Communication *

i Note Transportation Lane Master Data }

Before transferring the planned deliv-
ery time to DDF, implement a BAdI to
update the planned delivery time val-
ues as described in SAP Note 2357255

).
8 Location * SAPERP Description: Vendor http://help.sap.com/car'hrl} <your
e DRFOUT Outbound Implementation: o
SVEN release> > Application Help > Demand

e DDF Inbound Interface: /DMF/ Data Foundation ¥ Integration Information
MDIF LOCATION INBOUND » Inbound Interfaces For Remote Function
Call (RFC) Communication > Location

Master Data 1

9 Product Hierarchy ® SAP ERP Description: Article Hierar- http://help.sap.com/car'hrl} Application
chy
i Help > Demand Data Foundation >
e DRFOUT Outbound Implementation:
PAHY Integration Information  Inbound

e DDF Inbound Interface: /DME/ Interfaces For Remote Function Call (RFC)

MDIF PROD HIER INBOUND Communication > Product Hierarchy

Master Data 1

You can import the data into staging tables, and then transfer this data to production tables using report /bDMF /
PROCESS STAGING TABLES. Alternatively, you can skip the staging tables and import the data directly into
the production tables. For more information, see:

e http:/help.sap.com/carf| <your release> » Application Help » Demand Data Foundation » Integration
Information ¥ Inbound Processing 3

e http:/help.sap.com/carf | <your release> » Application Help » Demand Data Foundation » General
Services ¥ Monitor Imports » Process Inbound Staging Tables J

More Information

For more information on monitoring the replication, see:
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e http:/help.sap.com/car |» <your release> #» Application Help » Demand Data Foundation » General

Services » Monitor Imports 3
® The Periodic Tasks section of the Administration Guide for SAP Allocation Management.

Related Information

Periodic Tasks

6.5.5.2 Delta Load of Data to DDF Using DRFOUT

When performing a delta load of data from the source master data system using the DRFOUT framework, you
must ensure that the product location data required to enhance the sales records with historical sales cost is
loaded prior to the sales data.

Furthermore, we recommend that you schedule a daily periodic task to replicate data from the source system
to the SAP Allocation Management system.

6.5.6 Configure Front End

Check if you have performed the SAP Gateway configuration and that you have activated the OData Services
for distribution curve and SAP Allocation Management.

Activate SAP Allocation Management ICF Services [page 254]
Perform these steps to activate Internet Communication Framework (ICF) services for SAP Allocation
Management.

Assign Roles, Catalogs, and Groups in SAP Fiori Launchpad [page 254]
To be able to access SAP Fiori apps that constitute the SAP Allocation Management user interface from
the SAP Fiori launchpad, your front-end system user must have the necessary roles assigned. Based on
the roles assigned to your user, you can access certain business catalogs and business catalog groups.

Related Information

Configure SAP Gateway [page 88]
Activate OData Services [page 91]
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6.5.6.1 Configure SAP Gateway

6.5.6.2 Activate SAP Allocation Management ICF Services

Perform these steps to activate Internet Communication Framework (ICF) services for SAP Allocation
Management.

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Allocation
Management application are made available in an inactive state.

You have activated the central ICF services while configuring the SAP Gateway. This procedure provides the
instructions to activate ICF services required for the SAP Allocation Management SAP Fiori apps.

Procedure

1. Logon to your front-end server.

2. Open service maintenance (transaction SICF).

3. Inthe Maintain Service screen, select the Location Clustering service by specifying the following:
o Hierarchy Type: SERVICE
© Virtual Host: DEFAULT HOST
o Service Path: /sap/bec/ui5_ui5/sap/amr_alloplan/

4. Choose Execute.

o

To activate the service, choose Service/host Activate.

6. Repeat steps 3-5 to ensure that all of the following services are activated:
0 /sap/bc/ui5 ui5/sap/amr_allo_params

0 /sap/bc/ui5 ui5/sap/amr dist config

O /sap/bc/ui5 uiS5/sap/amr lib reuse

© /sap/bc/ui5 ui5/sap/amr_marketunit

© /sap/bc/ui5 uib5/sap/amr_workload

© /sap/bc/ui5 uib5/sap/amr kpiconfig

O /sap/bc/ui5 ui5/sap/amr_result

6.5.6.3 Assign Roles, Catalogs, and Groups in SAP Fiori
Launchpad

To be able to access SAP Fiori apps that constitute the SAP Allocation Management user interface from the
SAP Fiorilaunchpad, your front-end system user must have the necessary roles assigned. Based on the roles
assigned to your user, you can access certain business catalogs and business catalog groups.

Your SAP Allocation Management application is delivered with a predefined role, catalog, and group. These
include technical content as well as business content:
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Front-End Server Business Content Front-End Technical Content

Technical
Business Role Business Catalog Business Catalog Group Technical Role Catalog
SAP AMR BCR_ SAP_AMR BC_ALLOCA SAP AMR BCG ALLOCATOR T SAP_AMR TCR T SAP AMR
ALLOCATOR T TOR T TC T

To test the installation of SAP Allocation Management from the SAP Fiori launchpad, you need to assign the
roles to your user on the front-end system.

Procedure

Log on to your front-end system.
Launch User Maintenance (transaction su01).
Enter your user name in the User field and choose Change.

AW opoe

Onthe Roles tab, assign the roles SAP AMR BCR ALLOCATOR T and SAP AMR TCR T to your user.

A\ Caution

If you already have an SAP Fiori launchpad open, you must clear your browser cache to apply any
modifications made to your user roles. Otherwise, your changes are not reflected in the SAP Fiori user
interface.

More Information

Security Information section of the Administration Guide for SAP Allocation Management.

6.6 Configure Access to Documentation Provided on SAP
Help Portal (Optional for All Applications)

In transaction SR1 3, you can configure your back-end system to point to documentation for your application
that is provided on SAP Help Portal for SAP Customer Activity Repository applications bundle.

Context

You can configure your back-end system to access documentation provided on SAP Help Portal for SAP
Customer Activity Repository applications bundle at https://help.sap.com/viewer/p/CARAB. For example, if
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your application is SAP Customer Activity Repository, you can configure access to the application help for SAP
Customer Activity Repository.

Prerequisites

® The documentation you want to access must be available on SAP Help Portal.
® The users who access the documentation must have access to the Internet.

® You can configure an ABAP system to connect to only one combination of product and version. These are
the values that you will specify as Path in the procedure below.

i Note

The product cARAB is valid for all the applications delivered with SAP Customer Activity Repository
applications bundle.

The version depends on the release. For example, version 4. 0.1 is valid for all the application versions

delivered with SAP Customer Activity Repository applications bundle 4.0 FPSO1.

If you cannot fulfill one or more of these prerequisites, you must install the documentation in your local system
landscape using the download packages or DVDs/CDs provided.

i Note

For more information about installing the documentation in your local system landscape, see the SAP
Library Installation and Update Guide for SAP NetWeaver-Based Systems.

Procedure

1. Open transaction sr13.
2. Select the tab PlainHtmIHttp.

3. Choose New Entries.

A\ Caution

You have to create entries for both documentation and XML documentation areas for each platform
you are using and each language in which you want to provide documentation.

You must use the exact combination of uppercase and lowercase characters specified in the product
and version.

4. To create entries for the documentation area, enter the following values:

Name Value to be entered
Variant Enter a name for the variant.
Platform Select the platform relevant for your implementation from

the list of available platforms, for example, WN32.

Area Select Documentation from the list; this will display as
IWBHELP in the table.
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Name Value to be entered

Server Names https://help.sap.com/http.svc/ahp2
Path (<Product/version>) CARAB/4.0.1
Language Select the language you need from the list.

5. To create entries for the XML documentation area, enter the following values:

Name Value to be entered

Variant Enter a name for the variant (any name).

Platform Select the platform relevant for your implementation from
the list of available platforms, for example, WN32.

Area Select XML Documentation from the list; this will display
as XML_DOCU in the table.

Server Names https://help.sap.com/http.svc/ahp2

Path (<Product/version>) CARAB/4.0.1

Language Select the language you need from the list.

6. Repeat steps 4 and 5 for each relevant platform and language.
7. Select one entry as the default language for each platform and area.

8. Save your entries.

Results

You have configured your back-end system to point to documentation that is provided on SAP Help Portal.

Related Information

SAP Note 2149786 Customizing help settings in transaction SR13#
SAP Note 2652009 Connecting the help to the SAP Help Portal#

SAP Note 2572047 SAP provides user assistance (documentation) as HTML, PDF, or directly via SAP Help
Portal e
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:

e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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